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1 
OBJECTIVES 

In this chapter, you will learn more about: 

• Displaying DTM features such as contours and triangles. 

• Create TIN files from Superelevation Shapes. 

• Create TIN files from proposed cross sections. 

INTRODUCTION 
A Digital Terrain Model (DTM) represents the topography of a project in the form of a triangulated 
network. The DTM can be drawn in a 2D or 3D file, and then rotated to see the existing surface of the 
project area. The tools associated with the DTM are not related to and are independent of GEOPAK 
Drainage. 

Digital Terrain Models can be generated from various sources including MicroStation elements, survey 
data, photogrammetry data, GEOPAK cross-sections, and geometry data. 

• Triangulation is a mathematical process applied to ground points and vertices along 
longitudinal features to create planar surfaces. The result of triangulation is the creation of 
triangles connecting these points. These triangles are included in the GEOPAK TIN file from 
which existing ground profiles and existing ground cross sections can be generated.  

 

ACCESSING 
The DTM tool frame can be accessed from the MS Menu: Applications>Geopak 
Road>DTM Tools. Then clicking on the DTM menu icon, the user can access 
the DTM tool bar depicted below. 

 

 

SETTINGS 
When the Stroking Options tool is selected, the DTM Stroking Options dialog opens. 

 

Two user-defined stroking values can be defined before graphics can be extracted to create a DTM.  
Stroking is the process of automatically adding shots to the DTM Input file by interpolating new shots 
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from the linear and curved sections of the data. If the source topography data is mapped in a 3D-design 
file, stroking may be applied. Stroking is not available if the topography data resides in a 2D-design 
file.  

Curve Stroke 
Tolerance 

The maximum distance between the arc and the chord used to approximate the 
arc in the DTM. Stroking is only applied to breaks and contours. 

Minimum Linear 
Distance 

If a linear segment is greater than the Minimum Linear Distance, points are 
interpolated and added to the segment such that the distance between the points 
in not greater than the Minimum Linear Distance. 

EXTRACT GRAPHICS 
The Extract Graphics tool reformats MicroStation elements into DTM input data. 

 

File 
Name  

The name of the file to be created for storing the input data. The .dat extension is 
automatically assigned so you are not required to key this in; however, an alternate 
extension may be defined. If file already exists, it may be selected by clicking Files. 

File Type  Format of the new file. Either format produces the same results. The difference between 
the two is ASCII files can be viewed and edited with any text editor while binary files 
process faster, but cannot be viewed.   
For ASCII file designation, you must define the number of decimal places for the data. 

File Open Indicates whether a file is being created (Create) or the user is appending data (Append) 
to an existing .dat file. 

Feature 
Type 

This notifies GEOPAK of the feature type that the extract graphics will put in the DTM. 
Spots – Random survey points. Can also be vertices of a Line or a Line String. 
Breaks – Designate linear features such as edges of pavement, ditch bottoms, ridges, 
etc. No triangle leg will cross a Break. 
Boundary – The external boundary of the digital terrain model – only per .dat file. 
Contours – For use in extracting digitized or otherwise imported contours. 
Void – Closed shapes representing an area with missing data or obscure areas.  (i.e. 
ponds, headwalls, concrete pads, etc.). The void coordinates determine void lines, which 
are inserted as drape lines on the triangulated surface and do not alter the slope or 
elevations of the TIN. 
Island – Area within a void that contain data and should be included in the model. 
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Graphic Triangle – For use in extracting triangles from a TIN model that has been 
otherwise created or imported. 
Drape Void – Same as Void, except the Void’s vertex elevations are ignored and the 
triangulated model elevations at these vertex points are utilized.  
Break Void – Same as Void, except the void elevations are included in the triangulated 
model at it’s x y coordinates; therefore, the slope and elevations are modified on the 
TIN surface. 

Mode The Extraction mode calculates XYZ data directly from the coordinate values of 3D 
MicroStation elements. The Interpolation mode produces XYZ data by interpolating 
between spot elevations along linear MicroStation elements. This mode works in both 
2D and 3D files wherein the elements are not represented with a defined Z value. 

Search 
Criteria 

The Select Criteria group box provides options to specify the features to be extracted.  
When a "check" is placed in the box next to Levels, the Select box is activated. Then 
click the Select button to invoke the Level Mask dialog wherein only those levels you 
want GEOPAK to search for when extracting data can be selected. If the Levels box is 
not turned on, GEOPAK searches all levels. The same procedure is utilized for other 
criteria selections. The three buttons located at the bottom of the Select Criteria group 
box Match, Display and Reset enable you to interactively define, highlight elements that 
match the search criteria or clear the search criteria respectively. 

Extract The Extract group box has several options for data extraction. Complex Chain reads 
those elements along adjoining MicroStation elements. Selection Set uses the 
MicroStation selection set tools to identify elements to extract. Fence extracts all 
elements within a fence boundary. View1, View2, View3, etc. extracts all selected 
elements displayed in the selected view. 

BUILD TOOLS 
Tools 
 

 
Menu Bar Build > Triangle 

Build > Lattice 
Build > Merge TINs 
Build > Clip TIN 
Build > Pad 
Build > Delta Surface 

Included under the Build pull down and icons are options for creating, manipulating and merging DTM 
models. This class addresses, in detail, only those options utilized in routine DTM operations.  

BUILD TRIANGLES 
Tool 

 
DTM Menu Bar Build > Triangle 

The Build Triangle tool processes the information stored in a DTM input file (.dat) to create a 
triangulated model (TIN). The file extension TIN (which is automatically assigned) represents a 
triangulated irregular network. 
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Data File  The DTM input file where the extracted topological features are stored. The file can also 
be selected via Files. If the full path is not given, GEOPAK utilizes the working 
directory to locate the file. 

TIN File  The filename in which the DTM data will be stored in a binary format. The file can also 
be selected via Files if the file exists. If the full path is not given, GEOPAK utilizes the 
working directory to locate the file. 

Dissolve 
Option  

This option will allow the elimination of external triangles based on the selected option. 
Note that internal triangles are not affected. The three options are: 
None - no external triangles are deleted. 
Sliver - long, thin triangles based on a hard-coded formula within the software are 
deleted. 
Side - external triangles where a side is longer than the user specified length are deleted. 

Process Commences the TIN creation process. 

 

ADDITIONAL BUILD OPTIONS 
Tool 
 

 
Menu Bar Build > Additional Tools 

Several additional Build tools are supported, which are detailed in the following table. 

Lattice Creates a gridded mesh (.lat) of the triangulated data (TIN) to create a three 
dimensional visual display of the topography. 

Merge TINs Two triangulated models to be merged together as long as the boundaries of 
one model overlaps the other at a minimum of one point. This process creates a 
third model (TIN) from the combination of the two existing models.   

Clip TIN Creates a new model (TIN) from a portion of an existing model. The area is 
defined as internal or external to a user defined polygon. 

Build Pad Defines a pad (such as a building) and integrates the pad into the existing 
terrain with a variety of slope options. 

Build Delta Tin Creates a new model based on the difference between two other models or a 
model and elevation surface. 
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REPORTS 
Tools 

 
Menu Bar Reports > Duplicate Points 

Reports > Crossing Features 
Reports > Tin Statistics 
Reports > Lattice Statistics 

Options under the Reports pull down and tool frame include a way to check for duplicate points or 
crossing breaklines, and the ability to generate statistics associated with a TIN or Lattice file. Each 
report is described in the following table. 

Duplicate Points  Reports points with the same x and y coordinates 
Crossing Features  Reports intersecting (same xy location, varying z) breaklines or contours. 
Triangle Statistics  
Lattice Statistics  

Displays a summary indicating the total count of each element type and 
minimum and maximum X, Y, Z ranges for the specified TIN or LAT file.  

 

UTILITIES 
Tools 

 

Menu Bar Utilities > Convert TIN 
Utilities > ASCII to Binary 
Utilities > Binary to ASCII 
Utilities > Check Triangulation 
Utilities > Metric to English 
Utilities > DTM 
Utilities > Import LandXML 
Utilities > Export LandXML 
Utilities > LIDAR XYZ Tools 

Tools under the Utilities pull down and tool frame include a way to check the validity of a triangulated 
file, converting triangulated files from previous versions of GEOPAK, converting the DTM data file 
between ASCII and binary format; as well as exporting the LATTICE information to the Trimble DTX 
format. They are detailed in the following table. 

Convert TIN  Converts a pre-GEOPAK 98 triangulated file to the current format. 
ASCII to Binary  
Binary to ASCII  

Reformats the DTM data file (.dat). 

Check 
Triangulation  

Verifies the integrity of the triangulated file. A message appears indicating 
“Triangulation Valid” if the file structure is intact. 

English to Metric 
Metric to English 
Metric to 
Imperial 
Custom 

GEOPAK TIN files are neither English nor metric. English and metric 
preference settings within GEOPAK are for volume purposes and do not affect 
the TIN. This utility converts an entire TIN file with optional translation and 
rotation tools. 

Export DTM This tool utilizes a lattice file to generate a Trimble DTX file, Trimble TTM 
file, or Leica GSI file suitable for use in Trimble and Lecia field equipment. 
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Import LandXML This tool is utilized to create a DAT file from a LandXML file. 

Export LandXML This tool is utilized to create a LandXML file from a TIN file. 
LIDAR XYZ 
Tools 

This tool set is used to process, filter, clip, compare, report, and display 
LIDAR data. 

 

LOAD DTM FEATURES 
 

Tool 

 

Menu Bar Load > DTM Feature 

Load is the process by which we can visualize the DTM data, TIN model, lattice model, and contours. 
By selecting the Load DTM Feature icon, the following dialog box appears. The designer can choose 
to load the DTM data (.dat), the TIN file (TIN), or the Lattice file (.lat). Each of these files can be 
loaded for the model extents, within a fence, or selected view. 

 

 
 

Activating the Display Only toggle enables you to view the elements without writing them to the 
MicroStation file (temporary display). Conversely, deactivating the toggle writes the DTM features to 
the MicroStation design file at the defined symbology. These elements can be placed as a graphic 
group when Display Only is deactivated. 
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 Activates the display of all Features. 

 Turns off the Display of all Features. 

 
Turns on only the selected Feature. This can also be accomplished by 
activating the toggle (below the list box) or double-clicking on an item 
that is turned off within the list box. 

 
Will turn off only the selected item. This can also be accomplished by 
activating the toggle (below the list box) or double-clicking on an item 
that is turned on within the list box. 

EDIT TOOLS 
Tools 

 

Menu Bar Edit > Triangles 
Edit > Duplicate Points 
Edit > Crossing Break Lines 
Edit > Filter Vertices 
Edit > Join Linear Features 
Edit > Z Range Clip 

GEOPAK supports an extensive range of powerful editing tools, both pre- and post TIN generating.   

Triangles The triangulated model can be dynamically edited in terms of adding, deleting 
or moving spot elevations. Break lines can be added, draped or deleted.   

Duplicate Points  Interactive editing of points in a DTM data file with the same X and Y 
coordinates within the data (DAT) file. 

Crossing Break 
Lines  

Interactive editing of crossing break lines and extracted contours within the 
data (DAT) file. 

Filter Vertices  Removes vertices from break lines or extracted contours  within the data 
(DAT) file when located within the specified Tolerance of another vertex. 

Join Linear 
Features  

The Join Linear Feature is useful when the source break line or contour line 
consists of several elements containing numerous vertices. In these cases, the 
end of one break line is the beginning of the next break line, so the software 
utilizes this as two separate break lines. During the Joining process, GEOPAK 
changes these from the beginning and end of individual elements to the 
beginning and subsequent shots of one element. 

Z Range Clip  Deletes individual vertices from the data file (.DAT) based on a user defined 
elevation range. 
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DIGITAL TERRAIN MODEL (TIN) 
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Ground XS and 
Profiles 

Analysis 
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LAB EXERCISE: DIGITAL TERRAIN MODELING 
The purpose of this exercise is to review the triangles of a tin file and to create contours from it.  

> Accessing DTM Tools 

1. Execute c:\data\geo\vdot\drain1\LAB01_V8ad.EXE. 

2. Open the MicroStation file, c:\data\geo\vdot\drain1\h17682.dgn. 

3. Access the GEOPAK DTM Tools frame. (Applications > GEOPAK Road > DTM Tools) 

> Load DTM Features 

1. Select the Load DTM Features icon from the tool frame. 

                                               

 

2. Change the Load File option to TIN. 

3. Select the TIN file located in c:\data\geo\vdot\drain1\survey.tin by clicking the Files icon. 
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4. Enable the toggles for Graphic Group and the Display Only . 

5. Select the Triangles Feature by highlighting in the list box. Notice that initially the display is 
set to OFF. You can control the display of an item three ways 

• Use the “lightbulb” icons to the right of the dialog box 
• Double-click on an item 
• Use the “display” toggle in the lower right corner of the dialog box 

Set the Triangles display to ON. At this point your dialog box should resemble the following: 
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6. Set the display symbology for the Triangles as indicated below: 

                                 

7. Click Load and review the results. 

8. When complete, toggle OFF the triangles. 

9. Select the Contours feature. Activate the Display Feature. Verify that ON is set in the 
Display field. 

10. Complete the bottom of the dialog box as indicated below. To complete the Minimum and 
Maximum Z, click the Read button, which will review the active TIN file and determine these 
values. 

 
11. Enable the Display Only toggle since we only want to “preview” our contours but not 

actually write them to the design file. 

12. Activate the Display of the Contour Lines and Labels and set the symbology as indicated 
below: 

 Level Color Weight Style Font TH / TW Distance 

Major Lines Level 10 4 3 0    

Major Labels Level 10 5 3 0 0 TH=3, TW=3 200 

Minor Lines Level 9 1 1 0    

 

13. Click the Load button to initiate the process. 

14. Close the Load DTM Features dialog box. 
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SUPERELEVATION SHAPES TO DTM TOOL 
The Shape to DTM tool reads GEOPAK superelevation shapes and creates a DAT file suitable for use 
in the Build Triangles tool in the DTM tool frame. Building this proposed tin of the pavement surface 
helps the designer to better analyze the drainage flow due to superelevation conditions (“hidden low 
points”, zero slope conditions, etc.) 

This tool can be invoked from Applications>Geopak Road>Cross Sections>Superelevation Shape 
Manager Tools.  

 

 

Job Gpk file where the chains and profiles of the drawn 
shapes are stored. 

Chain Chain associated with the superelevation shape, i.e., 
shape cluster baseline defined when the shape was 
created. 

From Station/To Station Lower and upper stationing to be used as the limits of the 
DAT file. 

Increment/Even The interval of points used for the data file. When 
Increment is used, the value is added to the From Station 
iteratively until the To Station is reached. When Even is 
utilized, the points are taken at even values within the 
station range. 

Plot Text Elevation When turned on, text is placed at each point included 
within the data file. 

Data File Data file to be created or appended. 

Mode The dat file can be created or a previously created dat file 
can be utilized, in which case, the data created in this 
procedure is appended to the original data 

Decimal Number of decimal places used when creating the Data 
file. 
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Apply Commences procedure. 

 

LAB EXERCISE: SHAPES TO DTM 
The purpose of this exercise is to create a proposed dtm from the superelavations shapes developed by 
the roadway designers.  

 Creating a Proposed DTM 

1. Attach the superelevation shapes dgn file: c:\data\geo\vdot\drain1\d17682work.dgn as a 
Microstation reference file. (MS Menu: File > Reference) 

2. Open Project Manager (MS Menu: Applications > GEOPAK Road > Project Manager) 

3. Select project:17682.prj located in c:\data\geo\vdot\drain1, and click OK. 

 
 

4. Access User: VDOT. 
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5. Click OK. The Road Project dialog will load. This will setup the proper directories for the 
location of the gpk file. 

 
6. Minimize the Road Project dialog box. 

7. Access the Superelevation Shapes Manager tools. (Applications > GEOPAK Road >Cross 
Sections >  Superelevation Shapes Manager Tools). 

8. Select the Shape to DTM icon. 

 
9. Populate the Shapes to DTM Surface dialog as shown below.  

 
10. Click Apply to create the proposed_pavement.dat. This file will be created in your active 

working directory: c:\data\geo\vdot\drain1. 

11. Access the GEOPAK DTM Tools frame. (Applications > GEOPAK Road > DTM Tools) 

12. Click OK to accept the Run. 
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13. Select the Build Triangles icon from the tool frame. 

 
14. Populate the Build Triangles dialog as shown below. 

 
15. Click Process to create the proposed_pavement.tin DTM file. 

16. Use the steps in the previous lab exercise to display the new triangles and contours along the 
pavement surface. 

17. Exit Microstation. 



Proposed Cross Sections to DTM 
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PROPOSED CROSS SECTIONS TO DTM  
The DTM Prop 3D tool locates specified proposed cross section elements and existing ground, and 
generates an x, y, z file of vertices for break lines suitable for use with GEOPAK's Digital Terrain 
Modeling. Each cross section generates one break line. In the hierarchy, the path follows (from left to 
right) existing ground until a proposed finish element is intersected. The proposed path is followed 
until it ties back to an existing ground element. 

 

Job Job which contains the cross section chain. 

Chain Chain utilized to generate the existing ground cross 
sections or the name on the XSCELL 

Current Station Defaults to the lowest stationed cross section in the 
file.  During processing, the current cross section 
being reported is displayed 

Begin Station / End Station GEOPAK determines the beginning and ending cross 
section station within the MicroStation file and they 
are noted below the chain and placed in the key-in 
areas. If these defaults are utilized, the report is 
generated for the entire set of cross sections. 
However, if a report for a smaller range is required, 
the user may simply key in the required beginning 
and/or ending station. 

Search Criteria: Existing 
Ground Line/Proposed Finish 
Grade 

Refers to the Microstation symbology used to draw 
the existing ground line and any Microstation element 
that makes up the upper layer of the proposed cross 
section. 

Pause on Each XS When the toggle is activated, the first section is 
processed and stops.  Each click of Apply processed 
another section.   

ASCII File Specify the name of the ASCII file to be generated. 
The designer has the option of keying in the file name, 
or clicking Files, invoking the Files dialog, wherein 
the designer may select the desired file. The file is 
placed in the current directory, unless a full path is 
specified. If the specified file name already exists, the 
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file is overwritten with no warning message given. 

Apply Commences processing. 

LAB EXERCISE: PROPOSED CROSS SECTIONS TO DTM 
The purpose of this exercise is to create a proposed dtm from the roadway cross sections developed by 
the roadway designers. The newly created dtm will include the existing and proposed elements of the 
roadway merged together. 

 Creating a Proposed DTM 

1. Open the Microstation file c:\data\geo\vdot\drain1\d17682xsmainline.dgn  (MS Menu: File > 
Open) 

2. Open Project Manager (MS Menu: Applications > GEOPAK Road > Project Manager) 

3. Select project:17682.prj located in c:\data\geo\vdot\drain1, and click OK. 

 
4. Access User: VDOT. 
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5. Click OK. The Road Project dialog will load. This will setup the proper directories for the 
location of the gpk file 

 
6. Click the Report &XS Quantities button 

7. Access the DTM Proposed 3D report. 
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8. Setup the DTM Proposed 3D Report dialog as shown below. 

 
Existing Ground Line: Lv Name: Level 1 

Proposed Finish Grade: Lv Name: Level 2 thru Level 13 

ASCII File Proposed.dat 

 

9. Click Apply to create the proposed.dat file. This file will be created in your active working 
directory : c:\data\geo\vdot\drain1. 

10. Access the GEOPAK DTM Tools frame. (Applications > GEOPAK Road > DTM Tools) 

11. Click OK to accept the run. 

 
12. Select the Build Triangles icon from the tool frame. 
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13. Populate the Build Trainagles dialog as shown below. 

 
14. Click Process to create the proposed.tin file 

15. Use the steps in previous lab exercises to display the new triangles and contours along the 
pavement surface. 

16. Exit Microstation. 

 



Drainage Analysis 

VDOT GEOPAK Drainage © 2007 VDOT 2-1 

2 
 

OBJECTIVES 
Learn how to use different Geopak DTM, shapes and VBA tools for the analysis and creation of 
drainage areas in a project. 

INTRODUCTION 
A Digital Terrain Model (DTM) represents the topography of a project in the form of a triangulated 
network. The DTM can be drawn in a 2D or 3D file, and then rotated to see the existing surface of the 
project area. The tools associated with the DTM are not related to and are independent of GEOPAK 
Drainage. 

ACCESSING 
The DTM tool frame can be accessed from the MS Menu: Applications>Geopak 
Road>DTM Tools. Then clicking on the DTM menu icon, the user can access 
the DTM tool bar depicted below. 

 

 

ANALYSIS TOOLS 
Tools 

 

Menu Bar Analysis > Height 

Analysis > Profile 

Analysis > Volumes 

Analysis > Elevation Differences 

Analysis > Slope Area 

Analysis > Themes 

Analysis > Drainage Tools 

Analysis > Visibility 

Analysis > Trace Slope Path 

Analysis > DTM Camera 

Analysis > Trench Volumes 



Analysis Tools: Drainage 

 
The Analysis tools allow you to visually analyze the digital terrain model utilizing numerous tools as a 
profile analysis, thematic analysis, drainage flow patterns, and visual portions on the model from any 
given location. 

Height To determine the height and other associated data dynamically based on 
user-defined data points within the model. 

Profile View a profile based on a user defined MicroStation element. 

Volumes To compute the volume between two TIN models, the volume between a 
TIN model and a plane, or the cut and fill totals between two TIN models 
while applying a shrinkage/swell factors. 

Elevation Differences Will display the elevation difference or the amount of cut and fill between 
two TIN models, or a TIN model and a plane of constant elevation. 

Slope Area The Slope Area tool displays the horizontal area and actual slope area 
(area following the terrain of the Model). 

Themes Displays the digital terrain model based on different user definable 
themes such as elevation ranges, slope percentage, slope degree, or 
aspect. 

Drainage Displays and analyzes drainage patterns within a TIN model. Tools 
include delineating watersheds, drawing flow arrows, determining 
upstream and downstream traces, finding high and low points, and ridge 
and sump lines. 

Visibility Based on a user-defined point of origin, GEOPAK visually displays 
which triangles can and cannot be seen, or what is visible between two 
points. 

Trace Slope Path Traces a path along a TIN file using a user specified slope and method. 

DTM Camera Allows a 3d visualization camera for the DTM 

Trench Volumes Compute the excavation volume needed along the drainage pipes. 

ANALYSIS TOOLS: DRAINAGE 
These are available tools within the dialog. 

 

Delineate All Watersheds Displays the watershed boundaries that exist within a DTM. 

2-2 © 2007 VDOT VDOT GEOPAK Drainage  



Analysis Tools: Drainage 

 
A Watershed is defined by either a low point within the TIN 
or a low edge point along the TIN hull. MicroStation shapes 
may be created for each watershed contained in the TIN. 
Two important options to consider are: 

• Minimum Low Point Depth: A DTM has many 
low points in which drainage areas could be 
delineated, but many of depth are small dips in the 
TIN file in which water will keep flowing. 
GEOPAK determines each low point, then 
determines if water placed at the specified depth 
overflows these dips in the DTM and flows into 
adjacent triangles. If it does not flow into adjacent 
triangles, it is identified as a low point and the 
drainage area is delimited. The designer must use 
the appropriate criteria to set this value. 

• Refine Watershed: this option processes the entire 
TIN evaluating ridges, sumps, and low points and 
determines more precise flow boundaries within the 
triangles. It does not retriangulate, more specifically 
it insert lines within the TIN that actually represent 
flow divides. 

Delineate Watershed The Delineate Watershed tool further delineates watersheds 
at any location within the TIN. A data point representing the 
pour point of the watershed is indicated and the contributing 
watershed area is computed and delineated.  

Drainage Patterns Evaluates the flow paths contained in a region of the TIN, 
Model or Object. This tool performs a downstream trace 
from the centroid of each triangle contained in the region 
specified. 

Downstream Trace Trace tool delineates the flow path downstream from a given 
point in the TIN. The indicated path follows the steepest 
descent from the point through the TIN terminating at a low 
point or the edge of the TIN. 

Upstream Trace Delineates the flow path upstream from a given point in the 
TIN. The indicated path follows the steepest ascent from the 
point through the TIN terminating at a high point or the edge 
of the TIN. 

Flow Arrows Indicates the direction of flow within the triangles for a 
given region of the TIN. 

Delineate Low Points Locates all low points within a region of a TIN. A flow 
arrow is placed and the text "LP" is placed at the triangle 
vertex. Text placement utilizes the current MicroStation text 
parameters. 

Delineate High Points Locates all the high points within a region of a TIN. A flow 
arrow is placed and the text "HP" is placed at the triangle 
vertex. Text placement utilizes the current MicroStation text 
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parameters. 

Delineate Ridge Lines Indicates the ridge lines within a region of a TIN. A ridge 
line is defined as a triangle edge where the flow on each side 
of the edge is away from the edge. 

Delineate Sump Lines Indicates the sump lines within a region of a TIN. A sump 
line is defined as a triangle edge where the flow on each side 
of the edge is towards the edge and is found in areas of 
concentrated flows such as streams and ditches. 

Surface Ponds Delineates the area(s) of ponded water within the specified 
TIN. 

Pond Analysis Traces a point downstream to a low point and fills it giving 
the volume, maximum depth, and maximum elevation. In 
addition, the pond delineation is graphically displayed. 
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LAB EXERCISE: ANALYSIS OF THE PROPOSED DTM 

Accessing DTM Tools 

1. Execute c:\data\geo\VDOT\drain1\LAB02_V8ad.EXE. 

2. Open the MicroStation file, c:\data\geo\VDOT\drain1\h17682da.dgn.  

3. Access the GEOPAK DTM Tools frame. (Applications > GEOPAK Road > DTM Tools) 

 

Reading Elevations with the Height Tool 

1. Access the DTM Menu tool bar. 

                                               
2. Select the Height tool from the DTM Menu. (DTM > Analysis > Height) 

 

3. Select the proposed tin file: proposed.tin located in c:\data\geo\VDOT\drain1 

4. Activate the Show Contour and Show Flow Arrow toggles. The color may be altered to your 
choice of colors from the active color table on the Height dialog box. The weight of the 
contour line and arrow are controlled by the active MicroStation settings. 
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5. Click the Start button and scan the surface model with the cursor to display the values for xyz 
and the slope on the DTM at the cursor point. 

6. Close the height/slope dialog. 

 

Dynamic Proposed DTM Profiles 

1. Select the Profile tool. from the DTM Menu. (DTM > Analysis > Profile) 

 

2. Use the Selection tab to identify your surface model (TIN File) which you will generate a 
profile from, and the symbology for your profile. 

3. Select the Tin File :proposed.tin by using the Select Files icon. 

4. Double-click on the symbology box (field to the right of the Files icon) to set the symbology 
representing the ground surface profile. You may choose any symbology you wish. Once the 
symbology has been set, click OK. 
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Lab Exercise: Analysis of the Proposed DTM 

 
 

5. Click the Add icon (top icon next to the list box) to add the feature to the collection box. 

 

6. Select the Profile Tab. 

7. Click the Place Element button to cut your actual profile at any desired area by just placing 
two data points (i.e. a line) or a series of data points (i.e. a line-string) across your surface 
model at any location. 

 

8. You can use the Preferences tab to set up a grid for your profile if desired. 

9. Close the profile dialog. 
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Analyzing Drainage Flow Pattern 

1. Select the Drainage Tools from the DTM Menu. (DTM > Analysis > Drainage Tools) 

2. Select the Drainage Patterns icon and fill the dialog box as shown below. 

 

3. Click the Apply button. The drainage flow lines are drawn into the design file. 

4. Close the drainage patterns dialog. 

 

Locating Low Points 

1. Select the Delineate Low Points icon and populate the dialog as shown below. 

 
2. Click Apply to review the low points location in the Microstation file. 

3. Close the delineate low points dialog. 
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Delineating Drainage Areas 

1. Select the Delineate All Watersheds icon and populate the dialog as shown below. 

 
2. Click Apply and review the tentative watersheds for the pavement drainage. 

3. Close the delineate all watersheds dialog when done. 

Note This process will define all the “mathematically” possible drainage watersheds. The designer 
will need to define the final drainage areas for the project.  

 

Scouting for Pond Locations 

1. Select the Surface Ponds icon. 

 
2. Select the Tin File: survey.tin located in c:\data\geo\VDOT\drain1. The proposed DTM does 

not cover the areas where possible pond locations area available. Setup the dialog as shown 
below. 
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3. Click Apply. Geopak will display the possible areas where ponded runoff is located. 

 

Analyzing the Pond Locations 

1. Select the Pond Analysis icon. 

 
2. Click Apply. 

3. Select a point inside one the delineated possible pond locations.  
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Lab Exercise: Analysis of the Proposed DTM 

 

 
4. Following the previous steps, analyze other possible pond locations. 

5. Close the pond analysis dialog when done. 
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LAB EXERCISE: PLOTTING PROFILE ELEVATIONS ALONG THE CENTERLINE 

Loading th VBA Application 

1. Load the DrawProfInfoInPlan.mvba macro located in 
c:\data\geo\VDOT\drain1\standards\Geopak. (MS Menu: Utilities > Macro > Project 
Manager). 

 
2. Highlight the VBA application and click on the Macros button. 

 
3. Execute the loaded macro by clicking on the Run button. 
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Lab Exercise: Plotting Profile Elevations along the Centerline 

 
4. Setup the Elevations tab part of the dialog as shown below. 

 
5. Double click on the text box to setup the text size and level symbology. 

 
6. Click Set when done. 

7. Select the Flow Arrows tab.  

8. Attach the Microstation cell library that contains the flow arrow cell : flow_arrow.cel located 
in c:\data\geo\VDOT\drain1\standards\Geopak. (Ms Menu: Element > Cells). 
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9. Close the Cell library dialog. 

10. Setup the Flow Arrows part of the dialog as shown below. 

 
11. Select the HP and LP tab and setup the dialog as shown below. 

 
12. Double click on the text box to setup the text size and level symbology. 

 
13. Click Set when done. 
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Lab Exercise: Plotting Profile Elevations along the Centerline 

 
14. Click the Draw button. Geopak will place the profile elevations along the centerline and show 

the direction of flow. The low and high points of the profile are also labeled. 

 
15. Close the dialog when done. 

16. Exit Microstation. 
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LAB EXERCISE: SETTING UP LAND USE AREAS 

Creating Land Use Shapes 

1. Open the MicroStation file, c:\data\geo\VDOT\drain1\h17682da.dgn.  

2. Create Microstation shapes depicting the land use areas of the project: pavement, grass, 
building, etc. (MS Menu: Tools > Main > Polygons) 

 
 

Assigning Proper Land Use Symbology 

1. Open Geopak Drainage. (MS Menu: Applications > Geopak Drainage > Drainage). 

2. Open the Geopak Drainage Library tool. (Drainage : Project > Drainage Library) 

3. Select the VDOT Drainage Library: VDOT.dlb located in 
c:\data\geo\VDOT\drain1\standards\Geopak. (Drainage  Library: File > Open). 

 
4. Close the Drainage Library dialog. 

5. Select the Land Use tool (Drainage: Component > Land Uses) 
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6. Select the Impervious land use. 

 
7. Click the Select Shape button.   

 
8. Select the previously placed Microstation shape that depicts the pavement portion of the 

project. A new level symbology will be assigned to the shape. 

9. Repeat the process with all the shapes defined and assign the proper land use. 

10. Close the dialog when done. 

11. Exit Microstation. 
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This page left intentionally blank. 

 

2-18 © 2007 VDOT VDOT GEOPAK Drainage  



Starting a Drainage Project 
using GEOPAK Road 
Project Manager 

 

VDOT GEOPAK Drainage  © 2007 VDOT 3-1 

3 
 

 

\OBJECTIVES 
In this chapter, you will learn more about: 

• Setting up a project using Project Manager. 

• How to utilize Project Manager as a workflow guide 

• How to access GEOPAK dialogs from the Project Manager 

• How Geopak Project Manager can help organize you project directories and files 

• Various file types used within GEOPAK Drainage. 

• Creating a new GEOPAK Drainage Project file. 

• The general process for using GEOPAK Drainage to design a storm drain system. 

INTRODUCTION 
Project Manager is a GEOPAK tool that associates a project with its respective coordinate geometry 
job number, users, working directories and project files. Project Manager provides an easy workflow 
system that keeps records of processes run throughout the design of a project. 

ACCESSING PROJECT MANAGER 
To access Project Manager, select Applications > 
GEOPAK Road > Project Manager or click the 
Project Manager icon. The adjacent dialog 
appears. 
The current directory is displayed at the top of the 
dialog. This may be modified by traversing to a 
different directory in the Directories list box.  
Project files (.prj) are displayed in the projects list 
box.   
The remainder of the Project Manager dialog 
displays information after a project has been 
selected from the Projects list box. At the bottom 
of the dialog are the OK and Cancel buttons. To 
exit Project Manager, click the Cancel button. To 
continue in the Project Manager process, click the 
OK button. 

 



PROJECT MANAGER MENU BAR 
 
PROJECT MANAGER MENU BAR 

There are three options on the Menu Bar: Projects, Directory, and Admin. Each of these choices has 
tools contained in the pull down. 

PROJECT TOOLS 
There are four options under the Projects pull down, New, Edit, Delete and Exit. 

The Windows motif also keeps track of the last few processes that have been executed, which may be 
recalled as needed by selecting the desired process.   

The New menu option is used to create a new project. The .prj file is stored in the directory shown in 
the Directory path at the top of the Project Manager dialog.   

 

The Project Name can be any number of alphanumeric characters. The Working Directory specifies the 
location of the project data files and may be manually entered. In lieu of typing, click the Select button 
and select the appropriate directory.  

Note The Working Directory can be left blank if it is desired to have all of the MicroStation and 
GEOPAK files in a single directory. 

The next field is for keying in the COGO Job Number or the Select button may be clicked and the 
appropriate COGO job number selected. 

Next, click Preferences, invoking the Project Preferences dialog.  

 

You may set the parameters for each project as well as the directories for the COGO job number, 
COGO input files and COGO output files. By setting these parameters for each project, you can open a 

3-2 © 2007 VDOT VDOT GEOPAK Drainage  



PROJECT MANAGER MENU BAR 
 

design file in one directory and then open another design file in a different directory and still access the 
correct .GPK file and also save COGO input and output files to the proper directory. Simply choose 
the project and all parameters are automatically set. After all the information is entered, click OK or, if 
you want to abort, click Cancel.   

Note If these fields are left blank, the project working directory is used. 

Shown below is a sample project that includes a project description, which may be keyed in at the 
bottom of the Create New Project dialog. 

 

Use the Edit menu option to change any settings associated with the currently selected project. 

Use the Delete menu option to delete any project that has been stored. Highlights the project in the 
Projects list box and select Delete. 

Use the Exit menu option to close the Project Manager and write the settings to a resource file. 

DIRECTORY TOOLS 
There are two options under the Directory pull down, Create New Directory and Current Working 
Directory. 

The Create New Directory option creates a new directory on the disk within the current directory. If 
the Current Working Directory option is chosen, the directory path in Project Manager is changed to 
that directory.  

ADMINISTRATION TOOLS 
Use the Administration menu option to set a password on a project, if needed.  
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PROJECT USERS DIALOG 

Once a project is highlighted and OK is selected, the Project Users dialog appears. 

 

This dialog has three sections: Project Users, User Info, and Description. The Project Users list 
displays a list of users that have been created to work with any project that resides in the current 
projects home directory. The names shown in Project Users will be the user id’s of the people working 
on that project as specified in the Start Job dialog. Within the User Info group box, the Full Name field 
further identifies the user, and displays the full name of the user that is currently selected. The OP 
Code field displays the GEOPAK Operator Code of the currently selected user. The GEOPAK 
Operator Code is used for all coordinate geometry operations during this session. The Operator Code, 
along with the Job Number is utilized whenever a COGO input or output file is created by the 
software. The Operator Code is typically the user’s initials. The Description field displays the 
description of the currently selected user. 

Four tools are supported on the Project Users pulldown: New, Edit, Delete, and Exit.  
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ROAD PROJECT DIALOG 
After at least one user has been defined, click OK or double click on a project user, which opens the 
Project Manager dialog. 

 

The top of the dialog displays the Working Directory, Working Alignment (if defined), User and 
GEOPAK Job Number. In addition, a toggle for Working Alignment Influence Runs is also supported.  
The bottom portion of the dialog displays the various processes supported during the design process.  
The small square in the upper right corner will condense the dialog as depicted in the graphic below.  

 

ROAD PROJECT DIALOG MENU BAR 
There are two pull down menu bar options: File and Remember. When the File option is selected, 
Close and Exit are supported.  

If you select the Close option, you are returned to the Applications dialog. If you select Exit, you are 
exited from the Project Manager. 

When you select the Remember option is selected, you can instruct the software to remember the 
Project or User in subsequent sessions. For example, if both toggles are activated, and the Project 
Manager is completely closed (all dialogs), the invocation of the Project Manager immediately invokes 
the Road Project dialog (flow chart) and utilizes the project name, user name, etc., which were active 
when the Remember toggles were selected.  

If you activate only the User toggle, you are returned to the Project dialog in later sessions. If you 
activate only the Project toggle, you are returned to the Project Users dialog in subsequent sessions. 
This option is useful when numerous users are working on one project.  

When you enable the Auto Sink option, the Road Project flow chart sinks behind all open views when 
any tool is selected from the flow chart. 
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WORKING ALIGNMENT 
The concept of a working alignment enables the designer to organize a project and to access project 
information without continually typing the required information. On a simple project, only one 
working alignment may be needed. On a more complicated project, an unlimited number of working 
alignments may be defined. With each working alignment, the designer can define associated data, i.e., 
name of cross section and plan view files, element symbology, etc. The designer can easily change 
from one working alignment to another by highlighting the desired alignment listed in the Select 
dialog. Once the working alignment is selected, all previously stored data is utilized in subsequent 
processing. Three tools relating to working alignments are located at the top of the Road Project 
dialog: 

• Select 

• Define 

• Working Alignment Influence Runs (toggle on left side of dialog) 

 

SELECT OPTION 

 

When you click the Select button, the Select Working Alignment dialog appears. If no working 
alignments have been defined, UNTITLED appears in the Run List box. If working alignments have 
been defined, they are listed with the last run time. The description of the working alignment can be 
seen in the bottom of the dialog when each Name is highlighted. To select a previously defined 
working alignment, highlight the run from the list, then click OK at the bottom of the dialog. Double 
clicking on the Name also selects a previous working alignment for subsequent processing. Clicking 
Cancel closes the Select Run dialog without any File selection. Several Run options are supported as 
detailed in the following table.   

 

New Create a new working alignment 

Copy Copy a run from an existing Project, a User in the same project or Run created by 
the current user. 
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Modify Change the name of the existing working alignment. 

Delete Delete an existing working alignment. 

DEFINE OPTION 
Once a Run has been selected, clicking Define opens the Working Alignment Definition dialog. 

 

The information that can be associated with a working alignment is listed in the left portion of the 
dialog. As each option is chosen, the right side of the dialog will change to reflect the information 
needed as can be seen in the dialog above after Plan View was selected.  

All information entered in these fields can be used in subsequent processes run from Project Manager.  
In the beginning of a project, much of this information will not be known, but as you go through the 
design process, it can be added to the working alignment definitions.  

For example, as soon as a chain has been stored in COGO, you can enter that information in the Plan 
View fields on the right side of the dialog. For a more complete explanation of each option shown, 
please see On-Line Help. 
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PROJECT MANAGER PROCESS 

 

The primary Project Manager dialog is shown above. The advantage of utilizing the Project Manager 
rather than selecting functions directly from the Road menu is that pertinent information stored within 
the Project Manager is automatically displayed within the invoked dialog. Therefore, job numbers, 
chain names, stationing, file names, and data associated with the project do not have to be typed in 
each time a dialog is utilized. However, you have the option to change the fields.  

Many of the Project Manager processes function identically to their corresponding dialog’s invocation 
from the Road menu. Some processes invoke the Select Run dialog prior to invoking the actual dialog.  
The Select Run dialog enables you to set up different options to use in alternative design choices or 
different typicals. 
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LAB EXERCISE:   PROJECT MANAGER 
Create a GEOPAK Road Project 

1. Execute c:\data\geo\vdot\drain1\LAB03_V8ad.EXE 

2. Open the MicroStation file C:\data\geo\vdot\drain1\h17682.dgn. 

3. Select the Road Tools tool frame (Applications > GEOPAK Road > GEOPAK Road Tools). 

4. Select the Project Manager tool (Applications > GEOPAK Road > Project Manager).  

5. Ensure that the project directory is set to  C:\data\geo\vdot\drain1\. 

 
6. Select Projects > New and create a new project. 

 

Project name: 17682 

Job Number: 101 

Project Description: GEOPAK Drainage Course Project 

 

7. Click Preferences. Ensure the dialog is populated as shown below. 
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8. Click OK. 

After exiting the Preferences dialog, you will return to the Create New Project dialog.   

 
9. Click OK. 

10. Click OK. An Alert message is displayed stating that Job 101 was not found in the Working 
Directory you have defined.   

11. Click Yes to automatically create this job file. The main Project Manager dialog is now 
displayed and the project has been created and ready to be accessed.   

Note The previous two steps may not occur if the designer is using the gpk file previously created 
by the roadway engineers. 

 

Create a User 

1. Highlight 17682.prj. 

To access the project, select the project by single clicking on name of the project in the dialog.  
The project is highlighted as shown in the following dialog with all pertinent information 
displayed.  

 

2. Click OK. 
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3. Select Users > New.  

 

4. Enter the New User information. 

Name VDOT 

Full Name VDOT 

OP Code vd 

5. Click OK. When prompted to define a password for this user, click No. 

6. Double click the user. You now see the Main Workflow dialog. 

 
7. Use the Remember option to have Project Manager remember our Project and User. 

 
8. Exit MicroStation. 
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GEOPAK DRAINAGE 

GEOPAK Drainage has four major components within each project: the GEOPAK Drainage File 
(*.gdf), MicroStation 2D design file, Drainage Library, and the MicroStation Cell Library. In contrast 
to the GEOPAK Drainage File and MicroStation graphics file, the Drainage Library and Cell Library 
are utilized for numerous projects, as they contain the Department’s standards. The designer only has 
to select the desired items for each specific project. 

File Type Description 
GEOPAK Drainage 
File (*.GDF) 

This binary file contains all the hydraulic information about the drainage 
system. Each GEOPAK Drainage Project contains Preferences, which 
include hydrologic and hydraulic computation options, visualization 
symbologies, and project file references to the Drainage Library and 
GEOPAK GPK files. Spatial data, connectivity and hydraulic properties 
for each drainage feature are stored in this external file. Sufficient data is 
maintained to rebuild the graphical representation of the Drainage Project 
with the exception of certain features, which are defined by MicroStation 
elements. 

MicroStation Design 
File (*.DGN) 

This two or three dimensional graphics file is utilized for the visualization 
of the drainage project and definition of certain drainage features using 
MicroStation graphic elements. The only data stored within this file are 
attributes attached to the graphics for reference to the GEOPAK Drainage 
file (.gdf). 

Drainage Library 
(*.DLB) 

The Drainage Library is utilized for numerous projects, as it contains the 
standards for an entire organization. The Drainage Library contains the 
Rainfall Parameters, standard inlet types, standard pipes configurations, 
spread sections, and land use symbology tables. All of these items are 
merely referenced by each project to accommodate standardization and 
information sharing among projects.  

Drainage Cell Library 
(*.CEL) 

Drainage cells are the plan views of the Department’s drainage structures 
such as inlets and manholes.  The Cell Library contains the commonly 
used structures.  The Nodes used in the Drainage Library refer to 
appropriate cells in the Cell Library. 

Design and 
Computation Manager 
database (*.DDB) 

The Design and Computation Manager database is used for the 
Department as a tool to expedite the drafting of plans using the VDOT 
CADD Standards. The D&C Manager also allows the designer to 
compute plan view quantities based on MicroStation level symbology. 

Geometry Database 
(*.GPK) 

The gpk file is a database that stores all the geometric information of the 
project. All alignments (chains), profiles, points, curves, spirals, parcels 
are saved into a single file per project. Then, Geopak Drainage can refer 
to the nodes location by station and offset from a particular chain and get 
or calculate elevations from a profile. 
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MicroStation Design File (*.DGN) 

  

Project Preferences 

Project Drainage Features 

Rainfall Parameters 

Land Use Symbology 

Inlets 

Pipes 

Drainage Project File (*.GDF) Drainage Library File (*.DLB)

Drainage Cell 
Library (*.cel) 

D & C Manager 
Database (*.ddb) 

 

DRAINAGE COMPONENTS 
GEOPAK Drainage organizes the components of a drainage system according to their spatial 
characteristics. Spatial information is stored as Nodes, Links and Networks. 

• Nodes: A node (inlets, manholes, etc.) is a point with a user-defined location. The location 
may be in Cartesian coordinates (x,y) or in curvilinear coordinates (station, offset).  

• Links: A Link represents a linear feature depicting a path connecting two nodes, traversing 
upstream to downstream. The path may be straight line or curvilinear (along a graphic 
element). 
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• Networks: A network is a system of interconnected nodes and links that form a system 
through which water can flow to a single outlet node. A drainage project accommodates any 
number of Networks. 

Other associated components in GEOPAK Drainage include: 

• Areas: A drainage area can be represented by a closed boundary or simply keyed-in (acres or 
hectares). All flows from a single drainage area are tributary to a single Node. There is a one 
to one correspondence between a node and an area. Therefore areas and nodes share the same 
name (ID). A drainage area may contain multiple sub areas representing homogeneous 
features such as soil types and land uses (“C” values), thereby allowing composite "C" value 
calculations. 

• Profiles: A profile represents a path connecting any two nodes in a Network. Profiles provide 
the visualization of profiles between any two nodes in a drainage network. 

MAIN MENU BAR 
GEOPAK Drainage is invoked from within a two dimensional MicroStation graphics file. At the 
Applications pull down, select GEOPAK Drainage, which accesses the software and displays the main 
GEOPAK Drainage menu bar as depicted below. 

 

Each menu selection accesses GEOPAK Drainage project information, feature placement and tools 
necessary to complete a GEOPAK Drainage project. Tool frames and toolboxes are also supported for 
all functions and are accessed via the Tools pull down. 

PROJECT MENU SELECTIONS 
The Project Menu selections are utilized for creating new GEOPAK Drainage projects, opening 
existing projects, saving projects, establishing the project Preferences, editing the Drainage Library, 
importing and exporting between GEOPAK Drainage Files (gdf). 
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COMPONENT MENU SELECTIONS 
The Component menu selections provide the mechanism to add, edit and delete the various elements, 
which comprise a drainage system including Areas, Nodes, Links, Profiles, and Land Uses. Each of 
these tools invokes a dialog wherein the specific component information can be added or edited.  

 

NETWORK MENU SELECTIONS 
The Network menu selections provide tools to add, edit, delete, and manipulate a drainage Network. 
While work is being done on a particular Network, it can be identified as the Active Network, which 
dictates which features are contained in the calculations and provides quick access to the components 
of a specific Network. Once a Network is added to the project and set as the Active Network, the 
Design and Analyze options perform their respective hydraulic procedures on the Network. 

 

REPORTS MENU SELECTIONS 
The Reports menu selections provide access to the predefined hydrologic and hydraulic reports 
available and to the Custom Report Builder and Generator. 
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TOOLS MENU SELECTIONS 

The Tools menu selections provide access to all Tool Boxes, Navigator, Labeler, Culvert, Routing and 
DTM Drainage Tools. 

 

GENERAL DESIGN PROCESS FOR STORM DRAINS 
The design of a storm drain system is usually an iterative process.  Inlets locations and pipe sizes are 
selected.  The designer then checks if the system meets the Department’s criteria and changes pipe 
sizes and other items as needed.  The need to check if the system meets criteria is not avoided by using 
GEOPAK Drainage.  This document describes several ways that designers can use GEOPAK to check 
and identify where the system need to be changed.  The following is a general outline for creating 
storm drain systems in GEOPAK.  Details are provided in other chapters. 

1.  Start a New Project file (.gdf) by setting Project Preferences. 

2.  Select Inlet locations and types by adding Nodes. 

3.  Define the Areas to each node 

4.  Link the inlets together with pipe segments. 

5.  Identify the Network of pipes and inlets. 

6.  Use GEOPAK to Design the system. 

7.  Check if the design meets criteria. This can be done by several methods such as profiles, querying, 
warnings, or output reports. 

8.  Edit the system, re-compute the hydraulics and check if criteria are met. 

9.  Print the VDOT Storm Drain Tabulation Form. 

Note It is recommended that the designer should create or use an already existing Geopak Road 
Project Manager file (*.prj). This will help locate other project files that Geopak Drainage may 
use (Design and Computation Manager ddb file, Coordinate Geometry gpk file, etc). 

VDOT VBA APPLICATIONS 
The Department has provided VBA applications for specific tasks during the design and plans 
production process of the drainage system. These VBA applications are accessed thru the 
MicroStation: Utilities>Macro menu. They are: 
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• Draw flow arrows along the roadway centerline analyzing the profile conditions. 

• Draw Drainage Storm Sewer Tabs: creates an Excel spreadsheet for the VDOT Storm Tabulation 
form with information extracted from the GEOPAK Drainage gdf file. 

• Sketch of Geopak Drainage Network: creates a jpg image with a sketch (not to scale) of the 
selected drainage network. 

• Draw flow directional arrows along the pipes. 

ACCESSING GEOPAK DRAINAGE 
GEOPAK Drainage is invoked from within a two dimensional MicroStation graphics file. At the 
Applications pull down, select GEOPAK Drainage, which accesses the software and displays the 
Drainage application into the MicroStation pull-down menu. 

Each menu selection accesses GEOPAK Drainage project information, feature placement and tools 
necessary to complete a GEOPAK Drainage project. Tool frames and toolboxes are also supported for 
all functions and are accessed via the Tools pull down. 

GEOPAK Drainage always starts in an ‘Untitled’ project as noted in the MicroStation menu bar. 
Therefore it is necessary to always either create a new project or open an existing project prior to 
performing any other GEOPAK Drainage functions. 

 

LAB EXERCISE: CREATING A NEW GEOPAK DRAINAGE PROJECT 
> Opening Road Project Manager 

1. Open the MicroStation file c:\data\geo\vdot\drain1\h17682.dgn. 

2. Open Project Manager (MS Menu: Applications > GEOPAK Road > Project Manager) 

3. Select project: 17682.prj located in c:\data\geo\vdot\drain1, and click OK. 
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4. Access User: VDOT 

 
5. Click OK. The Road Project dialog will load. This will setup the proper directories for the 

location of the gpk file. 

 
6. Minimize the Road Project dialog box. 

 

> Create a New Geopak Drainage Project 

1. Access GEOPAK Drainage (MS Menu: Applications > GEOPAK Drainage > Drainage). 

All items in Drainage can be accessed through this main GEOPAK Drainage menu. GEOPAK 
Drainage opens in an Untitled project file. 

2. Create a new drainage project, c:\data\geo\vdot\drain1\h17682.gdf (GEOPAK Drainage 
Menu: Project>New). 

The following files are utilized for this project. 
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Drainage Design File h17682.dgn 

Reference File (land use file) h17682da.dgn 

Reference File (proposed roadway file) d17682des.dgn 

Reference File (existing topography) s17682.dgn 

Reference File (service utilities) su17682.dgn 

English Drainage Library vdot.dlb 

English Cell Library drainage.cel 

GPK Alignment File job101.gpk 

GEOPAK Drainage File (to be created) h17682.gdf 

Existing Triangulated Irregular Network file (TIN) survey.tin 

Proposed Triangulated Irregular Network file (TIN) proposed.tin 

 

3. Select the Main Drainage Tools tool frame. (GEOPAK Drainage Menu: Tool Boxes > Main) 

The GEOPAK Drainage tool frame is similar to the MicroStation main tool frame, is 2x7, not 
resizable, but can be docked. 

 

During the course you will become familiar with the various tools on this tool frame. 
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OBJECTIVES 
The objective of this chapter is to review the Project Preferences. 

INTRODUCTION 
GEOPAK Drainage supports a wide array of user defined Preferences which enables the designer to 
set project specific options, or a large organization to set parameters to maintain standards. Each 
GEOPAK Drainage project contains a set of Preferences and they remain with the project. 
Computation options in the Preferences may be changed easily and the systems completely redesigned 
utilizing the new computation options. The Preferences are invoked via Project > Preferences menu 
selection. The Drainage Preferences can also be invoked by selecting Tool Boxes > Main, then 
identifying the Drainage Preferences tool, (first column, top box). 

 

The general Options are displayed in a list box in the left side of the dialog, while the right side 
displays parameters for the highlighted Option. As different Options are selected in the list box, the 
right side of the dialog will change dynamically to reflect the parameters for highlighted Option. 



UNITS 
 
UNITS 

The first Preference is Units, which establishes the input and output units for the current project. Two 
supported options are English and Metric. FDOT supports only English units. 

 

Within each group box is a listing of the units utilized for GEOPAK Drainage. These are display only 
and cannot be changed. 

Projects with mixed units are not supported within GEOPAK. There are no other unit specifications 
within the project. The data input is expected to be in the proper units (English and Metric). As fields 
are entered in the dialogs the units required will be displayed in the MicroStation Command Prompt. 

Coordinate geometry databases (GPK files) must also be in the specified units when created within 
GEOPAK ROAD. For additional information on this topic, refer to the GEOPAK Online help > 
Coordinate Geometry. 

PROJECT COMPONENTS 
The Project Components define the location of all files utilized by the project. 
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Drainage Library File 
(DLB)  

Reference to the Drainage Library file containing the Rainfall Parameters, Land 
Use Options, Node Library items, Link Library items and spread sections. This 
file can be located within the working directory, in which case, no path need be 
specified. However, a more prudent option is placing the Drainage Library File on 
a central server or directory, so that all hydraulics designers can access the same 
database. This ensures standardization and minimal maintenance. The file name 
(and optionally, the path) may be supplied. Clicking Files opens the MicroStation 
File Manager, wherein the path and database file may be selected. 

The drainage library is vdot.dlb.  The file is provided by VDOT.   

GPK Job Number  
(optional) 

GEOPAK coordinate geometry database which contains all alignment and profile 
information for the project. Creation and manipulation of this binary file must be 
accomplished from within GEOPAK ROAD. The file name of the database is 
job*.gpk, where * is a one to three alphanumeric name unique to each project. It is 
this name that should be typed into the GPK Job Number field. In lieu of typing, it 
may be selected by clicking Select. For VDOT project the job number is always 
101, but for that particular reason, special attention must be given to the directory 
path where the gpk file of the project is located.  

Road Preferences  

 

The working directory, wherein the GEOPAK coordinate geometry database is 
located, is specified within this dialog. The directory may also contain other 
project files, which is desirable; however, this is not required by GEOPAK 
Drainage.  

The designer should adjust the Output Accuracy group settings as desired, since 
they will not affect the precision and accuracy of the drainage calculation. They 
are just output values. 

Drainage Cell Library Cell library containing cells utilized for Nodes contained in the Drainage Library. 
The cell library is drainage.cel. The file is provided by VDOT.   

Criteria Directory Directory wherein the criteria to draw nodes, links and other drainage data onto 
cross sections is stored. VDOT does not uses this functionality. 

GEOPAK DDB Defines the Design and Computation Manager which is utilized for matching pay 
items to the Drainage Library in order to draw nodes and links at the desired 
symbology and final quantities computation upon completion of the drainage 
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design. The file is VDOTenglish.ddb. 

Water and Sewer Project To leverage data from a Water and Sewer project, activate the toggle, then select 
the directory and GWS file. This is not a required element for the drainage design. 
VDOT has not standardized the usage of GEOPAK Water and Sewer. 

Shape File 
 

Optional, GEOPAK superelevation shapes created in GEOPAK Road can be 
leveraged into drainage. Specify the path and file name by manual entry via the 
browse icon. In order to utilize and extract superelevation shapes data from the 
superelevation shape file, the file must be referenced into the active design file. 

Site Project 
 

To leverage data from a Site project, activate the toggle, then select the directory 
and GSF file. A site project model or object may be used. This is not a required 
element for the drainage design. VDOT has not standardized the usage of 
GEOPAK Site. 

Original Ground 
 

The Model , Object or tin file to be used as existing ground. The Original Ground 
profile along the drainage pipes is drafted when drawing the profile of the 
drainage system. 

Design Surface 
 

The Model , Object or tin file to be used as another reference surface, in this case 
as a “proposed” surface. The Design Surface profile along the drainage pipes is 
drafted when drawing the profile of the drainage system. 

RAINFALL PARAMETERS 
The Rainfall Parameters dialog establishes the rainfall parameters for computing intensities and 
discharges for the current project. 

 

 
Rational Method 
Rainfall Source 

The Rainfall Data Source for computing intensities and discharges, which is 
stored within the Drainage Library File, therefore it may only be selected here. 
Select the zone where the project is located.  Refer to the FDOT Hydrology 
Handbook for the boundaries of the zones  

SCS Method: The Rainfall Data Source for computing discharges, which is stored within the 
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Rainfall Source Drainage Library File. Therefore, it may only be selected here. The Antecedent 
Moisture Condition I is the lowest runoff potential (dry soil), while Antecedent 
Moisture Condition II is the average condition, while Antecedent Moisture 
Condition III is the highest runoff potential (saturated soil).  

Hydrograph Time 
Interval 

Specified in minutes. 

LAND USE OPTIONS 
The Land Use dialog establishes the land use options used to delineate sub areas and runoff 
coefficients for the current project. 

 

Different Single and Multiple Land Use Items can be defined for the Rational and SCS Method.  

Since the Rational Method is the standard methodology used for VDOT Storm Drain projects, the 
designer should disregard the settings for the SCS Method. 

Single Land Use Item The land use source from the Drainage Library containing the runoff 
coefficients and symbology for land use delineation may be selected from the 
list box. 

Multiple Land Use Item The land use sources from the Drainage Library containing the runoff 
coefficients and symbology for land use delineation. To select, utilize the 
down arrow in the list box and select the desired option. The item selected 
must be associated with a symbology that matches the symbology of each of 
the main land use shapes in the design file. The Department has only defined 
a Single Land Use Item in their Drainage Library. Therefore, this option 
would not be used by the designers. 
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FREQUENCY OPTIONS 

The Frequency Options dialog establishes the computation frequency and runoff peaking factors for 
discharge computations for the current project. 

 

 
Drainage Library File 
(DLB) 

The current Library File as specified in the Project Component option, is 
displayed. It cannot be changed from this dialog, only in the Project Components. 

Computation Frequency 
(Rational Method) 

The displayed frequencies are selected from the available entries in the Rainfall 
Parameters chosen from the library. Select the appropriate frequency for the 
project. Refer to the VDOT Drainage Manual for further details. These fields 
cannot be modified except through the Drainage Library dialog.  

Cumulative Frequency 
(SCS Method) 

The displayed depths are selected from the available entries in the Rainfall 
Parameters chosen from the library. The SCS approach is not standard for VDOT 
storm drains, but it can be used for preliminary routing calculations. These fields 
cannot be modified except through the Drainage Library dialog.  

Peaking Factors Runoff coefficient peaking factors to be applied in the runoff computations. These 
factors are used to adjust runoff coefficients for differing frequency rather than 
entering multiple set of coefficients for each frequency. 

4-6 © 2007 VDOT VDOT GEOPAK Drainage 



INTENSITY OPTIONS 
 

INTENSITY OPTIONS 
The Intensity Options dialog establishes the intensity computation options for the current project.  

 

 
Drainage Library File 
(DLB) 

The current library file, as specified in the Project Component option, is 
displayed. It cannot be changed from this dialog, only in the Project 
Components. 

Minimum Time of 
Concentration 

Minimum Time of Concentration to use in discharge computations. This is used 
throughout the computations as the minimum. In pipe hydraulic computations 
this value will be used until the actual time of concentration within the systems 
exceeds this value. Specified in terms of minutes.  
The VDOT Drainage Manual specifies a minimum of 5 minutes. 

Accumulate Pipe Flow 
Time by: Uniform Flow 
Velocity 
Full Flow Velocity 
Iterative Velocity 

This option controls how travel times through the pipes are determined. The 
following provides an overview. 

VDOT uses the Uniform Flow Method. When selected, the velocity associated 
with normal depth (uniform flow) establishes the travel time. 

If Full Flow Velocity is selected, the velocity associated with full flow velocity 
(V= Q/A) establishes the travel time.  

If the Iterative Velocity method is selected, GEOPAK makes three passes up and 
down the network performing runoff and hydraulic calculations. By making 
several passes, the velocity used to compute the travel time closely matches the 
actual flow conditions. For pipes flowing full, the full flow velocity (V= Q/A) 
establishes the travel time. For pipes flowing partially full, the average velocity 
through the pipe establishes the travel time. GEOPAK performs backwater curve 
(water surface profile) calculations so the average velocity is often different than 
normal depth (uniform flow) velocity.  

Intensity Options Group Intensity options which allow for specification of an absolute (constant) intensity 
or computed intensities to use throughout the network discharge computation 
procedures. 
Select Compute Intensity from Library Rainfall Data Source for VDOT 
project since the rainfall intensities are already predefined in the library. 

VDOT GEOPAK Drainage  © 2007 VDOT 4-7 



JUNCTION LOSSES 
 

Compute Intensity from 
Library Rainfall Data 
Source  

Utilizes the values established and computed from the Rainfall Parameters 
(either default equation or table) from within the Drainage Library File.  

Absolute Intensity  A constant intensity that overrides the Drainage Library File and utilizes the 
specified value for all discharge computations. It is specified in terms of in/hr or 
mm/hr depending on the project units. 

Weight Time of 
Concentration  

When utilizing combining different types and times of concentration, activating 
this toggle weights the times of concentration such that the discharge will not 
decrease. Ignore this toggle for VDOT projects. 

Inlet Computation Only: 
Absolute Intensity  

A constant intensity that overrides the Drainage Library File and utilizes the 
specified value for discharge computations required for inlet and spread 
calculations only. Network hydrologic discharges will be computed as specified 
in the Intensity Options. Note, however, for the value to be utilized, the toggle to 
the left of the Absolute Intensity within the Inlet Computation Only group box 
must be activated or the value will be ignored. Specified in terms of in/hr or 
mm/hr depending on the project units. 
VDOT performs most inlet and spread calculations on 4 in/hr.  

JUNCTION LOSSES 
The Junction Losses dialog establishes the junction loss equations and coefficients utilized in Link 
hydraulic calculations for the current project. When selected from the Options list, the dialog depicted 
below is displayed. 

  

Unique Loss Coefficients (K) can be specified in the fields to the right of each Description, and apply 
to the whole project. On the other hand, designers can specify a particular Loss Coefficients for each 
junction in the "Node Configuration - Junction Loss" Dialog box discussed in the Nodes Chapter. 
However, if the Disable All Junction Loss Computations is activated, no losses will be computed for 
the entire project.  
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Disable All Junction Loss 
Computations 

If the toggle is active, no Junction Loss computations are calculated, regardless of 
the option selected in the Nodes - Junction dialog. Note if a single or small 
number of Junction Losses are not desired, an option is provided in the Nodes - 
Junction dialog to accomplish this. The toggle here applies to the entire project. 

Loss Velocity Losses can be computed on Actual or Full Flow. 

Pressure Expansion Loss coefficient to be used in pressure (full flow) expansions within the system. 

Free Surface Expansion Loss coefficient to be used in free surface (partial flow) expansions within the 
system. 

Pressure Contraction Loss coefficient to be used in pressure (full flow) contractions within the system. 

Free Surface Contraction  Loss coefficient to be used in free surface (partial flow) contractions within the 
system. 

Bend Loss Specify the methodology and source of bend loss computations. Method 1 utilizes 
Modern Sewer Design, while Method 2 utilizes AASHTO methods. 

Terminal Inlet / Junction Loss coefficient to be used at terminal inlets or junctions (no upstream pipes) 
within the system. 

Simple Junction Specify the methodology for computing junction losses at simple junction (one 
pipe into the junction and one pipe out).  

Complex Junction  Specify the methodology for computing junction losses at complex junctions 
(more than one pipe in and only one pipe out).  

 

INLET OPTIONS 
The Inlet Options dialog establishes the default inlet variables to use in the Node Configuration 
Properties dialog for each type of Inlet.  
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Inlet By Pass Options This option indicates the method by which Inlet by pass flows are accounted for in 
the system. By Pass as Total Discharge will account for by pass flows as the 
difference between the total discharge to the inlet and the inlet capacity. This 
difference, expressed in flow units, will be the total by pass from the inlet and can 
be added at a subsequent downstream inlet.  

VDOT spread calculations have typically been performed using this approach.  

By Pass as C x Area Product, on the other hand, is determined from the total 
bypass at the inlet as a product of runoff coefficient and drainage area that is 
contributing to the total bypass at the inlets computed intensity. This product of 
area and runoff coefficient will then be added to the composite runoff coefficient 
and area at the downstream inlet. 

Link By Pass Options This option indicates the method by which Inlet By Pass flows are accounted in 
the Link discharge computations. Do Not Allow Inlet By Pass in Link Discharges 
will prevent the system from bypassing discharges from one inlet to the next when 
Link discharges are computed. The total discharge that reaches the inlet will be 
considered entering the Link at that point. This option in no way impacts the inlet 
computations, bypass flows will be reflected in these computations.  

VDOT uses this first approach. 

Allow Inlet By Pass in Link Discharges will account for the discharge that 
bypasses the inlets when the Link discharges are computed. Only the discharge 
entering the inlet will be considered entering the Link at that location. Bypass 
flows will be directed to the appropriate inlet and the Link accordingly. 

Default Spread N Value The default Manning's roughness coefficient for the spread hydraulic 
computations.  

Extend Superelevation 
Shapes to Inlet at Shape 
Slope 

This option extends the slope of the last superelevation shape to the drainage 
location point of the drainage node. E.g., sometimes roadway superelevation 
shapes are not created to the extend of the whole pavement width. 
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NODE OPTIONS 
The Node Options establish the default naming prefix for Node entries and option for automatic link 
updates.  

                

 
Default Node ID Prefix This prefix will be added to the beginning of the each defined Node element 

automatically and then numerically sequenced by one. For example, the first 
Node stored would obtain default ID in this case of 3– 1” followed by “3 – 2”, 
“3– 3”, etc. for subsequent Nodes. 

Scale Node Cells / 
Scale Factor 

When active, the node cells are scaled based on the specified scale factor. In this 
way, the node cell can utilize standard node dimensions, but the cells are scaled 
in plan view. VDOT cells should be placed at 1.0, so inactivate the Scale Node 
Cells or set them to 1.0 

Minimum Freeboard This value does not affect the hydraulic computation in any way.  It is used 
solely to trigger a warning message (HGL Blowout) if the hydraulic gradient 
causes less free board.  GEOPAK measures freeboard from the hydraulic 
gradient to the inlet elevation.  
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LINK OPTIONS 

The Link Options dialog establishes the default Link design constraints. 

 

 
Default Link ID Prefix This prefix, similar to the one found in the Node Options, is added to the 

beginning of the each defined Link element automatically and then numerically 
sequenced by one. For example, the first Link stored would obtain default ID in 
this case of “pipe – 1” followed by “pipe – 2”, “pipe– 3”, etc. for subsequent 
Links. 

Link Profile Options 
group box 

A pipe profile envelope is developed which represents the minimum soffit 
elevation and maximum invert elevations for each network. This envelope is 
derived from an evaluation of all the constraints of the system; minimum and 
maximum depth, minimum and maximum pipe rise, minimum and maximum 
slope, and any elevations held through the system. These constraints are 
established later in the Link and Node dialogs. Refer to the Link and Node 
Chapters for additional information. The Minimize Pipe Size option will use the 
entire envelope to size pipes. If a smaller pipe will fit within the envelope at a 
steeper slope then it will be selected as the candidate of choice. If using the entire 
envelope does not result in smaller pipes then the top of the envelope will be used 
and the appropriate pipe fitting this slope configuration will be selected. 

The Minimize Depth of Cover will size pipes based on the top of the envelope, 
minimum soffit elevation and the pipe fitting this slope configuration will be 
selected. One Design Optimization method per project may be selected, however, 
the option may be changed anytime during the design process, the results 
quantified, and the effects of the Design Optimization reviewed. 

Minimize Pipe Size Drainage bases the design on minimizing pipe size, even though this may 
encourage deeper excavation.  

Minimize Depth of Cover Drainage designs the system with minimal excavation, but utilizes larger pipe 
sizes.  

Elevation Option  This refers to the elevation reported for the ends of the links. Two options are 
supported: at Hydraulic Center and at Actual Link End. Hydraulic Center reports 
the elevation at the center of the node structure. Actual Link End reports the 
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elevation at the inside of the structure wall.  Use Actual Link End for VDOT 
projects.  The option selected is reflected in the Link dialog in the condition 
option. 

Link Design Options  Only one option may be selected for a project, however, this may be changed 
during the design process.  

It is not critical what is selected here, because the pipes will likely be adjusted to 
meet standards after GEOPAK initially designs the system. . 

Design for Maximum 
Capacity 

This option sizes pipe using maximum capacity. This typically occurs at some 
percentage (90%)  less than full.  

Design for Full Capacity This option sizes pipe using full flow (100%) by depth. If a pipe is designed, the 
smallest size corresponding to a capacity greater than the discharge will be 
selected. 

Design Partial Capacity  
(d/D) Ratio  

The ratio of the diameter of the pipe capacity versus the diameter of the total pipe 
to be used as the maximum capacity in pipe sizing as depicted in the graphic 
below. Note the value is a ratio (in decimal format) which must be equal to or 
smaller than one. If the value is equal to one, the pipe is designed for full 
capacity. 

 

Design Partial Capacity  
(q/Q) Ratio  

The ratio of the pipe capacity versus discharge to be used in computing maximum 
capacity in pipe sizing algorithms. For example if the value is set to 0.5 then all 
pipes designed will have a capacity of twice the discharge and if set to 2.0 the 
pipes would have half the capacity of the discharge 

Link Slope Decimal Options range from none to four. This limits the number of decimal places 
reported for most link slopes. 

Link Criteria File Name of criteria file which draws links onto cross sections. 

VDOT does not draw drainage structure cross sections as a standard. Therefore, 
this entry should be blank. 

Hydraulic Gradeline 
Options  

 

Equal Hydraulic 
Gradeline 

This option for computing hydraulic gradelines assumes that the starting 
downstream hydraulic gradeline of one Link is equal to the upstream hydraulic 
gradeline (plus junction losses if applicable) of the downstream Link. 

Use this for all VDOT projects. 

Equal Energy Gradeline This option for computing hydraulic gradelines assumes that the starting 
downstream energy gradeline of one Link is equal to the upstream energy 
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gradeline (plus junction losses if applicable) of the downstream Link. The 
hydraulic gradeline will then proceed from the energy gradeline less the velocity 
head in the pipe. If the energy value in the downstream Link does not exist (too 
low) in the upstream pipe, the minimum specific energy and critical depth are 
used at the downstream end of the Link.  

 

PROFILE OPTIONS 
The Profile Options establishes the default naming convention for profiles along the links designed. 

 

Default Profile ID Prefix 
 

This prefix is added to the beginning of the each defined profile automatically and 
then numerically sequenced by one. For example, the first Profile stored would 
obtain default ID in this case of "PRO–1" followed by "PRO–2", "PRO–3", etc. 
for subsequent Profiles. If the links are to be used for COGO chains or profiles, 
the length of this prefix should be within the parameters for chain and profile 
character limitations. 

Create COGO Chains and 
Profiles 

When toggled on, the links are stored in the coordinate geometry database (GPK) 
specified in the Preferences - Project Components. The link name is used as both 
the chain and profile name. Stationing starts at 0+00. 
This is not applicable to VDOT projects. 
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PLAN SYMBOLOGY 
The Plan Symbology dialog establishes the element symbology for drawing the drainage features 
during the design process.  

 

These are “design process” symbology, therefore it does not need to match VDOT CADD standards. 
When the design is completed, GEOPAK Drainage will update automatically all the CADD elements 
to be complied with VDOT standards using the Design and Computation Manager. 

 
Linear Any valid MicroStation symbology may be specified for drawing the component. 

To set the symbology, double click on the graphic, which opens the Set Feature 
dialog. 

Text Any valid MicroStation text parameters may be specified. To set the symbology, 
double click on the graphic, which opens the Set Feature dialog. 

Label GEOPAK Drainage will automatically label drainage areas, nodes and link to aid 
during the design process when the toggle is activated  

UPDATES 
The Updates dialog enables you to determine whether various data is updated during the design 
process. You may toggle on as many options as desired. When toggled on, the automatic updating is 
activated. If the option is not toggled on, no automatic updating occurs. 
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SAVE OPTIONS 

 

Automatically Save 
Drainage Updates 

When activated, the Drainage project file (.gdf) is saved every time an Apply 
command is issued from any Drainage dialog. 

Automatic Backup When activated, a backup file is always created (in the project directory with a 
*.bak extension) when the project is opened. 

Automatic Save To automatically save, activate the toggle to the left of the option, then select the 
desired time interval. 

PRINTING THE PROJECT PREFERENCES 
Users may print all of the preferences by going to Project > Export >Preferences to ASCII. 
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LAB EXERCISE: PROJECT PREFERENCES 
The Project Preferences control the graphic and computational options of the drainage system. The 
Project Preferences may be changed at any time and the system can then be redesigned or analyzed 
utilizing the new preferences.  

> Setup the Project Preferences 

1. Execute c:\data\geo\vdot\drain1\LAB04_V8ad.EXE. 

2. Open the MicroStation file, c:\data\geo\vdot\drain1\h17682.dgn. 

3. Open Project Manager (MS Menu: Applications > GEOPAK Road > Project Manager) 

4. Select project:17682.prj located in c:\data\geo\vdot\drain1, and click OK. 

 
5. Access User: VDOT. 

 
6. Click OK. The Road Project dialog will load. This will setup the proper directories for the 

location of the gpk file. 
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7. Minimize the Road Project dialog box. 

8. Access GEOPAK Drainage ( MS Menu: Applications > GEOPAK Drainage > Drainage).  

9. Select the drainage project, c:\data\geo\vdot\drain1\h17682.gdf. (Drainage Menu: Project > 
Open).  

10. Select the Preferences tool (Drainage: Project > Preferences).  

Establish the preferences by selecting each option in the columns and defining the various 
values. 

11. Highlight Units.  
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12. Click Project Components. Populate the dialog as shown below.  

 
 

GPK Job Number Job101.gpk. 

Original ground survey.tin 

Note Click the Road Preferences button to setup the proper location of the gpk file. 

13. Click Rainfall Parameters. 

We will use the Rational Method for the Storm Sewer design.  

 
 

Rational Method Campbell 

SCS Method Type II 
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14. Highlight Land Use Options. 

15. Set the Rational Method Single Land Use to VDOT .  

 

16. Highlight Frequency Options.  

17. Set the Rational Frequency and the SCS Frequency options as shown below. 
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18. Highlight Intensity Options. 

 
 

Minimum Time of Concentration 5 minutes 

Accumulate Pipe Flow Time by Uniform Velocity 

Intensity Options Use Compute Intensity from Library Rainfall Data 
Source 

Inlet Computation Only Toggle ON , 4.0 

 

19. Highlight Junction Losses. 

20. Toggle ON Disable All Junction Losses Computations. 
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21. Highlight Inlet Options. 

 

Inlet By Pass Options By Pass as Total Discharge 

Link By Pass Flow Options Do Not Allow Inlet By Pass in Link Discharge 

Default Spread n Value 0.015 

 

22. Highlight Node Options. 

 

Default Node ID Prefix 3- 

Scale Node Cells Toggle OFF 

Minimum Freeboard 1.00 
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23. Highlight Link Options. 

 

Default Link ID Prefix pipe- 

Design Optimization Minimize Depth of Cover 

Elevation Option at Actual Link End 

Link Design Options Design for Maximum Capacity 

Link Slope Decimal 2 

Hydraulic Gradeline Options Equal Hydraulic Gradeline 

24. Highlight Profile Options. 

 

Default Profile ID Prefix Pro- 

Create COGO chains and 
profile 

Toggle OFF 
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25. Highlight Plan Symbology. 

26. Establish the symbology of the different project elements according to your standard 
conventions. The Preferences may be changed at any time during the course of the project. 

 

. 

Note These are “design process” symbology, therefore it does not need to match VDOT CADD 
standards. When the design is completed, GEOPAK Drainage will update automatically all the 
CADD elements to be complied with VDOT standards using the Design and Computation 
Manager. 

27. Highlight Updates. 

28. Toggle ON all the options, so all the individual project elements will be updated every time 
we recalculate our project. 

 

29. Highlight Save Options. 
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30. Toggle ON Automatically Save Drainage Updates. 

 

31. Click OK to accept the Project Preferences. 

32. Create the drainage preferences report for the project. (Drainage: Project > 
Export>Preferences to ASCII. 

33. Save the file as : drainage_preferences_17682.drp. 
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OBJECTIVES 
In this chapter, we will learn more about the drainage library. 

INTRODUCTION 
The Drainage Library is used to store data and standards which may be shared by different projects and 
designers. Each GEOPAK Drainage project simply accesses items within the library for use on the 
specific project. The library contains five major categories: 

• Rainfall Data 

• Land Use Runoff Coefficients 

• Nodes (Inlets, Junctions, etc.) 

• Links (Pipes) 

• Spread Sections 

Note The Library is unit specific, i.e., Metric or English. 

The VDOT CADD Support Section has created a drainage library (vdot.dlb) that will apply to most 
projects.   

The provided drainage library could be modified in order to address the designer’s specific needs. 
Caution should be used since these changes may affect existing and new projects. 

The Drainage Library is invoked by selecting Project > Drainage Library from the Drainage pull down 
menu or the Drainage Library tool located on the Main Drainage tools tool frame. 

 
 



RAINFALL ITEMS 
 

Five tabs are supported for the major categories within the Drainage Library: 

• Rainfall 

• Land Use 

• Nodes 

• Links 

• Spread Section 

RAINFALL ITEMS 
Within the Drainage Library (beneath the Rainfall tab) are the Rainfall Items, which store all the 
rainfall data sources to be used on subsequent GEOPAK Drainage Projects. GEOPAK Drainage 
supports rainfall sources in the form of intensity duration frequency (IDF) tables, two SCS methods, or 
as coefficients for three different preset intensity duration equation formats. Each curve is associated 
with a certain zone of the state.  Refer to the VDOT Drainage Manual for more information. 

 
 

When an Item is modified or added, the dialog displays the Rainfall Data Source information. 

 

 

The dialog depicted above is divided into the following sections: 
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• User Defined Frequencies (years): User defined frequencies group box contain the return 
period frequencies in years for the intensity value columns directly below. 

• Duration (min): Listed vertically in column one of the list box is the duration of the 
corresponding intensity values in the specific row. 

• Intensities (inch/hr o mm/hr) : Comprises columns two through six in the table. They can be 
manually entered or calculated utilizing the three populating options. These intensity values 
correspond to the duration specified in the far left column and are in inches or mm depending 
on the units of the library. 

User should not edit the rainfall source for typical rational method calculations on VDOT projects.  If 
needed for special occasions, three other Rainfall Data types are supported; Table, SCS Unit 
Hydrograph, and SCS Cumulative Hydrograph.  Selecting each of these dynamically changes the 
dialog to reflect the selection. 

LAB EXERCISE: UNDERSTANDING THE DRAINAGE LIBRARY 
> Review the Drainage Library: Rainfall Data 

1. Open the Microstation file c:\data\geo\vdot\drain1\h17682.dgn 

2. Select the Drainage Librarian tool. (GEOPAK Drainage Menu: Project>Drainage Library). 

At this point you may be looking at a default drainage library. We will now open our standard 
drainage library and review the various items stored in our library. 

3. Select File > Open. 

4. Open the Drainage Library c:\data\geo\VDOT\drain1\standards\Geopak\vdot.dlb. 

5. Click the Rainfall Tab. 

6. Double click Campbell. 

 

7. Review the data source item. 

8. Click Cancel. Do not close the Library. 
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LAND USE ITEMS 

Land Use Items take advantage of the drainage area delineation tools in GEOPAK Drainage and are 
used to store runoff coefficients and corresponding graphic symbology for various land uses contained 
in Drainage projects. Under the Land Uses tab, the Department has included a basic land use item.  
This item is shown below and has its Item ID Land Use.  The designer may use this item or create 
others.  Land use items can have as few as one land use description.   

The designer must draw MicroStation shapes matching the symbology below so GEOPAK Drainage 
can recognize and compute the different types of land use areas inside the drainage basins. These 
MicroStation shapes could be drawn in the active design file or in a referenced dgn file. 

 
 

Item ID: Land Use Item Identification to recall the item from within a GEOPAK 
Drainage project. (Maximum of 32 alphanumeric characters). 

Description: Description of the Land Use Item. (Maximum of 32 alphanumeric 
characters). 

Land Use Description: Description of each Land Use. (Maximum 32 alphanumeric 
characters). 

Runoff C: Runoff coefficient for the Rational Method (C Value). 

Symbology Specified element parameters which uniquely identify the various land 
use descriptions. 

Edit Buttons: Add - key in the required values in the edit fields directly below the list 
box, then click Add.  

OK / Cancel Action buttons which also close the dialog 
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> Review the Drainage Library: Land Use (Runoff Coefficients) 

1. Continuing in the Drainage Library, click the Land Use tab. 

 
 

2. Double click the first land use item. 

3. Review the different runoff coefficients for the land uses and associated MicroStation 
symbology. 

 
 

4. Click Cancel.  
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NODE ITEMS 

Node Library Items define the type of Node structures used on subsequent GEOPAK Drainage 
projects. The Nodes contain the Department's standard inlet configurations for Ditch Bottom Inlets 
(grated), Curb Inlets as well as Junctions (i.e., manholes), Outlets, and Other generic Nodes (i.e., grade 
breaks) as may be required for various Drainage projects. The description, plan view representation, 
and dimension information for each Node item are included in the library and referenced by each 
project. 

Under each Node Types are various stored Node configurations. A typical listing may appear as 
follows: 

 

GEOPAK Drainage supports the following node types: 

• Curb: This is used to depict a curb inlet. This type of inlet could be placed on a On-grade or 
Sag condition.  

• Grate: This is used to describe a grate inlet. This type of inlet could be placed on a On-grade 
or Sag condition. 

• Slotted Drain: This node type is used to enter slotted drain inlets.  

• Junction: This node type is used to enter data for any type of drainage structure required or 
representing a confluence of pipes that is not considered an inlet or outlet. Typical uses are 
manholes, junction boxes or Wye connections. 

• Outlet: It is used to enter data for outlets to a storm drain system. This is typically a pipe 
headwall or other structure to be placed at the outlet of a system.  

• Bottom: It is used for the bottom portion of an inlet or node structure. VDOT does not use this 
type of node. 

• Other: It is used to enter data for any generic Node that is considered to be an inlet, junction, 
or outlet. Typical uses could include pipe grade breaks, or just system connections where no 
computations or structures apply to the Node. Type Other is commonly used as the node type 
between ditch links. 
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• Headwall: It used to enter data for any node that is to be used as a headwall in conjunction 
with the culvert tool. It has no hydraulic properties since it is used only for graphical 
purposes. 

All Node items have certain data that describe them. The typical Node item dialog and common data 
requirements are shown below. For further explanation of the dialog contents, please refer to the 
standard GEOPAK Drainage On-line Help. 

 

The bottom part of the dialog contains parameters used in the hydraulic computations of the inlet. 
These parameters are needed for typical FHWA HEC-12 or HEC-22 calculations. 

A key element in the node definition is to properly configure the MicroStation cell representing the 
node. For that reason, GEOPAK Drainage supports the definition of certain key points within a cell 
that can be used to increase the flexibility of placing Nodes, connecting Links, and reporting on Node 
information.  

• Pipe Connection Points – these points can be placed within a cell to indicate the points 
around the structure to which the pipes shall connect. GEOPAK Drainage will subsequently 
track the actual pipe length from this connection point to that of the other nodes. If omitted 
from the cell, the pipes will connect to the cell origin. For circular nodes, a construction class 
circle may be placed inside the cell to allow the pipes to connect at any location around the 
circumference. These points are defined by using a MicroStation Construction Class Point, 
Line Style 6. For circular nodes, a construction class circle with Line Style 6 may be placed in 
the cell indicating the pipe location around the circumference. 

• Hydraulic Center Point – a single point may be placed in the cell representing the hydraulic 
center of the structure. All hydraulic calculations will be based on hydraulic length from one 
hydraulic center to the next. If omitted, the cell origin will be used as the basis for hydraulic 
length. These points are defined by using a MicroStation Construction Class Point, Line Style 
7. 

• Node Elevation Point – a single point may be placed in the cell representing the location for 
elevation definition on the Node. This point location will be used for subsequent extraction of 
the Node elevations from the DTM. If omitted, the origin of the cell will be used as the 
location of elevation sources. These points are defined by using a MicroStation Construction 
Class Point, Line Style 5. 

• Node Location Point – a single point may be defined in the cell representing the preferred 
point to locate the Node. A typical example would be if the cell origin is in the middle of the 
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structure and the structure is usually offset from the curb. If placed at the cell origin, the Node 
would always need to be placed at the offset from the curb. If the location point is placed 
within the cell at the offset from the curb, the Node can subsequently be placed directly on the 
curb. These points are defined by using a MicroStation Construction Class Point, Line Style 
4. 

• Node Alignment Point – used for top and bottom of cell. VDOT does not configure these 
points. 

LINK ITEMS 
The Link Items are used to store all the pipe configurations that may be used on a GEOPAK Drainage 
project. 

 

The Links Tab is the source of shapes, materials, dimensions, and hydraulic properties of these 
features. When designing these components, the items serve as the means to specify design candidates. 
If pipe items are deleted, these items will no longer be available for use on a project using the specific 
library.  

The Links are categorized by three types of properties for each pipe: 

• Shape 

• Material 

• Type or corrugations 
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The VDOT's library contains shapes for box, circular, and elliptical only.  Manning's n of 0.012 is 
applied to all of these and concrete is the only applicable material. 

Each pipe contains the specific pipe sizes and default roughness coefficients for each shape, and 
material combination. There are English and Metric libraries provided with GEOPAK Drainage, which 
contain virtually every standard pipe configuration. 
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LINKAGE TO AUTOMATED QUANTITIES 

One important feature of the drainage library, apart from their hydraulic utilization, is the ability to 
connect to the quantities database. This offers the designer the ability of computing final plan view 
quantities at the end of the design process. 

The drainage library connects to the Design and Computation Manager database (VDOTenglish.ddb) 
thru the PayItem definition in the Node and Link item dialog box. The PayItem definition field in the 
drainage library should correspond to the ItemID element in the Design and Computation Manager. 
The method and units of computation (each, linear feet, etc) will be defined by the design database or 
VDOTenglish.ddb. 

 

 

 

SPREAD SECTION 
The Spread Section tab is utilized to store roadway pavement spread information. 
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SPREAD SECTION 
 

When double clicking on an entry in the list box, the Spread Section dialog opens. 

 

                             
 

Input is available for the Spread Width, Slope, and Manning’s N value. The Department's library 
contains several common spread sections.  Note that some or all may not include the gutter.  Users can 
create additional spread sections as needed.   

 

> Review the Drainage Library: Spread Section 

1. Select the Spread Section tab, highlight the 2Lanes+Guttersection, and select Modify: 
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SPREAD SECTION 
 

 

2. Review the spread cross section characteristics for each spread item.  

3. Exit MicroStation. 
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OBJECTIVES 
The objective of this chapter is to review drainage design procedures on how to design a storm sewer 
system. 

DRAINAGE AREAS: INTRODUCTION 
Drainage Areas in GEOPAK Drainage may be used to simply compute peak discharges or to attach 
computed discharge values to Nodes within a GEOPAK Drainage Project. The physical drainage area 
boundaries may be delineated using a digital terrain model, simply drawn with MicroStation, or keyed 
in as a total area value. 

The Drainage Library is an integral part of defining and computing discharges for Drainage Areas. 
With graphical definition of the area boundary, runoff coefficients may be automatically computed 
with the use of Land Use Items from a Drainage Library.  

Intensity values for the peak discharge computations are computed using the FDOT Intensity-
Duration-Frequency curves that are part of the Department’s Drainage Library. 

Graphical definition of Drainage Areas through the DTM Drainage Tools or MicroStation is 
accomplished through the creation of MicroStation closed shapes and subsequent selection of the 
shape during the Drainage Area creation process. 

 
 

In order to assign Drainage Areas and the resulting peak discharges to Nodes of a storm drain network, 
the Drainage Area ID must match that of the Node. The best option to match the Node and the Area is 
thru Component>Node, then selecting the Edit Area button.  



Drainage Area: Definition 

 
Alternately, the Area tools are invoked by selecting Tool Boxes > Area, then identifying the desired 
tool from the tool box as depicted below. 

 
 

Tools from left to right are: 

• Add Drainage Area 
• Modify Drainage Area  
• Delete Drainage Area 
• Rename Drainage Area  
• Update All Areas 
• Drainage Area Report 

DRAINAGE AREA: DEFINITION 
The Drainage Area Definition dialog is used for adding or editing Areas. The general properties of the 
drainage area are displayed in a list box on the left side of the dialog under the Options group, while 
the right side displays parameters for the highlighted Option. As different Options are selected in the 
list box, the right side of the dialog will change dynamically to reflect the parameters for the 
highlighted Option.  When all the options have been reviewed and appropriate information supplied, 
pressing the Apply button will update the Drainage database 

 

This dialog is divided into six different group boxes. 

Description This may be used to better describe the drainage area. 

Hydrologic Method Rational and SCS are supported. The VDOT Drainage Manual requires that 
the Rational method be used for storm drain design. 

Drainage Area Total drainage area can be entered here or the designer can select a valid 
MicroStation shape and the software will automatically compute the area of 
the shape. The area units are either Acres or Hectares, depending on the 
project units. 

Base C Value If no sub areas are delineated, the Base C value applies to the whole drainage 
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area. If sub areas are delineated within the drainage area, this Base C value 
will be applied to all “remaining” sub areas that do not have their own C 
Value.  If the Land Use Library items address all the possible land uses on the 
project, there would be no “remaining” sub areas for the Base C-value to 
apply to.   See discussion of Sub areas below. 

Time of 
Concentration

The overland Time of Concentration for the Drainage Area expressed in 
minutes. The minimum time of concentration entered under 
Preferences>Intensity Options will override smaller values if entered here.  

Compute TC Opens the Time of Concentration dialog box. This is a time of concentration 
calculator that separates the flow into Sheet, Shallow and Concentrated flow. 
Different formulas and methods are applied for each type of flow. The flow 
path could be keyed in by the designer or could be extracted from DTM data. 

Area Selection / 
Creation:

Three methods of defining the area are supported: Select Shape, Pick 
Boundary Element or Create a DTM Shape.  

Select Shape: Select a previously drawn MicroStation shape, click Select 
Shape, then identify and accept the existing shape. These MicroStation 
shapes could be drawn in the active design file or be in a visualized reference 
dgn at the time of selecting the shape. 

Pick Boundary Elements: Click Pick Boundary Elements, then select all 
required MicroStation elements which comprise the boundary of the area. 
Note the vertices need not be trimmed but the elements must bound an 
enclosed region. Once the elements are selected for the bounding area, click 
DP Create Shape, and indicate a Data Point within the enclosed area. Upon 
successful creation of the shape, a Data Point will accept the shape and reset 
will undo the shape. If a solution cannot be found and numerous trials 
through the bounding elements are occurring, hitting any key will cancel the 
process. 

Create DTM Shape: Create a Drainage Area shape via the Delineate 
Watershed-Drainage Area Tool. Drainage>Utilities>Drainage Area Tools. 
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Drainage Area: Sub areas 

 
DRAINAGE AREA: SUB AREAS 

In order to delineate and add sub areas for a particular Area, select the Sub areas item within the 
Drainage Area dialog. Sub areas are defined as smaller components within a drainage area that exhibit 
different land uses or runoff coefficients (C values). 

 
 

 
 

The Sub areas and C-Values may be entered in the table manually or Sub areas may be delineated from 
the land use boundaries automatically. 

The Automatic Delineation button is used to define the sub areas within the current Drainage Area. In 
order for the software to delineate the land use areas automatically, MicroStation shapes need to be 
drawn into the active or reference dgn file following the symbology specified in the Department’s 
Drainage Library under the tab Land Uses. The designer can also assign this MicroStation symbology 
by using the land use definition tool located in Drainage>Components>Land Uses. Upon calculation 
of the sub areas, GEOPAK will write the sub area values in the dgn file unless the Display Only check 
box is activated. 
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DRAINAGE AREA: COMPUTATION 

The Computation option will calculate the discharge for the selected drainage area, using the computed 
weighted average or composite C value and the rainfall intensity associated to the entered or calculated 
time of concentration. The computed discharge shown does not reflect the absolute intensity, if the 
designer selected an absolute intensity for inlet computations in Preferences>Intensity Options. 

 

NODES: INTRODUCTION 
Nodes in GEOPAK Drainage are used to define structure points within a drainage Network. Nodes 
create all the Inlets, Junctions, and Outlets in the Network and provide for the connectivity of the Link 
system. Nodes are also used to indicate physical changes in Link sizes or slopes. Links cannot change 
size or slope, other than at Nodes. Although GEOPAK will support more, the Department provides 
library items for six Node types as described below. 

Node Description 

Curb Used for Curb opening inlets with or without pipe confluences. 

Grate Used for Grate opening inlets with or without pipe confluences.  

Slotted Drain Used for Slotted Drain Inlets. The Department has no Library items for 
slotted drain at this time (2007). 

Junction Used for any confluence of pipes, structure location (that is not an Inlet), 
pipe size or slope change, or flow addition that does not require an Inlet. 
The Library items include junction boxes and manholes. 

Other The Department intends these to be hydraulic openings that accept flow 
into the system. These node types can also be used for any miscellaneous 
points in a system such as a confluence of pipes, structure location (that is 
not an Inlet), pipe size or slope change, or flow addition that does not 
require an Inlet. They are also used between links that are ditches.  

Outlet Used for the Outlet, or outfall, of a storm drain Network. 

Bottom Used for the bottom portion of an inlet or node structure. VDOT does not 
use this type of nodes.  

Headwall For culvert tool only. 
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Node: Properties 

 
The Drainage Library is an integral part of defining Node properties. The Node types, names, 
descriptions, physical dimensions, hydraulic properties, and plan view representation are all defined 
within the Drainage Library and merely referenced and selected out of the library.  

Several options are supported to define, edit and delete Nodes. One option is invoked by the Drainage 
pull downs Components>Node and another option is  by selecting Drainage > Tool Boxes > Node 
,then identifying the desired tool from the tool box as depicted below. 

 

Tools from left to right are:  

• Add Drainage Node 
• Modify Drainage Node 
• Delete Drainage Node 
• Rename Drainage Node 
• Update All Nodes 
• Update Nodes With Pay Items 
• Drainage Node Report – Sump 
• Drainage Node Report – On Grade 

NODE: PROPERTIES 
To define a node as a part of the drainage network, the Node Configuration dialog needs to be setup 
with the appropriate node data. The general Options are displayed in a list box on the left side of the 
dialog, while the right side displays parameters for the highlighted Option. As different Options are 
selected in the list box, the right side of the dialog will change dynamically to reflect the parameters 
for highlighted Option.  When all the options have been reviewed and appropriate information 
supplied, pressing the Apply button will update the Drainage database. 

 

Node ID GEOPAK will automatically number the nodes based on the order in 
which the nodes are entered. The nodes can be renumbered later in the 
design process. This is discussed in the Chapter about Design 
Revisions. 

Description (optional) This may be used to better describe the node. 
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Node Type This will show the different node types defined in the drainage library.  

Profile The designer needs to specify the profile condition of the particular 
node to be placed. On Grade or in Sag condition. This affects the input 
and calculations for spread. 

Library Item Depending of the Node Type selected above, the list box will only 
show the available nodes that match the type condition.  

By Pass to Node The designer can specify or ID the node that will take the by passed 
discharge from the active node.  

Max By Pass Defines the maximum allowable by pass flow from the inlet. No 
specific computations are adjusted by this value; it is used to merely 
query the system for by pass flows which exceed this value. Used for 
On Grade Inlets only. This value could be left at zero (default) if no By 
Pass to Node is specified. 

Node Bottom VDOT does not use this type of node.  

Override Library Item Each node in the drainage library is associated to a pay item or Item ID 
in the Design and Computation Manager database. This option will 
override this linkage, allowing the user to select their own Item ID. The 
Department uses that option to make the placed node an “existing” 
node for quantity computations. 

 

NODE: LOCATION 
The designer will place the drainage node into the dgn file using different locating options. If a 
geometric database (gpk) is used in the Project Components, the Chain and Profile options will be 
activated, therefore the nodes could be referenced to a station and offset from the selected alignment or 
chain, and the node elevation could also be computed from the profile selected. If no gpk file is 
available, the node will be placed using the coordinate information from the MicroStation file. 

 

Chain A previously defined horizontal alignment stored in the "gpk" file.  
Activate the toggle to the left of the field and select the chain from the 
list 
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Profile A previously defined vertical profile stored in the "gpk" file.  Activate 
the toggle to the left of the field and select the desired profile from the 
list. 

Align: At Point When this option is utilized, the node is placed at the active angle in 
the MicroStation file at the current or dynamic Node coordinates. 

Align: Tangent to Chain When this option is utilized, the node is dynamically moved along the 
Chain, and is rotated maintaining tangency to the chain.   The designer 
can enter the station location or place the node dynamically. 

Align: Tangent on Element When this option is utilized, the ID button to the right of the option is 
activated and the designer is prompted to identify and accept a 
MicroStation element. The Node is placed tangent to and on the 
identified element projected from the current or dynamic Node 
coordinates. The designer can enter the station location or place the 
node dynamically. 

Align: Tangent to Element When this option is utilized, the ID button to the right of the option is 
activated and the designer is prompted to identify and accept a 
MicroStation element. The Node is placed tangent to the identified 
element at the current or dynamic Node coordinates 

Angle An optional angle rotation could be applied to the node.  A 180-degree 
angle is often needed to properly align the throat of curb inlets and is 
sometimes used in conjunction with the Mirror Node toggle.  

Station and Offset Nodes may be located by entering the station and offset in reference to 
the selected chain. If "Tangent on Element" is used, the offset is 
computed. 

Mirror Node When activated, the node cell is mirrored, in order that the same cell 
can be utilized to accommodate flow coming from either direction. 

Offset from Gutter to Inlet Inlet hydraulic equations assume the Inlet is at the edge of the 
computed spread (i.e. the Curb). If the Inlet is offset from the Curb, the 
discharge in the spread section will bypass the Inlet. This value, 
expressed in terms of feet or meters, is used to compute this bypass and 
adjust the actual flow to the Inlet. This may be used, for example, when 
a Grate Inlet is actually set some distance away from the curb of the 
road.  

Therefore any flow calculated in that segment will not be added to the 
inlet and it will bypass to the next assigned one. 

This value should remain zero for standard VDOT inlet applications. 
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NODE: SPREAD CRITERIA 

Inlets utilize this option to compute the node elevation and spread calculations and for other nodes, it is 
used for elevations only. The dialog changes slightly depending on whether the Inlet is On Grade or in 
a Sag. The following are the common components of the Spread Criteria for sections in Sag or On 
Grade. 

 

The Spread Cross Section Table in the box above is used to define the spread cross section including 
the gutter section and/or pavement section which may encompass the spread of flow approaching the 
Inlet. The top entry is at the outermost point of flow.  In most situations, this entry is the section 
abutting the curb.  GEOPAK drainage refers to this part of the cross section as Slope 1, Width 1, and 
Roughness 1.  Adjacent parts of the cross section are identified as Slope 2, Slope 3 etc. as shown 
below.  The cross section defined here may also be used to compute the inlet elevation from the PGL, 
so the sections should continue to the location of the PGL, if inlet elevations will be computed this 
way.   

 

A spread section needs to be defined for every node, including junctions or outlets for the software to 
design or analyze the system, since the spread section could also be used to compute the structure 
elevation. 

Note The slopes entered are positive in value if “going up” from the inlet’s point of view towards the 
centerline. Negative slopes are supported but not for the bottom (or last) one in the list since it 
does not convey flow to the node.    

The Spread Cross Section Table could leverage information from the drainage library, the gpk file or 
the MicroStation Superelevation Shape file as described below. 
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Node: Spread Criteria 

 

 

User Supplied The designer will enter the width and slopes across the spread section 
starting from the Inlet and continuing towards the edge of the section 
farthest away from the inlet. 

Reference TIN A spread cross section will be extracted at the inlet location from the 
TIN file defined in the Project Components item under the Drainage 
Project Preferences. The designer needs to be careful on what DTM is 
using since for most VDOT projects the only TIN file generated is the 
existing ground DTM.  

Library Item A spread cross section will be assigned to the inlet using a Spread 
Section item defined in the Drainage Library. Once a Library Item has 
been selected, the spread source can be changed to User Supplied and 
the spread section defined by the Library Item modified to 
accommodate non-typical situations such as pavement width 
transitions. 

Shape A spread cross section will be extracted at the inlet location from the 
Superelevation Shapes dgn file defined in the Project Components item 
under the Drainage Project Preferences and shown in the Spread 
Criteria table. 

For curb inlets in superelevation or superlevation transition, the 
designer can use this option or enter the spread source (cross section) 
as User Supplied. 

If the superelevation shapes are not defined to the edge of pavement, 
the designer can take advantage of the toggle:”Extend Superelevation 
Shapes to Inlet at Shape Slope”, located in Drainage > Project > 
Preferences under the Inlet Options item. This will extend the last 
slope of the shape to the node location point defined in the structure.  

Therefore, if the shape file is used to define the spread, be aware that 
the cross section starts at the edge of pavement creating a theoretical 
section that is shifted from the actual spread section by the width of the 
gutter.  This is acceptable because the calculated spread width is the 
same regardless of the shift.  The gutter depression cannot be modeled 
with this approach. To account for the gutter depression while using 
the shape option, the "Shape and Library Item" would need to be used 

Shape and Library Item A spread cross section will be assigned to the inlet combining the 
section extracted from the Superelevation Shapes dgn file and Library 
item from the Drainage Library. If the gutter section is made a library 
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item, this option can be used to account for the gutter capacity.   

To properly use this option, the superelevation shapes need to be 
defined to the edge of pavement line, and the ”Extend Superelevation 
Shapes to Inlet at Shape Slope” toggle must be off. 

Note Some options could be gray out if no active elements are present. E.g. roadway 
superelevation shapes files or TIN file not specified in the Project>Preferences. 

To accurately depict the spread section for inlets along a special gutter grade, the designer can provide 
the cross section as User Supplied, or use the Superelevation Shapes, if needed to account for a special 
gutter grade.  

The designer can specify threshold values for the spread at each node. When either of the following 
values is exceeded, GEOPAK Drainage will issue a Warning Message while designing the Network.  
After a networks is initially designed, it can be Queried for inlets that violate these values.  

Maximum Ponded Depth The maximum depth allowed for ponding in the cross section 
(expressed in terms of feet or meters).  This does not affect any 
computations, but will produce a warning if the computed depth is 
greater. 

For sag inlets, this value is used to compute the capacity of the node. 

Maximum Ponded Width The maximum width allowed for ponding in the cross section 
(expressed in terms of feet or meters).  This does not affect any 
computations, but will produce a warning if the computed depth is 
greater. 

The Longitudinal Slope for Inlets On Grade can be identified several ways as shown below. 

 

Reference PGL Slope will be extracted from the profile defined in the Location item of 
the Node dialog box at the inlet location. The slope will update as the 
.gpk file is updated. 

User Supplied Slope will be entered by the designer in percentage format while 
omitting the % sign. 

Shape Slope will be extracted from the superelevation shapes dgn file defined 
in the Project Components item in the Drainage Project Preferences. 
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For inlets in superelevation, superelevation transition, or other 
transitions, the designer can use this option or enter the longitudinal 
slope as User Supplied. 

For an inlet in sag conditions, the approaching longitudinal slopes have no effect on the calculation of 
the inlet capacity or spread at the inlet.  The spread approaching a sag inlet needs to be calculated and 
the approaching longitudinal slopes affect those calculations.  The fields unique to Spread Criteria for 
Sags relate to the spread along the approaching longitudinal slopes and are discussed below.  The 
designer must specify a value for Maximum Ponded depth for sag inlets.  Although this value is not 
needed to compute spread, it is used by GEOPAK to compute the capacity of sag inlets. 

 

% Slope Left and Right For defining the longitudinal slope to use in spread (ponded width) 
computations for the flow approaching from the right and left side of 
the inlets. The terminology (right and left) is somewhat arbitrary as 
long as the designer recalls which side is intended as left and right.  

% Discharge Left and Right Defines the percentage of the total discharge to the inlet to allocate to 
the left and right approach spread computations. The terminology right 
and left are somewhat arbitrary as long as the designer recalls which 
side is intended as left and right and is consistent with the definition of 
% Slope Left and Right 
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NODE: ELEVATIONS 

The Node Configuration-Elevation dialog will assign the elevation of the drainage nodes from 
different sources, dictate the vertical matching point of the pipes entering and exiting the structure, and 
the minimum and maximum depth of the node. 

 

Reference Surface Define the desired TIN File or a Model or Object within the site project 
specified in the Drainage Preferences – Project Components.  

Elevation Source Defines the source of the Node elevation. With the source specified as 
something other than User Supplied, the Node elevation will 
automatically update as the Node is moved. The options are: 

 

• Reference Surface: Computes the actual elevation from the X 
and Y coordinates of the structure from the Location dialog 
and the Reference TIN File or Site Model. This option may be 
useful for placing Ditch Bottom Inlets at the existing ground 
elevation depicted in a TIN file. 

• Reference PGL: Utilizes the Station from the Location dialog 
to ascertain the profile elevation on the Reference PGL. Note: 
This option will report the elevation directly at the station on 
the PGL. 

• PGL+Spread Section: Utilizes the PGL and information from 
the Spread Criteria cross section to compute the elevation. The 
elevation is ascertained along the PGL at the specified Station 
and then adjusted along the spread cross section width and 
slope segments to the end of the cross section. Although it 
says PGL "plus" spread section, the programs subtracts 
positive values from the PGL. 

Node Elevation Options: The designer may adjust the inlet elevations up or down from the 
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Elevation Source item. These options are: 

 

• Same as Source: matches the node elevation with elevation 
source. 

• Constant Offset: enables a plus or minus value to the elevation 
source selected. For example, if the reference profile is PGL+ 
Spread Section to the flow line of the gutter, a Constant Offset 
can be specified to have the node elevation be the edge of 
pavement (EOP) elevation.  This is useful because the EOP is 
used for curb inlet elevations.  A plus offset will add to the 
elevation value. 

• User Supplied: The user may specify an elevation.  

For the outlet node elevation, the elevation is not a physical point 
on the structure.  The elevation should be at least 1 foot above the 
tailwater to avoid a warning.  In general, using the berm or ground 
elevation that covers the outlet structure is acceptable for the outlet 
node elevation.    

Vertical Alignment Alignment preferences for incoming and outgoing pipes from the 
Node. As pipes are designed the elevations will be set according to the 
selected preference. Options available are: Match Soffit, Match Invert, 
Match Surface, Allow Drop Manhole and Min. Fix Drop. 

• Match Soffit: aligns all the pipes in the system by matching 
the top of each pipe or crown elevation. 

• Match Invert: aligns all the pipes in the systems by matching 
the bottom of each pipe or invert elevation. 

• Match Surface: aligns the pipes following the elevation of the 
water surface inside the pipes. 

• Allow Drop Manhole: allows for “drops” inside the node for 
the pipes arriving or existing the node. Not matching inverts 
or soffits will be performed. This option allows for greater 
flexibility. Since the design preference is to minimize 
excavation, the first pass during the design will align all the 
pipes at the soffit. As the designer needs to move the inverts 
of certain pipes due to various factors, e.g. utility conflicts, the 
change will only affect the selected pipe and others will 
remain at the previously set elevation. 

• Min. Fix Drop: sets a minimum drop in elevation between the 
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pipes arriving and exiting the node. VDOT uses this option. 

Minimum Depth Minimum depth expressed in master units (i.e., feet or meters) for the 
pipe to be buried (minimum cover) measured from the Node Elevation 
to the soffit (top inside) of the highest pipe. This value is used to 
establish the minimum cover elevation noted in the Link Configuration 
Conditions dialog box.  See the discussion below. 

Maximum Depth Maximum depth expressed in master units (i.e., feet or meters), for the 
pipe to be buried measured from the Node Elevation to the invert of the 
lowest pipe.  This value is used to establish the Maximum Depth 
elevation noted in the Link Configuration Conditions dialog box. See 
the discussion below. 

Add Sump Depth .Extra depth to be allowed in the manhole structure after the maximum 
depth of the structure has been computed. This has no effect in the 
hydraulic calculations, but some designers add this extra depth for 
pollution control measures. VDOT does not use this option 

The designer can use multiple combinations of the previous parameters in order to automate the computation of 
the node elevations. Some of the project conditions that affect inlet elevations and spread are superelevation, 
turn lanes, and through lane transitions.  

GEOPAK has different ways to handle different project conditions.  The options within GEOPAK that may 
affect calculations of inlet elevations and spread are listed below. It is a the designer discretion to use them 
depending on the structure and project conditions given. 

Item Options 

Created to edge of travel way 1.- Shape Files:  These are created by the 
roadway designer. 

Created to less than edge of travel 
way. 

Yes (activate toggle) if shapes are 
not created to the edge of travel 
way. 

2.- Extend Shapes to Inlet: This option is in 
Preferences>Inlet Options.  This affects the 
entire project because it is in Preferences.  

No 

User Supplied 

Reference PGL 

3.- Longitudinal Slope Source: This option is 
in Node Configuration> Spread Criteria. 

Shape 

User Supplied 

Library Item 

4.- Spread Source:  This option is in Node 
Configuration> Spread Criteria.  This refers to 
the cross section of the spread area. 

Shape 
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Shape + Library Item (this option is 
not applicable if the shapes are 
extended to the Inlet 

Reference PGL 4.- Elevation Source: This option is in Node 
Configuration> Elevations  

PGL+Spread 

Source 

Constant Offset 

5.- Node Elevation Option: This option is in 
Node Configuration> Elevations 

User Supplied 

MINIMUM AND MAXIMUM DEPTH AT NODES DEFINITION 
The values entered for Minimum and Maximum Depth define the vertical limits that the program uses to place 
the pipe. The Minimum Depth establishes the upper limit that pipes are designed in. The Maximum Depth 
establishes the lower limit.   

The minimum depth of a pipe is often established by cover requirements specified in the VDOT Drainage 
Manual.  

Consider the following for the Maximum Depth: The approximate elevation of the outlet node should be known 
while designing the storm drain. The outlet elevation may be controlled by the minimum pipe slope or by the 
depth of the pond at the outlet. The designer will be able to lock the elevation of the outlet pipe in the Link 
Configurations-Conditions dialog. Locking the elevation of the outlet will control the total drop through the 
system. This will limit the allowable pipe envelope that the pipes are designed within. Reasonable results should 
be obtained by setting the Maximum Depth for all nodes to be deeper than the outlet pipe (maybe use a tentative 
20' depth). Again, GEOPAK will not fully use this depth to design the pipes if the outlet elevation is locked. 

Regardless of what depths are used, the designer will still need to check for adequate depth, pipe slope, and 
hydraulic gradient clearance later in the design process. 
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NODE: JUNCTION LOSS 

 

Within this dialog the designer has the option to enter specific values for the junction losses in the 
particular structure being analyzed. These settings will override the coefficients selected under the 
Drainage Project Preferences, but the toggle Disable All Junction Loss Computation must be off. 

NODE: DISCHARGE OPTIONS 
The Node Configuration-Discharge option is used to select type and possible amount of flow entering 
the drainage structure directly from its drainage area or from “offsite” locations. 

 

The options are: 

Use Computed Discharge Indicates using the computed discharge from a stored Drainage Area as 
the discharge to the Node.  

Supplied Discharge This option allows for a user supplied discharge, with disregard to any 
calculated value from a drainage area. 

Disable Inlet Calculations 
Capacity

When toggled on, the designer may provide the desired inlet capacity 
overriding any GEOPAK Drainage calculated value. 

Link Base Flow Area / Link Base 
Flow Discharge 

When toggled on, an additional drainage area may be defined. The area 
can be identified graphically by clicking ID and selecting the 
MicroStation shape previously defined as a GEOPAK Drainage Area.  

For the Link Base Flow Discharge. the designer can also enter a value 
for the extra discharge in the proper units defined in the Project 
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Preferences (cubic feet per second or cubic meters per second). 

This “extra” area or discharge is included in the pipe, but is not 
included in the inlet spread calculations. 

NODE: COMPUTATIONS 
Once all the information regarding a specific Node has been defined, clicking the Compute Option 
computes and displays all pertinent information in the list box.  If sufficient information has not been 
provided, warning or error messages are displayed in the list field. 

 

Note The designer should be aware that the computations shown are the spread calculations. 
Therefore, the value of discharge may be different from the discharge calculated in the 
drainage area, since VDOT uses an absolute intensity of 4 inches/hour intensity for inlet 
computations. This discharge value also includes any bypass discharge added to the current 
node. 
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LAB EXERCISE: DRAINAGE DESIGN 

> Opening the Drainage Project 

1. Execute c:\data\geo\vdot\drain1\LAB06_V8ad.EXE 

2. Open the MicroStation file, c:\data\geo\VDOT\drain1\h17682.dgn. 

3. Open Project Manager (MS Menu: Applications > GEOPAK Road > Project Manager) 

4. Select project: 17682.prj located in c:\data\geo\VDOT\drain1, and click OK. 

 
5. Access User: VDOT. 

 
6. Click OK. The Road Project dialog will load. This will setup the proper directories for the 

location of the gpk file. 
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7. Minimize the Road Project dialog box. 

8. Access GEOPAK Drainage ( MS Menu: Applications > GEOPAK Drainage > Drainage).  

9. Open the drainage project, c:\data\geo\vdot\drain1\h17682.gdf (Drainage Menu: Project > 
Open).  

 

> Define Properties and Locate Inlet 3-1 

1. Visually determine (zoom to) the location of the Proposed Inlet Location: Station 205+86; 
offset –26.  

 
2. Select the Add Drainage Node tool ( Drainage: Component > Node > Add) and click OK. 
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3. Highlight Properties in the Options section. 

4. Select the Node to be used from the Drainage Library and assign its properties. 

Node Type Curb 

Profile On Grade 

Library Item DI-3B 10 

5. Highlight Location. 

 

6. Define the inlet’s location in the design plane. 

Chain MAINLINE  

Profile MAINLINE  

Align Select Tangent on Element. Activate 
the Select MS Alignment Element 
button   and select and accept the 
edge of pavement line.  Activate the 
Station DP button   and the node 
will dynamically move along the 
selected element.  Using the left 
mouse button, place the node close to 
where it is desired.  The station can be 
revised by entering a different station 
value. 
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Station 205+86 

Offset -26.00 feet 

7. Click Apply.  

This automatically places the inlet at the specified location. 

> Define Additional Inlet Information 

1. Highlight Spread Criteria. 

 

2. Define the roadway cross sectional characteristics directly in front of the inlet. 

Longitudinal Slope Source Reference PGL 

Spread Source User supplied 

Max Ponded Depth 0.50 

Max Ponded Width 8.00 

 

These values will be utilized to calculate inlet capacity and resulting by-pass flow.  
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3. Highlight Elevations. 

 

4. Assign the inlet's vertical elevation and vertical pipe alignment. 

Reference Surface Survey.tin 

Elevation Source PGL + Spread Section 

Node Elevation Option Same as Source 

Vertical Alignment Preference Min. Fixed Drop = 0.2 

Minimum Depth 2.67 feet 

Maximum Depth 8.0 feet 

5. Highlight Junction Losses. 

 

6. Use Defined Equations (defaults to Preferences > Junction Loss Settings). 
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7. Highlight Discharge Options, and Toggle ON Use Computed Discharge 

 
 

> Complete Hydraulic Computations and Add Node to the Project 

1. Highlight Computations to verify the inlet’s hydraulic computations. 

 

Note The Drainage Area for this node won’t be added until the next step. Therefore, the 
Computations for the node can’t be completed until a discharge is known (Delineate Drainage 
Areas section). 

2. Click Apply to add this Node to the project. 

DELINEATING DRAINAGE AREAS 
The physical drainage area boundary may be delineated using a digital terrain model, simply drawn 
with MicroStation, or keyed in as a total area value (in units of acres or hectares). After the drainage 
area is delineated using MicroStation’s drawing tools, runoff coefficients can be automatically 
computed with the use of Land Use Items from the Drainage Library. 

> Design Drainage Area for 3-1 

1. The basin limits were predefined and were drawn on the MicroStation Level: 63. A closed 
shape will be created in the next steps in order to become the drainage area for each structure. 
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2. Turn On Level 63 in the MicroStation dgn file. (MS Menu: Settings>Level>Display). 

 
3. Still in the Node Configuration dialog, highlight Properties, and click Edit Area (to the left 

of the Apply button).  

   
                            

4. Select YES at the prompt of creating a new drainage area and enter the Definition 
information. 

Base C 0.50 

Time of Concentration 5.0 
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5. Click Select Shape and select the MS shape for this area. The drainage area value is 

computed. 

 
6. Highlight Subareas. 

7. Toggle on Display Only. Then, the subarea values will not be written in the dgn file. 

8. Click Automatic Delineation. 

The file is scanned for closed shapes matching the Land Use symbology specified in the 
Drainage Library (Land Use Tab). 

 
9. Click Apply. 

This applies the land uses (and their “C” values) to the Drainage Area. Alternately, this table 
may be populated manually using the key-in fields and add, modify and delete icons to the 
right of the table.  

10. Highlight Computation. 

6-26 © 2007 VDOT VDOT GEOPAK Drainage 



Delineating Drainage Areas 

 

 
11. Click Compute Discharge. 

12. Verify the computations. 

13. Click Apply to add the Area to the Project.  

14. Close the Drainage Area Computations dialog. 

15. Return to the Node Configuration dialog, and highlight Computations.  

16. Review and verify the computations. 

17. Click Apply to update the node information. 

 

Define Properties and Locate Inlet 3-2 

1. Visually determine (zoom to) the location of the Proposed Inlet Location: Station 206+36; 
offset –26.  

2. Select the Add Drainage Node tool ( Drainage: Component > Node > Add) and click OK. 

3. Highlight Properties in the Options section. 

 
4. Select the Node to be used from the Drainage Library and assign its properties. 

Node Type Curb 

Profile Sag 

Library Item DI-3C-6 
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5. Highlight Location. 

 

6. Define the inlet’s location in the design plane. 

Chain MAINLINE  

Profile MAINLINE  

Align Select Tangent on Element. Activate 
the Select MS Alignment Element 
button   and select and accept the 
edge of pavement line.  Activate the 
Station DP button   and the node 
will dynamically move along the 
selected element.  Using the left 
mouse button, place the node close to 
where it is desired.  The station can be 
revised by entering a different station 
value. 

Station 206+36 

Offset -26.00 feet 

7. Click Apply.  

This automatically places the inlet at the specified location. 

8. Highlight Spread Criteria. 
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Longitudinal % Slope Left  4.50% 

Longitudinal % Slope Right  8.60% 

% Discharge Left  50 % 

% Discharge Right 50% 

 

10. Highlight Elevations and assign the inlet's vertical elevation and vertical pipe alignment 

 

11. Highlight Computations to verify the inlet’s hydraulic computations. 

 

Note Elevation Source, Node Elevation Option, vertical Alignment, Minimum and Maximum Depth 
should be filled out based on the previous node 3-1. 

12. Click Apply to add this Node to the project. 

13. Click the Edit Area icon to associate this inlet with its Drainage Area.   

14. Select Yes to the Alert dialog box, since no area for the inlet is created yet. 

15. Enter the Definition information. 
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Base C 0.50 

Time of Concentration 5.0 

 

16. Click Select Shape and select the MS shape for this area. The drainage area value is 
computed. 

 
17. Highlight Subareas. 

18. Toggle on Display Only. Then, the subarea values will not be written in the dgn file. 

19. Click Automatic Delineation. 

The file is scanned for closed shapes matching the Land Use symbology specified in the 
Drainage Library (Land Use Tab). 
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20. Click Apply. 

This applies the land uses (and their “C” values) to the Drainage Area. Alternately, this table 
may be populated manually using the key-in fields and add, modify and delete to the right of 
the table.  

21. Highlight Computation and press the Compute Discharge button to obtain the drainage 
area’s computations. 

22. Click Apply to add the Area to the Project.  

23. Close the Drainage Area Computations dialog. 

24. Return to the Node Configuration dialog, and highlight Computations.  

 
25. Review and verify the computations. 

26. Click Apply to update the node information. 
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COMPLETE THE INLET LOCATIONS 

1. Select from the Node Configuration dialog the Add Node icon. 

2. Layout the inlets for the project using the same methodology as described above, and create 
the correspondent drainage areas. 

Node ID Type Profile Library Item Station Offset Elevation 

3-3 Curb On Grade DI-3B 8 206+86 -26.00 PGL+Spread 

3-4 Curb On Grade DI-3B 16 205+86 26.00 PGL+Spread 

3-5 Curb Sag DI-3C 6 206+36 26.00 PGL+Spread 

3-6 Curb On Grade DI-3B 8 206+86 26.00 PGL+Spread 

3-7 Curb On Grade DI-3B 16 208+00 26.00 PGL+Spread 

Outlet Outlet  ES18 206+36 -42.00 El. 2020.00 

Note It is recommended to input the Node Elevation for an outlet node at least one foot higher than 
the tailwater elevation.  This elevation is not used in the hydraulic calculations and does not 
represent a physical point on the outlet node.  E.g. pond’s top of berm elevation, ditch top of 
bank, etc. 

3. Close the dialog box when done. 

 

LINKS: INTRODUCTION 
In GEOPAK Drainage, Links connect and convey runoff from the various Nodes within a Network to 
the Outlet, and may consist of pipes, boxes, or ditches. A multitude of options for sizing, and profiling 
Links are supported.  

A Link represents a linear feature depicting a path connecting two Nodes. The path (upstream to 
downstream) need not be indicated because GEOPAK Drainage will determine the direction of flow 
purely based on connectivity. The path may be a straight line, line string, curvilinear, or a combination 
and series of linear MicroStation elements. 

The Drainage Library is an integral part of designing and analyzing Links. The library contains all the 
standard pipe configurations based on shape, material, and, if applicable, corrugations which may be 
used in a Drainage project. Link library items selected to specify pipe sizes or the shape and material 
properties within the library may be used to establish the suitable candidates for design.  

Several options are supported to add, edit, and delete Links.  One option is invoked by the Drainage 
pull down menu Component>Link. Another option is the tool box obtained by selecting Tools > Tool 
Boxes > Link, then identifying the desired tool from the tool box as depicted below.  

 
 

Tools from left to right are:  

• Add Drainage Link 
• Edit Drainage Link 
• ID Drainage Link 
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• Delete Drainage Link 
• Rename Drainage Link 
• Update All Links 
• Update All Links with Pay Items 
• Drainage Link Report – Configuration 
• Drainage Link Report – Computation 

 

Add Utilized to add a Link to the current GEOPAK Drainage project. 

Edit Utilized to select and edit any previously defined and stored Link within 
the current project. The Link Edit dialog is identical to the Link Add 
dialog, however, when the Link is identified, all associated data is 
displayed. 

ID Utilized to ID the link in the design file. 

Delete Utilized to select and delete the specified Link and associated data. 

Rename Rename the link name in the GEOPAK database. 

Update All Links Updates all link graphics in the design file. 

Update All Links with 
Pay Items 

Updates all link graphics with the designated pay items (specified in the 
Drainage Library) from the Design and Computation Manager database. 

Drainage Link Report 
Configuration 

Displays in table report the links configuration (size, inverts, and slopes) 
after the design is performed. 

Drainage Link Report 
Computation 

Displays in table report the links hydraulic computation (discharge, 
capacity, HGL) after the design is performed. 

 

A third option is to access the Links the Navigator (Utilities>Navigator). 
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LINK CONFIGURATION DIALOG: INTRODUCTION 

The Link Configuration dialog box is the one used to properly place a link (pipe or ditch) into the 
database.  

 

The Link options are displayed in a list box in the left side of the dialog, while the right side displays 
parameters for the highlighted Option.   The options are:   

• Definition 

• Conditions 

• Constraints 

• Computation 

As different Options are selected in the list box, the right side of the dialog will change dynamically to 
reflect the parameters for highlighted Option.  When all the options have been reviewed and 
appropriate information supplied, pressing the Apply button will update the Drainage database. 

LINK CONFIGURATION DIALOG: DEFINITION 
This option will define the Link’s path, connectivity, shape, material, roughness coefficient, size, and 
design options. 

 

Description (optional) Description of the Link. (Maximum of 32 alphanumeric characters.) 

From Node Identification of the Node from which the Link originates. The flow 
direction, upstream or downstream, need not be established. The 
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direction is determined by the connectivity of the Network in which the 
Link resides. If the designer identifies a downstream node as a From 
Node, GEOPAK will reverse the From Node and To Node based on 
actual flow direction of the Network.  GEOPAK does this when the 
network is built (See the Network Chapter).   

It is recommended to use the ID button  to select the node since it 
will connect the link to the proper pipe connection points defined in the 
Department’s Drainage Library. 

To Node Identification of the Node from which the Link originates. The flow 
direction, upstream or downstream, need not be established. The 
direction is determined by the connectivity of the Network in which the 
Link resides. 

It is recommended to use the ID button   to select the node since it 
will connect the link to the proper pipe connection points defined in the 
Department’s Drainage Library 

ID   Identification of the Node from which the Link originates or ends. The 
flow direction, upstream or downstream, need not be established. The 
direction is determined by the connectivity of the Network in which the 
Link resides. 

Length Once the From Node and To Node are identified, GEOPAK computes 
the length of the Link based on distance between Nodes or the 
MicroStation element selected as the Link path.  GEOPAK Drainage 
considers two lengths for a link: actual length and hydraulic length. 

• Actual Length: this is the distance from the pipe connection 
point of one node to the pipe connection point of the next node. 
This is often called the construction length of the pipe.  

• Hydraulic Length: this is the distance from the hydraulic point 
of one node to the hydraulic point of the next node. This length 
is used to perform the drainage calculations (travel time, HGL 
slopes, etc). The Department has defined the hydraulic point of 
every node at the center of the structure.  

Use MS Element To define and select the Link path with previously drawn MicroStation 
elements. Activate the toggle, press the Select button, then identify the 
element. 

This is only used when the designer needs to model a link with a bend 
without a node. 

Type Group: Pipe or 
Ditch 

Selection of this option dynamically changes the Configuration group 
box to reflect the selection. 

Links in GEOPAK Drainage could be a pipe or a ditch. 

The Configuration group box will change depending upon designer’s choice to use a pipe or ditch as a 
link between nodes. 

VDOT GEOPAK Drainage  © 2007 VDOT 6-35 



Link Configuration Dialog: Definition 

 
If a pipe is selected, then the Configuration Group box will allow the following: 

 

Shape Option button for pipe shapes.  The Department’s Drainage Library 
contains only box, circular, and elliptical shapes.    

Material Option button for Pipe materials. The Department’s Drainage Library has 
all the links stored as concrete material, so the designer must select 
concrete.  This does not control the pipe material for construction. The 
pipe material constructed is controlled by the Department’s Optional Pipe 
process. 

Design Size Toggle on to indicate pipe size to be determined by the software based on 
given design Configuration and Constraints. 

If the pipe is an existing one or the designer wants to select a specific 
pipe, then toggle off this option. 

Pressing the Select button invokes the Select Size dialog, wherein the 
desired size may be selected. Pipes listed in the dialog are based on the 
sizes in the Drainage Library for the specified Shape and Material 
configuration. 

Design Barrels Toggle on to indicate the number of barrels (multiple pipes) GEOPAK is 
to design based on given configuration and constraints.  If the toggle is 
not activated, GEOPAK designs for one barrel. 

The designer can select from 2 to 10 barrels from node to node. 

Manning’s n Manning's roughness coefficient. The default value is based on shape and 
material found in the Drainage Library. All of the current Library items 
have Manning's n = 0.012.  This is consistent with the Drainage Manual 
standards for acceptable Storm Drain and Cross Drain materials.  

The designer can also override this value for each individual pipe. 

Override Library Pay 
Item 

Each pipe in the drainage library is associated to a pay item or Item ID in 
the Design and Computation Manager database. This option will override 
this linkage, allowing the user to select their own Item ID.  

The Department uses that option to make the placed pipe an “existing” 
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pipe for quantity computations. 

 

If a ditch option is selected, then the Configuration Group box will allow the following: 

 

Ditch Type A ditch with fixed geometry or cross section based could be placed. 

Ditch Width Ditch bottom width in master units (i.e., feet or meters). 

Ditch Depth Ditch depth in master units (i.e., feet or meters). 

Side Slope Ratio Left Left side slope of the ditch. 

Side Slope Ratio Right Right side slope of the ditch 

Manning’s Manning's roughness coefficient. 

Number of Cross 
Sections 

If the ditch type selected is cross section based: 

 

Number of cross sections to create along the path of the Link. A minimum 
of four sections is suggested to balance energy. 

The TIN file or Site Model to extract the cross sections is specified in the 
Reference Surface option of the Node Definition dialog. 

Width of Cross 
Sections 

Width of the cross sections created along the path of the Link. Cross 
sections will be centered along the Link. 
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LINK CONFIGURATION DIALOG: CONDITIONS 

Defines or reviews the elevation condition for the Link including minimum depth, soffit, invert, and 
slope data. It also includes the profiling options for holding certain values constant. 

The Minimum Cover and Maximum Depth values on this dialog represent calculated elevations based 
on the values for the nodes connected to the link.  The Minimum Cover elevation = Node Elevation - 
the Minimum Depth of the node.  The Maximum Depth Elevation = Node Elevation – Maximum 
Depth of the node.  

 

The soffit, invert and slope of the pipes are the calculated elevations after the Network is designed. The 
designer has the option to “lock” these elevations, therefore GEOPAK Drainage will not adjust them.  
To lock one of these items, activate the toggle and type the desired value in the window. Another 
option to lock the pipes elevations is thru the Edit Profile dialog box. 

 

Note GEOPAK Drainage cannot accommodate adverse pipe.  If locked or held flow lines result in 
one of these conditions, GEOPAK will adjust the flow lines to fix the problem, thus giving the 
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appearance that the Lock or Hold Invert option does not work. A Warning message will inform 
the designer of the changes made to the pipe elevations after the design is performed.  

 

LINK CONFIGURATION DIALOG: CONSTRAINTS 
The Constraints establish further design criteria for Links. GEOPAK Drainage utilizes the physical 
constraints of minimum and maximum size and slope to determine a suitable pipe size.  

 

GEOPAK Drainage will perform the following steps to determine the “allotted pipe envelope” 

• Starting upstream, GEOPAK computes each link slope by connecting the nodes at the 
elevation set by the node elevation minus the  minimum depth. 

• If this slope is less than the minimum slope, GEOPAK Drainage sets the slope equal to the 
minimum slope. This will provide the upper limit of the envelope. Then, it continues 
downstream. 

• To setup the bottom part of the “envelope” , it starts from the outlet elevation, move upstream 
and setup the minimum invert of the pipes by using node elevation minus the maximum depth 
values on each node. 

• If the invert falls within the minimum and maximum slopes the link is placed at the calculated 
elevation.  If not, the link is once again placed at the minimum specified slope from that node 
to the upstream end of the system. 

• If during the construction of the envelope, any elevations that the user has held will be 
accommodated if physically possible and the envelope constrained to that elevation.  
However, if a held elevation of a pipe violates the minimum or maximum depth line, the 
elevation will not be held. With the minimum and maximum depth profiles computed, 
GEOPAK Drainage can then design a suitable pipe within this envelope that satisfies all the 
constraints possible. 

VDOT GEOPAK Drainage  © 2007 VDOT 6-39 



Link Configuration Dialog: Constraints 

 

 

The other constraints, minimum and maximum velocities are for querying purposes and evaluating the 
adequacy of the design. 

Minimum Rise Constraint - Minimum rise (diameter, height) for pipe or ditch in master 
units (i.e. feet or meters). The Department’s minimum round pipe size is 
1.5' (18”). 

Maximum Rise Constraint - Maximum rise (diameter, height) for pipe or ditch in master 
units (i.e. feet or meters). Unless the designer knows a constraint, it is 
recommended that this be set for a large pipe such as a 6' (72”). 

Minimum Slope Constraint - Minimum physical slope for pipe or ditch expressed in 
percentage. The minimum pipe slope varies with the pipe size (0.15% for 
18”, 0.102% for 24” etc.)  See the discussion in the Storm Drain Handbook.  
During the initial design, the pipe sizes are not known, so this constraint 
may need to be changed as the design progresses.   In moderately sloped 
terrain, using 0.15% may be acceptable for all pipes, because the terrain 
will force the pipes to be steeper than that.  In flat terrain, using 0.15% for 
all pipes may cause the downstream pipes to be too deep. 

Maximum Slope Constraint - Maximum physical slope for pipe or ditch expressed in 
percentage. The Department does not have a maximum slope constraint, so 
it is recommended that this be set high for all pipes. 

Minimum Velocity Query - Minimum velocity for pipe or ditch expressed in feet per second or 
meters per second. This value must be something greater than zero for the 
program to do the hydraulic calculations. 

Maximum Velocity Query - Maximum velocity for pipe or ditch expressed in feet per second or 
meters per second. 
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LINK CONFIGURATION DIALOG: COMPUTATION 

The Computations option allows for evaluating the computed hydraulic properties of the Link. Link 
hydraulics are not available for review until a Network has been established containing the Link and 
the Network hydraulic computations have been successfully performed.  

 

LAB EXERCISE: LINKS 
> Link Placement 

1. Select the Add Drainage Link tool (Drainage: Component > Link > Add).  

 

2. Click OK. We are using the default Link ID. 

       
3. Highlight Definition. This sets the pipe's spatial characteristics including From and To Nodes 

ID’s, pipe shape, material, library items, etc.  
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4. Graphically identify the From Node (3-1) by selecting the ID Button  and left clicking in 

the proper pipe connection point of the structure. 

5. Accept the highlighted point by left clicking one more time. 

6. Graphically identify the To Node (3-2) by selecting the ID Button  and left clicking in the 
proper pipe connection point of the structure 

7. Accept highlighted point by left clicking one more time 

8. Set the other pipes properties under the Definitions option. 

Shape Circular 

Material Concrete 

Design Size Toggle ON 

Design Barrels Toggle ON and Select 1 for the Number of Barrels, 
then Toggle OFF. 

Manning’s n 0.013 

 

5. Highlight Conditions. 

The elevations shown are based on the From-Node and To-Node elevation minus the 
min/max depth, as specified in the Node Definition Dialog Box for Nodes 3-1 and 3-2 
respectively.  

In this case, no entries are necessary; Drainage will design all the profiles for this project. 

 
 

6-42 © 2007 VDOT VDOT GEOPAK Drainage 



Lab Exercise: Links 

 
6. Highlight Constraints. 

 

 

7. Establish the min/max design criteria for Links. 

Rise min/max 1.0 / 4.0 (feet) 

% Slope min/max 0.5 / 10.00 (%) 

Velocity min/max 2.00 / 10.00 (fps) 

 

8. Highlight Computations. 

This displays the computed hydraulic properties of the Link. 

 

Note Link hydraulics are not available for review until a Network has been established and 
designed or analyzed (next exercise) successfully. Check here for computations after the 
Network has been added and designed or analyzed. 

9. Click Apply. This incorporates the link to the project. 
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10. Add the remainder of the link conveyance system by clicking Add Link. 

Note As Links are added, most dialog values default from the previous Link with the exception of 
the node and elevation information. 

Link Traverses From Node To Node 

PIPE-2 3-3 To 3-2

PIPE-3 3-4 To 3-5 

PIPE-4 3-7 To 3-6

PIPE-5 3-6 To 3-5

PIPE-6 3-5 To 3-2

PIPE-7 3-2 To Outlet and set the invert elevation at the Outlet node at el. 2013.00 
using the Conditions option in the Link Configuration dialog box.  

11. Close the dialog box when done. 

 

NETWORKS:  INTRODUCTION 
A GEOPAK Drainage Network is defined as a series an interconnected Nodes and Links draining to a 
single outlet . GEOPAK Drainage can maintain multiple Networks in a single project.  

 

 

The Network computations serve as the final calculation process in the design or analysis of a storm 
drain system. Drainage Areas and Inlets may be computed individually and are not dependent on any 
type of Network topology. Pipes and Ditches, however, are dependent on the connectivity and 
Network characteristic and therefore, require a Network be defined and successfully built, in order to 
complete the hydraulic computations on these features.  

Several options are supported to add, edit, and delete Networks and are invoked via the Network pull 
down on the main menu bar as depicted below. Alternately, the Network tools are invoked by selecting 
Tools > Tool Boxes > Network, then identifying the desired tool from the tool box. 
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Seven tools are supported in the Network tool box (from left to right). 

 

Tools Description 

Add Initially utilized to define the Network and associated data. When 
invoked, the Network Configuration dialog is blank. 

Edit Utilized to edit any previously defined Network. When selected, the 
Select Network dialog is invoked, wherein the desired Network is 
highlighted. Note the Network Edit dialog is identical to the Network Add 
dialog, however all associated data is displayed. 

Delete Utilized to delete the specified Network and associated data. 

Rename Utilized to rename any previously defined Network.  

Design This mode enables when an Active Network is defined. It's a shortcut to 
the Design procedure without having to invoke the Network dialog. 

Analyze This mode enables when an active network is defined. It's a shortcut to the 
Analyze procedure without having to invoke the Network dialog. 

Set Active Network GEOPAK Drainage uses an Active Network as a shortcut and 
organization tool. Many of the reporting, query, and navigation tools 
support the use of the Active Network to limit the information viewed to 
the system currently under design (the Active Network). When selected, 
the Active Network dialog is invoked, wherein a previously defined 
Network may be specified as active. The current Active Network is 
displayed on the main menu bar for quick reference. 

NETWORK CONFIGURATION DIALOG 
It is within this dialog where a network is built and computed. The dialog box is divided into two 
major groups: Validation and Computations. 

 

Validation: Build 
Network. Highlight 
Network. 

Build Network: Builds the storm drain network starting from the Outlet 
Node. The purpose of building a Network is to check the topology and 
connectivity and determine whether this storm drain system is ready to 
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be analyzed or designed. It is at this time that all the flow directions 
through the Links are established.  

The Network is established by traversing from the Outlet Node upstream, 
splitting off into multiple paths at a fork, until terminating nodes are 
reached on all paths. For a gravity system, the topology must be a tree 
structure.  

This process validates all the interconnected components for errors 
and/or unexpected conditions like: no or multiple outlets identified, 
indeterminate flow path due to loops, duplicate links, or multiple 
downstream links from a single node.  

Highlight Network: Highlights all elements (Areas, Nodes, and Links) 
contained in the current Network for visual inspection of the system. 

 

 

Computations: 
Design. Analyze 

 

Design: Performs the hydraulic design of all the components contained 
in the Network. It evaluates the current Network, and designs any 
features that were indicated as such. 

Analyze: Performs the hydraulic analysis of all components contained in 
the Network.  It evaluates the current network, ignoring all design toggles 
and maintaining current feature sizes. This can be helpful when 
evaluating a system that has already been designed to see how it 
accommodates a different design storm.  This is also helpful when the 
designer is changing the size of certain pipes to meet the hydraulic 
gradient clearance requirements.  In this case the designer may want to 
change only one pipe while holding the size of the others. 

Lock/Unlock Sizes Lock or Unlock the sizes prior to computing. Be careful with this option 
since it will lock/unlock all pipes sizes, even the ones manually defined 
by the designer. 

Lock/Unlock 
Elevations 

Lock or Unlock the pipe invert elevations prior to computing. Be careful 
with this option since it will lock/unlock all pipe inverts, even the ones 
manually defined by the designer. 
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LAB EXERCISE: NETWORKS 

> Network Design 

1. Select the Add Drainage Network tool (Drainage: Network > Add). 

 

2. Enter the network information. 

Network ID: System1 

Outlet Node Outlet 

3. Click OK. 

4. In the Validation section, click Build Network.  

This feature verifies the nodal topology and link connectivity. The Highlight Network 
feature highlights all components (areas, inlets, pipes, etc.) connected to the Active Network. 

 

5. Click Apply. The Network SYSTEM1 has been added to the project. 

6. In the Computations section, click Design Network. 

GEOPAK Drainage designs the network and issues the pertinent Warning Messages, if 
necessary. These warning messages are also written in an ASCII file named: drgmsg.txt 
located in the GEOPAK’s working directory. 

 
7. Click Set Active Network (to the left of Apply). 

8. Now we can review some of the provided reports of this network. 

9. Select the Drainage Area Report tool (Drainage: Reports > Drainage Area). Review some of 
the available reports. This will be further discussed in the Reports Chapter 
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10. Close the dialog box when done. 

 

DRAINAGE PROFILES: INTRODUCTION 
A Profile is a path between two nodes, spanning one or more links. Profiles allow you to define a path 
running in any direction (upstream or downstream) in a drainage Network and visualize profiles 
(ground, pipes, depth of cover...) along that path. All that is needed to define a profile is the 
identification of the From Node and To Node, and GEOPAK Drainage automatically traverses the 
Network and finds the Links connecting the two Nodes. . 

Several options are supported to add, edit, and delete Profiles and are invoked via the Component pull 
down on the Drainage menu. Alternately, the Profile tools are invoked by selecting Tools > Tool Boxes 
> Profiles, then identifying the desired tool from the tool box as depicted below. 

 
 

The Drainage Profiles tool box contains seven tools (from left to right). In addition, the tools can be 
invoked via the Navigator.  

Tool Description 

Add Drainage Profile Utilized to add a Profile to the current GEOPAK Drainage project. 

Drainage Profile List List of profiles in the current drainage project. 

ID Drainage Profile Allows selecting a previously plotted profile from the screen and making 
it the active one. 

Modify Drainage 
Profile 

Utilized to select and edit any previously defined and stored Profile 
within the current project. 

Delete Drainage 
Profile 

Utilized to select and delete the specified Profile and associated data. 

Update All Drainage 
Profiles 

Recalculates and redraws all the profiles in the active gdf file. 

Auto Create Profile The Auto Create Profile tool draws a series of profiles based on the 
specified network. 

When the Add, Edit, or Delete options are selected, the dialog depicted below is displayed. 
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The dialog is comprised of the Description area and five tabs. The fields detailed in the table below are 
independent of which tab is selected. 

Profile ID Identification of the Profile is displayed in the Dialog Title bar. 
(Maximum of 16 alphanumeric characters.) 

View Number Select the view in which the profile is to be drawn. 

Center Profile When clicked, the profile is centered in the specified view. 

Description Description of the Profile. (maximum of 32 alphanumeric characters.) 
This field is always at the top of the dialog, above the tabs. 

Apply Applies the current Profile information in the project. 
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REGISTRATION  

The Edit Drainage Profile dialog under the Registration tab is the one that control the display of the 
profile. Its setup is reviewed in the table below. 

Registration Point: X coordinate corresponding to the specified Station, Elevation. Y 
coordinate corresponding to the specified Station, Elevation. 

DP Identify x, y coordinates using a data point. Click, then identify and 
accept the desired point on the screen. Be aware that profile plotting does 
not support rotated views. The vertical direction should always be due 
North. 

Scale: Horizontal and vertical scales. All profiles are drawn to true dimensions 
in the horizontal, so the scales are used to determine the distortion factor 
of the vertical. Example:  10 Horizontal : 1 Vertical means that the 
vertical elements are distorted 10 times larger than the horizontal.  

Node Information: Node used as the starting point of the profile. This is populated using the 
From Node in the New Profile dialog. The From Node is on the left side 
of the profile and the To Node is on the right side. 

Reset Profile This will reset the profile display to the current setting of the dialog after 
the Project to Chain option is deactivated. 

Project to Chain If the Profile is to be projected onto a chain in order to utilize its 
stationing, the toggle is activated and chain parameters specified by 
selecting a profile cell previously plotted in the dgn file. 

Grid Stationing and 
Elevations: 

If Chain Projection is not used, the Stationing at the From Node is set to 
0+00 and is assigned to the Registration Point. If Chain Projection is used, 
the Station matches the Begin Station in the Projection group box. 
The ending station is automatically computed based on the length of the 
profile and the Beginning Station. 

Reference Surface Surface utilized to draw the ground profile above the Profile. A site 
model/object may also be specified. If blank, individual Node elevations 
are utilized. 

DISPLAY PROPERTIES  
The Display Tab determines what information is drawn for each profile. Activate the toggles for the 
desired components of the profile drawing and set the desired element symbology. For the Water, 
Drainage, Sewer Line and Misc. Utilities Crossings, labels may be placed by activating the toggle to 
the left of label. A separate set of symbology is used for the textual label from the crossing elements. 
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DRAINAGE INFORMATION  

Other information from the drainage GDF file may be optionally drawn. This information is generated 
after the design or analysis of the network. Simply activate the toggle to the left of the desired drainage 
information, and set the symbology. 

 

GRID AND LABELS 
A variety of Grid and labels options are supported to enable the user to customize the profile drawings. 
Six Grid & Labels options are listed on the left side of the dialog. To activate an option, double click to 
fill the option box to the left. Double click again to turn off, which ghosts the right side of the dialog. 

 

LINK PROFILE 
In this tab, each node of the link profile can be reviewed and modified. Clicking on any Link ID in the 
list box populates the fields below. To modify, change the desired field(s), then click Modify (to the 
right of the list box.)  To Hold an Invert, toggle on the button to the left of Hold Invert.  The Slope can 
also be held by toggling on in the lower right corner. A pipe size could also be change selecting the 
Drainage Library Item option. 

The user can also identify a Link ID, click ID then graphically identify one link of the profile. The 
associated line is highlighted in the list box. 
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After performing the changes, click Apply to accept all modifications. Depending on your Update 
options under Project>Preferences, Geopak Drainage will redesign your network using the same 
design parameters and constraints specified under the Nodes and Links menus. 

 

Note Geopak Drainage cannot accommodate adverse pipe.  If locked or held flow lines result in this 
condition, Geopak will adjust the flow lines to fix the problem, thus giving the appearance that 
the Lock or Hold Invert option does not work. A Warning message will inform the designer of 
the changes made to the pipe elevations after the design is performed.  

PREFERENCES 
The setup of the Edit Drainage Profile dialog box could be could be saved into a preferences file with 
default extension .ppf. This allows greater flexibility to the users since properties and display 
information of most profiles in the same project are very similar. 

 

MISCELLANEOUS UTILITIES 
Miscellaneous utilities can be stored within a drainage project and utilized within the utility conflict 
tool. Each group of utilities is stored as a group, then the group is referenced for conflicts. Therefore, it 
is prudent to group by location for subsequent location of conflicts, rather than grouping by utility 
type. For example, all utilities in an intersection, (i.e., gas, power, cable TV) can be placed within a 
single group, rather than all gas for an entire subdivision as a group. 

This tool checks for conflicts in elevation but it does not address conflicts in the horizontal plane. 
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Miscellaneous utilities for a drainage project are defined thru Components>Miscellaneous 
Utilities>Add. 

 

To properly define a utility location, the user needs to specify the horizontal and vertical location of the 
buried utilities in the Details section of the dialog box. The options available are: 

Alignment Element: specify the MicroStation symbology of the drawn utility. 

Chain: select the desired chain from the list of chain available in the 
gpk database 

Elevation Source Model: it can be selected from the list of all models in the current 
site project or GSF file. 

Object: it can be selected from the list of all models in the current 
site project or GSF file. 

Tin file: select the DTM or tin file of project.  

Size Defines the diameter of the utility in terms of master units, feet or 
meters. 

Offset Vertical distance (in master units) from the top of the utility to the 
specified model, TIN file, object or profile. Negative offsets indicate 
below the terrain, while positive offsets are above it. 
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LAB EXERCISE: PROFILE DESIGN 

> Creating a Drainage Profile 

1. Select the Add Drainage Profile tool (Drainage: Component > Profile > Add).  

 
 

2. Enter the Add Profile information.  

Profile ID: Profile1 

From Node: Select 3-4 

To Node: Select Outlet 

3. Click Apply. 

 

4. Enter the Edit Drainage Profile information. 

Min. Elevation: 2010.00 

Max. Elevation: 2025.00 

Horizontal Scale: 25 

Vertical Scale: 5 

5. Click DP and select a data point in the MicroStation design plane. 

This is the location where the profile is drawn. 

6. Select File > Open and select c:\data\geo\vdot\drain1\standards\Geopak\Drain_Profile.ppf.  
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7. This loads the profile plotting preference file.  

8. Click Apply. GEOPAK Drainage draws the profile.  

 
 

> Dynamically Editing Profiles 

1. Select the Link Profile tab. 

2. Click ID. Select and accept the link you want to modify from the profile view. (pipe-3). This 
will make pipe-3 the active link. 

3. In the Details section, click Edit Invert in the left Node group. 

 
 

4. Move your cursor into the profile view. There is a circle around the downstream invert at 
node 3-4. 

5. Move the cursor into the circle and drag the invert now. Link pipe-3 will dynamically follow 
your cursor. 

6. Data point to define a new invert location in the profile. 
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7. Click Apply. For this example, the "Automatic Update Network" dialog was activated in the 

Preferences, so the network is automatically redesigned after clicking Apply.    

8. Click NO to the alert dialog box if you do not want to display any warning or error message 
generated by the design process. 

Note GEOPAK Drainage redesigns your system aligning the pipes following the vertical alignment 
options (Match Soffit, Match Inverts, Allow Drop Manhole, etc.) of your node configuration. 
The inverts of the modified pipe get automatically locked but if there are other pipe sizes or 
inverts that you do not want to change, you must lock them in the Link Configuration 
Conditions dialog before changing an invert as shown above.  

 

AUTOMATED PROFILE BUILDER 
The Auto Create Profile tool draws a series of profiles based on the specified network.  

 
The setup of this dialog is similar to the individual profiles one. However, the automated process 
incorporates the need of specific action buttons. 

 
Query - Click to populate the list box from the specified 
network. 

 
Reverse Nodes - Changes the From Node To Node and the To 
Node to the From Node. 

 Add List Item - Enter the Profile Name, From Node, and To 
Node.  Then click Add. 

 
Edit List Item - Highlight a line in the list box, make the 
desire changes. Then click Modify. 

 
Delete List Item - Highlight a line in the list box, then click 
Delete. 

 
Move Line Up - Highlight a line, then click.  Each click moves 
the line up one place in the list box. 

 
Move Line Down - Highlight a line, then click.  Each click 
moves the line down one place in the list box. 
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The profile information group controls the setup of the created profiles. 

Preference File File created in the Edit Profile dialog, which 
contains the settings for drawing profiles. 

Scale: H,V Vertical and horizontal scale.  The horizontal 
scale is drawn to true measurements, while the 
vertical scale is distorted.   

Origin: X,Y Coordinates of the lower left corner of the first 
profile. 

Vertical Stack Offset Distance between profile drawings. 

 

LAB EXERCISE : AUTOMATED DRAINAGE PROFILES 
> Creating Automated Profiles for a Network 

1. Select the Auto-Create profiles tool. (Drainage: Component > Profile > Auto_Create). 

2. Select System1 as your Network ID. 

3. Setup the Profile Information group in the Drainage Automated Profile Builder dialog as 
shown below.  

The Preference file is located in \data\geo\vdot\drain1\standards\Geopak\Drain_Profile.ppf. 

The Origin X and Y represent the coordinates in the MicroStation file where the profiles will 
start plotting. Clicking the DP button will populate the coordinates. 
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4. Select the Query icon. Geopak will create a series of possible profiles along the network. 

 
5. Click Apply to plot the profiles in the dgn file. 

6. Close the dialog when done. 

 

REPORTS: INTRODUCTION 

GEOPAK Drainage provides a number of tools to create and generate both custom reports and quick, 
standardized reports.  The standardized reports for Drainage Areas and Inlets are updated dynamically 
as any of the components contained in the report are updated, so the impact of the changes can be 
reviewed on the entire system.  The Storm Drains/Links report dynamically tracks the condition of the 
data and provides notification whether the data is current in the report.  These summaries are 
dependent on the Network computations being performed successfully and whenever the Network is 
designed or analyzed, these report summaries are updated automatically. 

All report functions are invoked by selecting Drainage > Tool Boxes > Reports, then identifying the 
desired tool from the tool box as depicted below. 

 

Tools from left to right are:   

Drainage Area Report 
• Drainage Node Report – Sump 
• Drainage Node Report – On Grade 
• Drainage Link Report – Configuration 
• Drainage Link Report – Computations 
• Drainage Report Builder 
• Drainage Generate Report 

Of these reports, Drainage Areas, Inlets, and Storm Drains / Links are standardized reports, while the 
Builder and Generate menu selections are utilized for the customized reporting capabilities.  Both 
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standardized reports and customized reports can be viewed and subsequently, hard copy output can be 
produced. 

Several useful features are common in most of the standardized reports at the bottom of the dialog as 
depicted in the fragment below. 

 

Network  When initially activated, all components within the project are reported.  The option is All 
Networks.  By selecting Active Network, only those components in the active network are reported.  
Note in order to use this option, an Active Network must be defined prior to selecting the option.  If an 
Active Network is not defined, no warning message is displayed and the list box is not updated. 

Edit (/)  To edit an element directly from the report summary, highlight the desired element in the list 
box, then press the Edit (/) button, invoking the specified dialog in an update mode.  When the desired 
updates have been made, press the Update button which closes the dialog, returns to the report dialog 
and automatically updates the report with the edited information. 

Highlight  When the toggle is activated, double click on a line in the list box.  The MicroStation 
highlight color is applied to the specified item in the list for easy visual reference.  Note the screen 
maintains the relative window, i.e., it does not perform any Zoom In or Zoom Out commands.  Note 
the Window Center and Highlight toggles may be active simultaneously. 

Window Center  When the toggle is activated, double click on a line in the list box.  The highlighted 
item in the list is window centered on the screen.  Note the screen maintains the relative window, i.e., it 
does not perform any Zoom In or Zoom Out commands.  Note the Window Center and Highlight 
toggles may be active simultaneously. 

ASCII File  The data may be written to an ASCII file.  Manually type in the optional path and name of 
the file, or utilize the Files button to select from Create Area Summary ASCII File dialog.  Note the 
default extension is *.sum.  
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LAB EXERCISE: CREATE VDOT STORM CALCULATION SHEET  

Saving the Drainage Project Preferences Report 

1. Create the drainage preferences report for the project. (Drainage: Project > 
Export>Preferences to ASCII. 

2. Save the file as : drainage_preferences_17682.drp. 

 

Creating the VDOT Storm Calculation Sheet 

1. Activate the Macro tool in MicroStation. (MS Menu: Utilities > Macro > Project Manager) 

 
2. Load the project:  StormSewerTab.mvba located in the 

c:\data\geo\vdot\drain1\standards\Geopak\ directory. 

3. Select the previous loaded macro and press the Macros button.  

 
4. Press the Run button. 
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Note The previous steps could be replaced by typing the following command in the MicroStation 

key-in browser: “vba load ; vba run”  and loading the StormSewer application. 

5. Set the drainage project , drainage preferences report file and network in the Storm Sewer 
Tabulation dialog. 

 
6. Press Generate Storm Sewer Tab 

7. Provide a name for the new storm tabulation Excel spreadsheet: Storm.xls 

8. Open Storm.xls with Microsoft Excel. Review the Stormtab and Spread worksheet. 

 
9. Exit MicroStation. 
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7 
OBJECTIVES 

• The objective of this chapter is to review the GEOPAK’s functionality of locating possible 
utility conflicts in plan and profile view.  

• Usage of the Conflict Finder tools and Miscellaneous Utilities. 

INTRODUCTION 
The Conflict Finder tool is an easy method of locating conflicts between components of a Drainage 
project and miscellaneous utilities. When a conflict is found, a textual label is displayed or drawn in 
the design file, based on user-defined parameters. Then, the designer has the option to fix these 
conflicts using the drainage profiling tools. 

 

The Conflict Finder dialog is divided into three groups: Check Feature, Display Options and Conflicts. 

CHECK FEATURE 
Several types of conflict checking are supported: Single Feature, Water Lines, Sewer Lines, and 
Drainage Links. When Single Feature is utilized, the ID Element is available and used to graphically 
identify any current Water or Sewer line in the project. Once identified, GEOPAK checks the element 
against any other elements identified in the Conflicts group box. 



Display Options 

 
DISPLAY OPTIONS 

The Display Option group controls the way the possible conflicts will be displayed or drawn in the 
MicroStation dgn file. Several definitions are present: 

 

Display Only 

 

The conflicts are labeled with display only, not written into 
the file. Therefore, they disappear when a View Control or 
Window command is issued. When not activated, the label is 
drawn into the design file.   

Conflict Elevation 

 

When the toggle is activated, the elevation of the conflicting 
feature is displayed. Note this corresponds to the feature 
defined in the Conflicts group box. When the toggle is not 
activated, no elevation is displayed. 

Feature Elevation 

 

When the toggle is activated, the Elevation of the feature is 
displayed. Note this corresponds to the feature(s) defined in 
the Check Feature group box. When the toggle is not 
activated, no elevation is displayed. 

Surface Elevation 

 

When the toggle is activated, the Elevation of the Design 
Surface at the X, Y location of the conflict is displayed. The 
Design Surface is defined in the Water and Sewer Preferences 
(Terrain). When the toggle is not activated, no elevation is 
displayed. 

Clearance 

 

When the toggle is activated, the elevation difference (in 
master units) between the Check Feature and the Conflict 
Feature is displayed. When the toggle is not activated, no 
clearance is displayed. 

Depth 

 

When the toggle is activated, the elevation difference (in 
master units) between the Surface Elevation and the Check 
Feature is displayed. When the toggle is not activated, no 
depth is displayed. 

View Center 

 

When activated, either the plan view or profile view may be 
centered in the specified view. 

Plan View Number 

 

When activated and a conflict is found and the View Center 
toggle is activated, the numbered view is utilized to window 
center about the plan view area of conflict. 

Profile View Number When activated and a conflict is found and the View Center 
toggle is activated, the numbered view is utilized to window 
center about the area of conflict in the profile drawing of the 
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 Check Feature. 

Edit Profile  

 

When activated and a conflict is found, and the Edit Profile 
dialog is activated, the numbered view is utilized to window 
center about the profile view area of conflict. 

 

CONFLICTS 
The Conflict group allows the designer to select what services or utilities to check. Possible conflicts 
could be checked against other drainage networks, water and sewer systems and user defined 
miscellaneous utilities. 

 

Check Drainage 

 

When the toggle is activated, all drainage links in the current 
Drainage project (gdf file) are checked for conflict with the 
Checked Feature(s). When the toggle is not activated, no 
conflicts are checked. The drainage project is specified in the 
Water and Sewer Preferences (Project Components). 

Check Sewer 

 

When the toggle is activated, all sewer links in the current 
Water and Sewer project are checked for conflict with the 
Checked Feature(s). When the toggle is not activated, no 
sewer conflicts are checked.  

Check Water 

 

When the toggle is activated, all water links in the current 
Water and Sewer project are checked for conflict with the 
Checked Feature(s). When the toggle is not activated, no 
water line conflicts are checked.  

Check Misc 

 

When the toggle is activated, all miscellaneous utilities in the 
specified group in the current Water and Sewer project are 
checked for conflict with the Checked Feature(s). The group 
is selected from the option list of all utility groups in the 
current project. When the toggle is not activated, no utility 
conflicts are checked.  

Clearances 

 

When set to Default, the clearance stored with each line is 
utilized. In this case, the key-in field is ghosted. However, this 
can be overridden by selecting Override and typing in the 
desired Clearances value, in master units. 
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When the dialog is populated with the desired settings, clicking Compute commences the process. If 
no conflicts are found, an Information message is displayed. 

In addition, a note is displayed to the right of Compute in the Conflicts section. 

If conflicts are found, the number is noted to the right of Compute in the Conflicts section 

The Prev and Next can be utilized to move between conflicts, if more than one conflict has been 
found.  

MISCELLANEOUS UTILITIES 
Miscellaneous utilities can be stored within a drainage project and utilized within the utility conflict 
tool. Each group of utilities is stored as a group, then the group is referenced for conflicts. Therefore, it 
is prudent to group by location for subsequent location of conflicts, rather than grouping by utility 
type. For example, all utilities in an intersection, (i.e., gas, power, cable TV) can be placed within a 
single group, rather than all gas for an entire subdivision as a group. 

This tool checks for conflicts in elevation but it does not address conflicts in the horizontal plane. 

Miscellaneous utilities for a drainage project are defined thru Component>Miscellaneous 
Utilities>Add. 

 

To properly define a utility location, the user needs to specify the horizontal and vertical location of the 
buried utilities in the Details section of the dialog box. The options available are: 

Alignment Element: specify the MicroStation symbology of the drawn utility. 

Chain: select the desired chain from the list of chain available in the 
gpk database 

Elevation Source Model: it can be selected from the list of all models in the current 
site project or GSF file. 

Object: it can be selected from the list of all models in the current 
site project or GSF file. 

Tin file: select the DTM or tin file of project.  

Size Defines the diameter of the utility in terms of master units, feet or 
meters. 
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Offset Vertical distance (in master units) from the top of the utility to the 
specified model, TIN file, object or profile. Negative offsets indicate 
below the terrain, while positive offsets are above it. 

 

To Edit any of the previously defined utilities, simply select the one to be edited. Once selected, the 
dialog is automatically populated with the data associated with the selected utility. Edit the data as 
desired, then click Apply to complete the editing. The only data which cannot be edited is the ID. To 
change the ID, delete the utility and use the Add Miscellaneous Utility tool with the new ID and 
associated information.                                

 

LAB EXERCISE: CHECKING FOR UTILITY CONFLICTS 
> Opening the Drainage Project 

1. Execute c:\data\geo\vdot\drain1\LAB07_V8ad.EXE 

2. Open the MicroStation file, c:\data\geo\VDOT\drain1\h17682.dgn. 

3. Open Project Manager (MS Menu: Applications > GEOPAK Road > Project Manager) 

4. Select project: 17682.prj located in c:\data\geo\VDOT\drain1, and click OK. 

 
5. Access User: VDOT. 
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6. Click OK. The Road Project dialog will load. This will setup the proper directories for the 

location of the gpk file. 

 
7. Minimize the Road Project dialog box. 

8. Access GEOPAK Drainage ( MS Menu: Applications > GEOPAK Drainage > Drainage).  

9. Open the drainage project, c:\data\geo\vdot\drain1\h17682.gdf (Drainage Menu: Project > 
Open).  

  

> Adding Miscellaneous Utilities 

1. Select the Miscellaneous Utilities tool (Drainage: Component>Miscellaneous Utilities>Add). 

2. Enter ID: Service_utilities. Click OK when finished.  
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3. Enter the electric line information. 

Alignment Element. Level=Level24 , Co=Yellow (4), Style=0, 
Weight=7 

Elevation Source TIN File. C:\data\geo\vdot\drain1\survey.tin 

Size 2.0 

Offset -3.0 

4. Click Add List Item (right side of the dialog). 

5. Enter the water main data. 

Alignment Element. Level=Level25 , Co=Purple(5) , Style=0, Weight=7 

Elevation Source TIN File. C:\data\geo\vdot\drain1\survey.tin 

Size 2.5 

Offset -6.0 

6. Click Add List Item (right side of the dialog). 

7. Enter the telephone lines information. 

Alignment Element. Level=Level27 , Co=Brown(6) , Style=0, Weight=7 

Elevation Source TIN File. C:\data\geo\vdot\drain1\survey.tin 

Size 0.5 

Offset -1.5 

 

8. Click Apply when done entering all the utilities in the project. 

9. In the Miscellaneous Utility dialog, select File>Save As. Save the file: Service_utilities.utl 
under c:\ data\geo\vdot\drain1\ 

 
10. Close the Miscellaneous Utility dialog. 
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> Checking for Utility Conflicts in Plan View 

1. Select the Conflict Finder tool. (Drainage: Utilities>Conflict Finder). 

2. Populate the Conflict Finder dialog as shown below. 

 
3. Double click inside the text display box to setup the plotting parameters. 

 
4. Click OK when done. 

5. Click Compute in the Conflict Finder dialog to initiate the process. 

6. Using the Next and Previous buttons verify the utility conflicts. 
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7. Close the dialog when done. 

 

 Checking for Utility Conflicts in Profile View 

1. Edit the previously created drainage profile. (Drainage:Component>Profile>Edit List). 

 
2. Center the profile in the MicroStation view by clicking the Center Profile icon.  
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3. Select the Display Tab 

4. Toggle ON the Misc.Utility Crossings group. 

 
5. Click Apply to update the profile and show the utility crossings. 
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6. Select the Link Profile tab. 

7. Modify the pipe inverts to clear the utility conflicts. 

 
8. When done, click Apply to redesign the network with the new pipe inverts and/or sizes. 

7. Review the new design and exit MicroStation when done. 
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This page left blank intentionally. 

 

 

 

 

7-12 © 2007 VDOT VDOT GEOPAK Drainage 



Plans Preparation 

VDOT GEOPAK Drainage  © 2007 VDOT 8-1 

8 
 

OBJECTIVES 
• Review plans preparation procedures under GEOPAK Drainage. 

• Renumber Nodes along the network system. 

• Plan View Labeling of drainage structures and pipes. 

• Plotting flow directional arrows along the pipes. 

• Plotting a sketch of the drainage network. 

• Compute Automated Quantities 

• Create Summary Tables. 

PLAN VIEW LABELING 
The Labeling automates the composition and placement of plan labels onto drawings. This interactive 
tool permits the creation of very simple to complex labels using many of the following features:  

• Numerous Computed Text Inserts permit standardized computed values to be easily incorporated 
into labels. These standardized computed values are based on the type of element to be labeled and 
change as you select different elements. Types of elements available for computed inserts include 
points, lines, arcs, complex graphic elements, COGO features, and drainage features. 

• User Text Inserts facilitate the simple inclusion of user defined text strings into the label. These 
User Inserts can be customized to include frequently used labeling terms and be saved for 
continual use. 

• Standard shapes can be placed around labels and to accommodate different plan label formats. 
• Standard leader lines and leader line terminators can also be utilized to create the desired label 

formats. 
• Frequently utilized labels can be stored as Label Styles for subsequent recall. The complete label, 

including computed text inserts, user inserts, shapes, and leaders, are all stored within the Style. 
• Tools to edit, move, and extract labels are also provided to make manipulation and plan changes 

easier. 
• Enhanced ASCII is supported by use of the (\) symbol. 
• Styles are supported, whereby often used labels and associated settings can be saved off and 

recalled in subsequent sessions. 
• Updating options provide for efficient changing as the project dictates changes in the design. 

While the labeler can be used for generic purposes, several of the fields are set up for specific 
applications. The specialty modes include: 



Renumber Nodes 

 
• Plan View 
• Profile 
• Cross Section 
• Drainage 
• Site 
• Water and Sewer 

Under each mode, the types of elements available to label and the associated text inserts change.  

RENUMBER NODES 
GEOPAK Drainage provides an automatic tool to renumber all the nodes in the gdf. (Drainage: 
Component > Nodes > Renumber). 

The renumbering tool will update not only the selected nodes, but all the pipes connected to them, 
drainage areas and profiles. Conflict resolution procedures are also available to the user prior the 
renumbering process. 

 

The Renumber Node dialog box is divided in four groups: 

Alignment Possible nodes for renumbering will be scanned along a 
specified chain and station range. The scan range is also 
limited by a search distance along the left and right side 
of the alignment. The Find button will initiate the 
scanning process. 

Numbering The new nodes will be renumbered or renamed 
according to the new prefix, number and suffix specified 

Nodes Inside the Scan Range The list box will show the encountered nodes along the 
alignment after the scanning process is finished. 

Node Name Conflicts outside the scan 
range 

This list box will be populated only if the new 
numbering of the nodes has a name conflict with an 
existing node in the system that was not selected by the 
FIND process. The designer will have to resolve this on 
an individual basis, renaming the conflict node and 
place it into the Nodes inside the Scan Range list box. 
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LAB EXERCISE: RENUMBERING NODES 

 Opening the Drainage Project 

1. Execute c:\data\geo\vdot\drain1\LAB08_V8ad.EXE 

2. Open the MicroStation file, c:\data\geo\VDOT\drain1\h17682.dgn. 

3. Access GEOPAK Drainage ( MS Menu: Applications > Drainage > Drainage). 

4. Open the drainage project, c:\data\geo\VDOT\drain1\h17682.gdf (Drainage: Project > Open) 

 Renumbering the Nodes 

Warning It is recommended that before renumbering, the designer should create a copy of the dgn and 
gdf file for the drainage project as a backup. 

1. Select the Renumber tool (Drainage:Component>Node>Renumber). 

2. Fill out the Renumber Nodes dialog as shown below. We will renumber all the structures 
following the direction of the alignment Mainline, starting with structure 3-1. 

 

3. Click Find. 

 
4. Click Renumber Nodes. GEOPAK will renumber all the drainage structures, update the links 

connections, and drainage areas, and accordingly to our previously setup project preferences it 
will update the calculations and profiles. 
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LAB EXERCISE: SKETCH OF THE GEOPAK DRAINAGE NETWORK 

Creating a Sketch of the Network 

1. Open VBA Project Manager dialog. (MS Menu: Utilities > Macro > Project Manager). 

2. Load the macro: DrainageNetworkSketch.mvba located in the 
c:\data\geo\VDOT\drain1\standards\geopak directory.  

 
3. Select the previously loaded macro and press the Macros button. 

 
4. Click the Run button.  
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Lab Exercise: Sketch of the GEOPAK Drainage Network 

 
5. Set the drainage project and drainage network in the Drainage Network Sketch dialog.  

 
6. Upon selection, the sketch will be displayed in the dialog box. 

9  

7. Using the Scale and Move buttons adjust the size of the node labels, node cells and link 
labels. 

 
8. Click on the Save icon to store the network sketch as a JPG image file. 

 
9. Close the dialog when done. 
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LAB EXERCISE: UPDATING THE DESIGN TO VDOT CADD STANDARDS 

> Updating the Drainage Design to VDOT CADD Symbology. 

1. Open the Drainage Preferences dialog.(Drainage: Project > Preferences). 

2. Select the Plan Symbology item. 

3. Toggle OFF the Labels option. 

4. Disable the Set Node Cell Symbology. 

 
5. Click OK when done. 

6. Open the Design & Computation Manager. (Applications > GEOPAK Road > Design & 
Computation Manager) 

7. In the Design & Computation Manager, open the VDOTenglish.ddb database located in the 
c:\data\geo\VDOT\drain1\standards\geopak directory.  (Design and Computation Manager : 
File > Open) 
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8. Select Settings > Design in order to change the updating properties for the drainage structure 

cells. 

 
9. Toggle ON the Influence Graphic Cell Symbology option. Then, close the dialog box. 

 
10. Execute the Area Update All option. (Drainage: Component> Area > Update All).GEOPAK 

Drainage will clear the previously place drainage area labels. 

11. Execute the Nodes Update with PayItems option. (Drainage: Component> Nodes > Update 
With Pay Items). GEOPAK Drainage will update the drainage structures level symbology 
according to VDOT CADD Standards. 

12. Execute the Links Update with PayItems option. (Drainage: Component> Link > Update 
With Pay Items). GEOPAK Drainage will update the drainage structures level symbology 
according to VDOT CADD Standards. 
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LAB EXERCISE: PLAN VIEW LABELING 

> Labeling Drainage Structures 

1. Open the Drainage Labeler. (Drainage: Utilities > Labeler).  

2. Select the Text Tab and set the Component to Node. 

 

3. Select the first Element ID: 3-1. 

4. Double-click the Computed Text: Node-ID to add it to the Editor box. 

5. Click on the Parameters Tab and set the Text Preferences/Symbology as shown below. 
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Lab Exercise: Plan View Labeling 

 
6. Move to the Shape Tab, and set the Shape Preferences and Symbology as shown below: 

 

7. Move to the Leader Tab and set the Leader Type as shown below. 

 
8. Move to the Rotate Tab and select the Current Angle option as shown below. 
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Lab Exercise: Plan View Labeling 

 
9. Place the label in the design file by clicking Place Label. 

 

10. Create a new Style by moving to the Styles Tab and clicking on New Style. Provide a style 
name for the label, and press OK. 

              

11. Save the Style by selecting Style Files > Save. 
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12. Move to the Text Tab, and select the second structure: 3-2. By activating the Highlight and 

Window Center toggles, the Drainage Labeler will navigate to the correspondent drainage 
structure location in the dgn file.  

 

13. Label the remaining drainage structures. 

 

> Labeling Pipes 

1. After labeling the drainage structures, click on the Clear button in order to empty the Editor 
box. 

 
2. Select the Text Tab and set the Component to Links. 

 

3. Select the first Element ID: pipe-1. 
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4. Compose the label by double-clicking into the Computed Text: Link-Library Description. 

 
 

5. Click on the Parameters Tab and set the Text Preferences/Symbology as shown below. 

 
 

6. Move to the Shape Tab, and set the Shape Preferences and Symbology as shown below: 
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Lab Exercise: Plan View Labeling 

 
 

7. Move to the Leader Tab and set the Leader Type, Terminator and Symbology as shown 
below: 

 

8. Move to the Rotate Tab and select the Current Angle option as shown below: 

 

9. Place the label in the design file by clicking Place Label. 
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Lab Exercise: Plan View Labeling 

 
10. Move to the Text Tab, and select the second pipe: pipe-2. By activating the Highlight and 

Window Center toggles, the Drainage Labeler will navigate to the correspondent drainage 
pipe location in the dgn file.  

 

11. Label the remaining pipes and close the Drainage Labeler when done. 

 

> Plotting Flow Arrows along the Pipes 

1. Open VBA Project Manager dialog. (MS Menu: Utilities > Macro > Project Manager). 

 
2. Load the macro: DrawFlowArrow_along_pipes.mvba located in the 

c:\data\geo\VDOT\drain1\standards\geopak directory.  

3. Select the previously loaded macro and press the Macros button. 
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Lab Exercise: Plan View Labeling 

 
4. Click the Run button.  

 

5. Setup the Drainage Profile dialog as shown below. 

 

6. Click on the Draw Drainage Arrows button to plot the flow lines along the pipes.  

7. Close the dialog when done. 
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Automated Quantities 

 
AUTOMATED QUANTITIES 
The Design and Computation Manager (D&C Manager) is a tool that enables the user to standardize graphics 
elements for drafting and pay item quantities. 

A D&C Manager Pay Item can be used for Node and Link items within the Drainage Library for use in 
performing quantity takeoffs and applying D&C symbology.  Pressing the Select button within the specific 
Drainage Library Node or Link item invokes the Design and Computation Manager, in order to select the 
desired Pay Item. 

 

OPERATIONAL MODES: COMPUTE 
Several operational modes are supported within the Design and Computation Manager; one of them is 
the Compute mode. 

Through the Compute mode of the Design and Computation Manager, GEOPAK offers tools that 
make the completion of this task much quicker and easier.  In addition, since the software utilizes the 
plan view construction drawings to compile quantities, discrepancies between the drawings and the 
tabulated quantities are non-existent.  Chosen items within either the View or a Fence are calculated. 
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Operational Modes: Compute 

 

                           

Once the MicroStation plan view design file is accessed, the first step is to invoke the Design and 
Computation Manager and click the shortcut button at the top of the dialog box to Compute. 

The dialog box changes dynamically to reflect the compute operation. 

The Design and Computation Manager dialog box is resizable.  Within the dialog box, the sash (long, 
thin bar between list boxes) enables the user to adjust the partition between the list and collection 
boxes while the overall dialog box size remains constant.  Simply place the cursor over the sash and 
dynamically move. 

In addition to dynamically adjusting the main dialog box to reflect the compute operation, the auxiliary 
dialog box is invoked as depicted below.  Note if the auxiliary dialog box was already invoked from 
another operation, it dynamically changes to reflect the Compute operation. 

The next step is the selection of the correct item from the hierarchy.  GEOPAK computes quantities 
only for those hierarchical items that are configured for the computation of quantities. 

Two selection methods can be employed.  The first method is to select an entire category.  GEOPAK 
computes quantities for every item found in the selected category as well as any child categories.  This 
is accomplished by double clicking through the groups until the desired category is contained in the 
Content list box.  Single click onto the desired category and click the Add to Collection button at the 
top of the dialog box. 

The second method involves the selection of individual features.  This is accomplished by double 
clicking through the categories until the desired item appears in the hierarchy list box.  When seen in 
the hierarchy list box, a single click onto the desired item and subsequent click of the Add to 
Collection button places the item in the Collection box. 

Several output formats are available as described in the table below. 

Item Report  Quantities Summary lists pay items, descriptions, units and total quantities for 
located elements.  File is in ASCII format. 

Comp Book  A more detailed report that lists not only quantity summaries, but also geometric 
properties such as plan view coordinates and station/offsets for located elements.  
File is in ASCII format. 

Item Tables  Contains the same information as the Item Report, but formatted in tabular form. 

CSV by Item Quantities Summary lists pay items, descriptions, units and total quantities for 
located elements.  Format is in CSV format. 

SDF by 
Element  

A more detailed report that lists not only quantity summaries, but also geometric 
properties such as plan view coordinates and station/offsets for located elements.  
Format is CSV format. 

DBMS Very detailed information including calculated and rounded quantities, geometric 
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Operational Modes: Compute 

 
properties, pay item numbers, descriptions, station / offset values, etc. The format 
is the selected database (i.e., Microsoft Access, Oracle, SQL Server, and dbase. 

Table Places the report into the active design file. 

An option button located on the left side of the Compute auxiliary dialog box dictates the Output.  
Options that apply to various Output types are detailed in the table below 

View / Fence If the View toggle is selected, only selected items that can be seen in 
MicroStation view one will be computed.  If the view includes area outside of 
the Range, the Range will override.  If the Fence toggle is selected, a fence 
must be placed, and all specified graphical features, which are inside both 
the fence, and the Range will be tabulated.  The Fence mode is sensitive to 
the MicroStation Inside, Overlap and Clip modes. 

File / Preview If set to File, GEOPAK creates the file whose file format is based on the 
Output type and whose name is defined in the key-in field to the right of the 
File option.  The name can be manually entered or selected via the Files 
(folder) icon.  The file can be created or appended to an existing file.  If 
desired, a full path may be specified, otherwise, the report will be found in 
the current directory.   

If the option is set to Preview, the file is not created and the output is 
displayed in a GEOPAK window. 

Description Any description keyed within this field will be printed at the top of the report.  
There is a maximum of 48 characters supported for this field. 

Display These short cut icons are functionally identical to the Display mode in the 
main dialog box and are discussed in the next section. 

Highlight in 
Computation 

When activated, all MicroStation elements utilized in computations are 
highlighted. 

Compute Commences the computation process. 

Job Number  GEOPAK Coordinate geometry database (GPK) file wherein the specified 
chain is stored.  

Chain Requires a minimum of one chain, which must be stored in the specified job 
number.   

Select When selected, the Chain Selector dialog box appears, wherein the user can 
select the desired chain.   

Range Left and right offset limits (in master units) from the chain where the 
quantities will be computed.  Any specified item located outside of the limits 
is not included in the report 

Phase Quantities can be separated into various phases, as a means to group 
various pay items.  Default phases include:  Design, Preliminary, and Final.  
Note the user can add new phases, but must be aware of naming limitations 
of downstream applications (i.e., Transport links in Quantities Manager.) 

Run The user may also runs as a method of grouping various quantities and / or 
pay items.   
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LAB EXERCISE: AUTOMATED PLAN VIEW QUANTITIES 

Computing Automated Quantities 

1. Utilize the MicroStation command Window Area to view the entire Drainage Network in 
view. 

 
2. In the Design and Computation Manager, set the Mode to Compute by pressing the 

'calculator' icon button. 

 
3. Highlight the Drop Inlets Category under Location&Design, then press the Add to Collection 

button on the Design & Computation Manager toolbar. 
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4. Set the Compute dialog as shown below. 

 
5. Press the Compute Quantities button to start the calculation. 

 
6. Close the dialog when done. 

7. Exit Microstation. 
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LAB EXERCISE: PLOTTING SUMMARY TABLES 

Entering the Information in Microsoft Excel 

1. Open the Excel file, c:\data\geo\VDOT\drain1\ Erosion Control 
Summary_master_data_entry.xls 

2. Enter the pertinent information for your project.  

Warning Do not modify any of the first two rows. They are part of the formatting of the Table operation. 

3. When finished, delete the last row of the spreadsheet that contains the column labels. 

 
4. Click in the upper left corner of the spreadsheet to select all columns and rows. 

 
5. Format the cells using the AutoFit function. (Excel: Format > Column > AutoFit Selection) 

6. Save the spreadsheet formatted as a space delimited file. (Excel : File > Save As) 
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7. Close Microsoft Excel. 

Plotting Tables 

1. Open the MicroStation file, c:\data\geo\VDOT\drain1\a5.dgn 

2. Open the Tables tool. (Applications: GEOPAK Road > Plans Preparation > Tables) 

3. Select the Plot option. 

 
4. Select the Erosion table and load the file c:\data\geo\VDOT\drain1\ Erosion Control 

Summary_data_entry.prn. 

 
5. Select the Begin and End line number you desire to plot. 
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6. Give a data point at the location indicated in the dgn file. 

7. Click Apply. The table information will be plotted in the dgn file. 

 
8. Close the dialog when done. 

9. Exit MicroStation. 
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OBJECTIVES 
In this chapter, you will learn more about: setting up and accessing the coordinate geometry database 
file and create alignments and profiles for a future ditch. 

INTRODUCTION 
The Coordinate Geometry database file (*.GPK file) is comprised of stored geometric elements such as 
points, lines, curves, spirals, chains, parcels and profiles. When COGO calculations are completed, the 
results are stored in the binary database file, which is then utilized throughout the design process with 
many other applications. 

ACCESSING COGO 
When Coordinate Geometry is started, the Start-Up dialog appears. 

 

Project Name Name displayed on reports. This is an optional entry, with a maximum of 60 
alphanumeric characters. If Project Manager is active, this field is populated 
automatically. 

Job Number Identifies coordinate geometry database file and is a required field. The job number is a 
maximum of three alphanumeric characters. If Project Manager is active, this field 
populated automatically. This field is required. 

Operator Code Unique 2-character code which enables multiple users access to database file. The user’s 
initials are suggested. This field is not required for single user access, but highly 
recommended. If Project Manager is active, this field is populated automatically. 

Subject Description of coordinate geometry work (could relate to the project) with a maximum of 
48 alphanumeric characters.   
This field is optional. 

After the dialog is populated and OK is clicked, the main coordinate geometry dialog is invoked. 



Coordinate Geometry Dialog 

 
COORDINATE GEOMETRY DIALOG 

 

The coordinate geometry dialog box is made up of three separate display areas: 

• Tool Bar consisting of drop down options and icons. The display of specific icons is customizable. 

• COGO Key-in field enables manual entry of COGO commands. The drop down button allows for 
a history of commands to be reviewed. 

• Output Display Window shows the results generated by the commands. 

FILE COMMANDS 

 

 

Preferences Short-cut to COGO preferences and toggles for visualization coordinate readout 
and angle display. 

Input File 
Utility 

This option opens another dialog that contains group of file utilities that will be 
explained later. 
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Coordinate Geometry Dialog 

 
Input File 
Restore 

Loads an ASCII file of GEOPAK commands into the display window.  Note no 
processing occurs. The file must be named j999ooc.inp, where 999 is the current 
job number and “oc” is the operator code. 

Database 
Utilities 

Two tools are supported to validate, clean, and compress the COGO GPK database. 

Import  Imports horizontal and vertical alignments and points from ASCII Points, SDMS 
Alignments and Points, LandXML 1.0 Geometry, RDS, and VDOT PLT 
formats into the GEOPAK .gpk file. 

Export  Exports ASCII points, SDMS Points, SDMS Alignments, LandXML 1.0 
Geometry, and Alignments and Profiles into formats for use in various data 
collectors.  

Exit Closes the COGO dialog box and ends the coordinate geometry session. A prompt 
to save the session appears. Yes saves the audit trail, No exits without saving, 
Cancel returns to the COGO session. Whether you pick Yes or No everything you 
did is still saved in the .gpk file. 

USER PREFERENCES 

 

The User Preferences (as displayed in the exploded view above) are detailed in the following table. 

Dialog Allows access to COGO Preferences dialog box. 
Redefinition of 
Elements 

Toggles the Redefine option on/off. If Redefine is on, COGO data can be 
redefined/overwritten. 

Visualization Enables the elements to be displayed in the MicroStation file permanently, 
temporarily, or not at all. 

Coordinate Display Toggles between displaying NE or XY coordinates. 
Angle Display Toggles between displaying Bearing or Azimuth. 
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Coordinate Geometry Dialog 

 
INPUT FILE UTILITY 
The File Utility option invokes the following dialog. 

 

Load When selected, a menu appears listing all saved input files. Highlight a file then 
click OK. The input lines from the highlighted file are now displayed in the display 
window for viewing, editing, or processing. 

Append This command is for input files only. A new input file is created by copying the 
contents of an existing input file to the end of the current input file. The Save 
command must be used in order to store this new file. 

Catalog When selected, a menu appears listing all saved input files (under the current 
operator code) in the project directory. This is for reference only no action is taken. 

Delete When selected, a menu appears listing all saved input files. Highlight a file then 
click the OK button to remove this file from your project directory. Although the file 
is deleted, the elements stored as a result of processing the commands are not 
deleted. 

Output  Writes an ASCII file of the current display for reviewing and / or printing. 
(Fname999.ooc, where 999 is the current job number and oc is the operator code). 

Print Input 
File 

Sends your input file to the printer. 

Print Output 
File 

Sends your output file to the printer. 

Save Saves the current audit trail to a file. (Fname999.ioc, where 999 is the current job 
number and oc is the operator code.). 

Allow 
Commands 
to be Added 

When this is toggled on, COGO commands are added to a previously loaded file. 
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EDIT COMMANDS 

 

Clear Empties the memory of the current audit trail without saving and initializes the line 
numbers to begin a new sequence of commands. This does not clear the display 
window. 

Delete Deletes input commands in the input buffer by line number (or range of line numbers) 
and re-sequences the line numbers for the remaining commands. 

Insert  Adds a command line to the current input buffer before a specified line number; 
subsequent command lines shift down and line numbering is automatically re-
sequenced. 

Modify  Changes a fragment in a command line. The modified command line is not processed 
until a Read command is performed. 

Read All Processes all lines in the audit trail. 
Type All Displays the contents of the audit trail. 
Line 
Range 

Opens the Line Range dialog where a range of lines can be entered that can either be 
read or displayed. 

Editor Opens the COGO Command Editor, which enables you to edit the current input file. 
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ELEMENT COMMANDS 
The mainstay of GEOPAK Coordinate Geometry is the various element commands. Tools are 
supported for storing, stationing, adding additional data, deleting, etc. GEOPAK supports a wide 
variety of elements:  points, curves, spirals, chains or alignments, parcels, and profiles. Each element is 
detailed on the following pages. 

ELEMENT > POINT 

 

One of the most utilized sets of COGO tools are the point commands, which are detailed in the 
following table. 

Utility Opens the Point Utility dialog where the following options are available. 
Delete - Deletes a point number (or range of numbers) from the database file. 
Print - Displays the selected point numbers x, y, z coordinates, station value and 
other stored information in the display output window. 
Display - Visualizes the selected point numbers currently stored in the GPK file 
(Temporary Visualization or Permanent Visualization must be turned on). 

Cell Assigns a cell name to a previously stored point. 
Copy Copies points or a point range to a new point number or range within the same 

GEOPAK database file 

Elevation Assigns an elevation to a previously stored point 
Equate Stores a new point with the same values as a previously stored point 
Station Adds a station to a previously stored point. 
Store Stores a point by key-in coordinates or by selecting a location graphically. A station, 

elevation, point code, cell, feature, or description can be optionally stored with the 
point. 

9-6 © 2007 VDOT VDOT GEOPAK Drainage 



Coordinate Geometry Dialog 

 

 

Transfor-
mation 

Performs coordinate transformations based on user-defined control pairings 

Compare 
Points to 
TIN 

Utilizing a set of COGO points (with elevations) compares the COGO elevation to the 
TIN elevation and completes statistical analysis for "goodness of fit." 

Set 
Elevation 
from TIN 

Utilizing this command, GEOPAK adds or updates an elevation to a previously 
defined point, based on a TIN model. 

ELEMENT > CURVE 

 

Utility Opens the Curve Utility dialog where the following options are available. 
Reverse - Reverses a previously stored curves direction.   
Delete - Deletes a curve (or range of curves) from the database file.   
Print - Displays the selected curves x, y, z coordinates, station value and other stored 
information in the display output window.   
Visualize - Visualizes the selected curves currently stored in the GPK file 
(Temporary Visualization or Permanent Visualization must be turned on). 
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Coordinate Geometry Dialog 

 
Copy Copies a specified curve to another curve name. 

Data Calculates the geometric parameters of a curve, displaying values for Delta, Degree, 
Tangent, Length and Radius. 

Segment Defines new curves by dividing a stored curve into segments. 
Station By identifying a curve and a control point on the curve (PC, PI, or PT), a station value 

may be assigned. 

Store Provides various options for defining and storing curves such as Store Curve By 
Tangents as shown below.  

 

ELEMENT > SPIRAL 

 

Utility Opens the Spiral Utility dialog where the following options are available. 
Delete - Deletes a spiral (or range of spirals) from the database file.   
Print - Displays the selected spirals x, y, z coordinates, station value and other stored 
information in the display output window.   
Visualize - Visualizes the selected spirals currently stored in the GPK file 
(Temporary Visualization or Permanent Visualization must be turned on). 

Copy Copies a specified spiral to another spiral name. 
Store Provides various options for defining and storing spirals. 
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Coordinate Geometry Dialog 

 

 

ELEMENT > CHAIN 

 

Utility Opens the Chain Utility dialog where the following options are available. 
Area - Calculates the area of a closed chain. 
Delete - Deletes a chain (or range of chains) from the database file.   
Print - Displays the name of each element in the selected chains. 
Describe - Displays the alignment data of each element in the selected chains. 
Visualize - Visualizes the selected spirals currently stored in the GPK file 
(Temporary Visualization or Permanent Visualization must be turned on). 

Layout Offset Project points onto a chain or compute offset distance and direction between two 
chains at each control point or at user defined intervals of a specified station range. 

Station Provides a method for stationing or re-stationing a chain. 
Station Equation  Provides a method for applying a station equation to a chain. 
Store Provides three options for storing a chain in the database file, From Elements, 

Store Offset Chain, and Store Transition Chain.  The Store Chain From 
Elements dialog is shown below.  (Chain name can be between 1-9 alphanumeric 
characters)  

VDOT GEOPAK Drainage  © 2007 VDOT 9-9 



Coordinate Geometry Dialog 

 

 

ELEMENT > PARCEL 

 

Utility Opens the Parcel Utility dialog where the following options are available. 
Delete - Deletes a parcel (or range of parcels) from the database file.   
Print - Displays the elements of composition, the area of tract stored, taken and 
remaining. 
Describe - Displays the elements of composition, the area of tract stored, taken and 
remaining and a point, bearing, distance description of the specified tract. 
Visualize - Visualizes the selected parcels currently stored in the GPK file (Temporary 
Visualization or Permanent Visualization must be turned on). 

Copy Copies a specified parcel to another parcel name. 
Store Stores a parcel by adding points, curves and spirals. 
Subdivide Divides a parcel into individual lots. 
Editor Edits a parcel. 
Default 
Attribute 
Preferences 

Defines a set of attributes that are assigned to each additional parcel that is stored. 
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Coordinate Geometry Dialog 

 
PARCEL COMMANDS (MANUAL ENTRY) 
Several parcel commands are supported only by manual entry and have no associated dialogs. 

Store 
Taken 

Store the portion of a parcel taken by entering point and curve names in either a 
clockwise or counterclockwise direction. 

Store 
Easement  

Store easements by entering point and curve names in either a clockwise or 
counterclockwise direction. 

Own Parcel  Stores the names of the owners associated with previously stored parcels.  
Make Legal  Creates a metes and bounds description and writes it to a user named text file. See 

also Legal Description Editor for the ability to create detailed and customizable legal 
descriptions. 

ELEMENT > PROFILE 

 

The Profile commands (as displayed in the exploded view above) are detailed in the following table.  
Additional commands are supported as keyin only commands.   

Utility Opens the Profile Utility dialog where the following options are available. 
Delete - Deletes a profile (or range of profiles) from the database file.   
Print - Displays the data of the selected profile from the database file. 

Elevation Provides three options for reporting elevations along a selected profile, Station, Even 
Station, Incremental Stations. 

Offset Stores a new profile within a specified Station Range at a defined vertical offset from 
the original profile. 

Restation Creates a new profile with different stationing from a previously stored profile. 

VDOT GEOPAK Drainage  © 2007 VDOT 9-11 



Coordinate Geometry Dialog 

 
VIEW COMMANDS 

 

Icons Enables you to customize which icons appear in the tool bar. 

Redefine Displays the Redefine box on the tool bar. 
Visualization Displays the visualization items on the tool bar. 
Format Displays the format items (i.e. number of decimals, station format, etc.) on 

the tool bar. 

COGO Key-in Displays the COGO Key-in box for entering commands in the dialog. 
Command Output Displays the Command Output Window in the dialog box, and controls 

options for the Command Output Window. The Command Output window 
can also be saved to a text file in lieu of using the File > Output command. 

Error Alert Enables you to activate a beep and/or restore a minimized COGO dialog 
when an error occurs. 

TOOLS COMMANDS 
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COGO Navigator 

 
Navigator Invokes the COGO Navigator. 

Inverse Calculates the distance and direction between points. 

Locate Stores a point or series of points not by specifying coordinates, but based on a 
previously stored point using several methods. To locate a point by distance 
and bearing, use the Tools > Locate > Traverse as shown in the dialog 
below. 

 

Intersect Stores a point at the intersection of any two COGO elements. 
Best Fit  Calculates a best-fit chain through a set of points. 
Translation and 
Rotation  

Moves, rotates, and scales a data set. 

Map Check  Edits a parcel. 
Roadway 
Intersections 

Calculates data for the intersection of two COGO elements, usually chains. 

Cul-de-sacs  Calculates data for a cul-de-sac. 
Redraw 
Visualized 
Elements  

Re-syncs the visualized COGO elements in the MicroStation file with the 
coordinate geometry data. 

Clear Visualized 
Elements 
(Temporary)  

Removes all temporary visualized elements from the view. 

Clear Visualized 
Elements (All)  

Clears all temporary and permanent visualized elements from the 
MicroStation file. 

 COGO NAVIGATOR 
The COGO Navigator is a tool utilized to easily view and edit COGO data. Store, delete, edit, print 
elements, plus visualization and selection set commands are easily accessible via the Navigator. The 
Navigator can be accessed by the pull down menu COGO > Tools > Navigator or by the Navigator 
icon. The following dialog opens. 
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COGO Navigator 

 

 

From the Navigator, points, curves, spirals, chains, survey chains, parcels, and profiles  (all COGO 
elements contained in the coordinate geometry database file; *.gpk) can be added, deleted, modified, 
identified, visualized, printed, or selected. 

NAVIGATOR > SELECT TOOLS 
A variety of selection tools can be invoked via the Select pulldown, as depicted in the following 
exploded view. 

 

Select All Selects all data items of a certain type.  (i.e. all points) 
Invert 
Selection 

Selects all items not previously selected, and unselects all items previously 
selected. 

Clear 
Selection 

Unselects all items. 

Selection Set Allows you to create a selection set that meets particular criteria. Same as using the 
Selection Set icon 

Fit View 
(Selection Set) 

Fits the selected items to the active MicroStation window. 
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COGO Navigator 

 
NAVIGATOR > TOOLS 
A variety of tools can be invoked via the Tools pulldown, as depicted in the following exploded view.  
Many can also be invoked via the shortcut icons displayed at the top of the Navigator. 

 
 

Add Element 

 

Enables the selected type of element to be stored. When selected, the 
appropriate Store Element dialog is invoked. 

Delete Element 

 

Deletes the highlighted element(s). 

Edit Element 

 

Invokes the appropriate Store Element dialog, populated with the 
associated data of the selected element for editing. 

Identify Element 

 

When clicked and a COGO element is graphically selected, the element is 
highlighted in the display field. If the selected element is not the 
displayed element type (i.e., curve or point), the element type is also 
changed.   

Print/Describe Element

 

Displays the selected element’s data. 

Edit Element Feature Changes the feature code of the element. 
Visualize Element 

 

Displays the selected element(s) according to their feature code or default 
symbology. 

Unvisualize Element Removes the display of selected element(s) from the design file. 
Visualize All Displays all of the elements of a certain type, or all elements. 
Redraw Visualized 
Elements 

Re-syncs the coordinate geometry data with the data displayed in the 
MicroStation file. 

Clear Visualized 
Elements (Temporary) 

Clears only temporary visualized elements from the design file. 
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Clear Visualized 
Elements (All) 

Clears all visualized elements from the design file. 

Settings Enables you to define certain actions and behaviors of the Navigator. 

 

 

LAB EXERCISE:   COORDINATE GEOMETRY 
 Opening the Road Project Manager 

1. Execute c:\data\geo\vdot\drain1\LAB09_V8ad.EXE 

2. Open the MicroStation file, c:\data\geo\VDOT\drain1\h17682.dgn. 

3. Open Project Manager (MS Menu: Applications > GEOPAK Road > Project Manager) 

4. Select project: 17682.prj located in c:\data\geo\VDOT\drain1, and click OK. 
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Lab Exercise:   Coordinate Geometry 

 
5. Access User: VDOT. 

 
6. Click OK. The Road Project dialog will load. This will setup the proper directories for the 

location of the gpk file. 

 
7. Click the Coordinate Geometry button. 
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Lab Exercise:   Coordinate Geometry 

 
 Storing COGO Points 

1. Select Permanent Visualization on the main COGO dialog. 

2. Select the Store Point tool (COGO:  Element > Point > Store). 

 
3. To store point h1, enter the point number and coordinates as indicated in the dialog shown 

above. 

4. Activate the Auto Increment toggle.  This will automatically increment the point number by 
1 for subsequent Store Point commands. 

5. Click Store Point. This stores the point into the COGO database (gpk). 

6. Continue storing points utilizing the coordinates as shown below. 

Point Number Northing Easting 

H2 339044.1284 2718650.8320 

H3 339140.6908 2718566.4231 

H4 339200.0702 2718472.6387 

7. Close the Store Point dialog. 

 Store Curves 

1. Access the Store Curve By Tangents dialog. (COGO: Element > Curve > Store > By 
Tangents). 

2. To store the curve Ditch1, complete the dialog as shown below. 
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Lab Exercise:   Coordinate Geometry 

 
3. Click Store Curve to store curve Ditch1 into the COGO database. 

4. Store curve Ditch2, populating the dialog as shown below. 

 
5. Click Store Curve to store curve Ditch2 into the COGO database. 

6. Close the Store Curve By Tangents dialog. 

 

 Storing the Ditch Alignment 

1. Access  the Store Chain From Elements dialog. (COGO:  Element > Chain > Store > From 
Elements).  

2. Enter Ditch for the Chain Name. 

3. Set the option button to Begin Station and enter 0+00. 

4. Build the list of COGO elements which will become a part of the chain. You can fill in the 
elements comprising the chain by keyin or by graphically selecting the visualized elements in 
the design file. Ensure that the elements are added to the list in the order that you want them 
to be stored as a chain. 

 
5. Click Store Chain to store chain DITCH into the COGO database. 

6. Close the Store Chain from Elements dialog. 

 

 Describe the Ditch Alignment 

1. Access the Cogo Navigator. (COGO: Tools > Navigator).  

2. Set the Element option to Chain. 
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Lab Exercise:   Coordinate Geometry 

 

 
3. Highlight the chain DITCH 

4. Select the Print/Describe command. (COGO Navigator: Tools > Print/Describe Element). 

5. The chain geometry will be displayed in the main COGO window as shown below. 

 
6. Close the Navigator dialog. 

 

 Create Output Files 

1. Access the Input File Utility dialog. (COGO: File > Input File Utility). 

2. Set the option button to Output. 

3. Enter Ditch for the Output File Name. 
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Lab Exercise:   Coordinate Geometry 

 

 
4. Click Apply. 

5. An ASCII  file named ditch101.ovd will be created in your project directory. 

6. Close the Coordinate Geometry dialog box. 

 Drawing the Ditch Alignment 

1. Access the Design and Computation Manager (Applications > GEOPAK Road > Design & 
Computation Manager). A secondary dialog box will appear to be used in conjunction with 
the Design and Computation Manager dialog box. 

2. Select the item shown in the dialog box shown below. 

 

3. Click on the Draw Plan and Profile button from the secondary dialog box. 
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Lab Exercise:   Coordinate Geometry 

 
4. Select Chains operation as the Element Type.  Each of the chains will be displayed in the list 

box as shown.  Notice that the options that are to be drawn with the chain are already 
activated. Set the Label Scale to 25. 

 

5. To draw the chain, click on the name of the chain: Ditch in the list box. Only click once!! 
Each time you ID a chain it will be plotted into the design file. 

6. Change the Element Type to Stationing and modify the dialog settings as shown. 

 

7. To draw the stationing for the chain, click on the name of the chain: Ditch in the list box.  

8. Exit the Plan and Profile Draw dialog box and close the D&C Manager. 
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Existing Ground Profiles : Draw Profile Tool 

 
EXISTING GROUND PROFILES : DRAW PROFILE TOOL 

The Draw Profile Tool is not supported by Project Manager. It can be accessed by selecting 
Applications > GEOPAK ROAD > Plans Preparation > Draw Profiles or from the GEOPAK ROAD 
Tools tool frame. 

The generation of profiles must be invoked from within the 2D MicroStation design file where the 
profile is to be drawn. 

 

The initial entries that are required are the Job Number and Chain name. Once selected, click Dialog 
Profile Cell Control (to the right of the Job Number field).    

 

Select the Active Chain that the new or existing profile is to be stationed along. If no profile cell exists, 
click Place Profile Cell along the right side of the window to place a new cell. If multiple profile cells 
exist, highlight the desired cell and click Activate Profile Cell. 

UPDATE OPTIONS 
Four update options exist that allow you the control needed to tell the software what to do if a profile 
has been previously drawn in the file and needs updated. The options are toggled off/on by each 
selection of the option by clicking the Update Options pulldown. The check to the left of the option 
indicates the option is active. Only one option may be active at any given time, therefore, if an option 
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Surfaces Tab 

 
is selected, the previous active option is de-activated. The four options are detailed in the following 
table. 

Delete Existing Elements and 
Redraw 

When this option is activated, any profiles previously drawn with 
this tool are deleted and new ground lines are drawn. 

Delete Non-Modified Elements 
and Redraw 

When this option is activated, any profiles previously drawn with 
this tool and not modified with any MicroStation commands are 
deleted and new ground lines are drawn. 

Draw on Top of Existing When this option is activated, any previously drawn profiles are 
ignored and a new set is drawn, resulting in multiple copies of 
each profile. 

Query When activated, you are prompted each time the Draw button is 
pressed. 

SURFACES TAB 
The Surfaces tab defines the surfaces utilized as source data when drawing profiles. Multiple surfaces 
from a variety of sources can be drawn in a single processing. When the tab is selected and a profile 
cell is placed, the dialog dynamically changes as shown in the following graphic. 

 

Each surface to be drawn must be added to the list box. This is accomplished via the action/edit 
buttons on the right side of the dialog box. Each surface draws a cross section line string or lines.  
When a line is added to the list box, the profile is drawn. Note: clicking on the draw toggle in the list 
box deletes or redraws the profile. 

To add to the list box, simply select the source data and method, Display Settings, Tolerances and 
Offsets, and then add the profile to the list. Once a profile is drawn, it may be updated at any time by 
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Display Settings 

 
using Update Profile. Refer to the Update Options section to review those options. Any profile may 
optionally be stored to the GPK file. 

DISPLAY SETTINGS 
The Display Settings group box specifies the element symbology of the cross section elements being 
generated. The symbology may be specified using Level Symbology or a feature selected from a D&C 
Manager database. 

To use By Level Symbology, set the option to By Level Symbology, then double click on the graphic.  
This opens the Set Feature dialog box, wherein the symbology can be specified. Click OK when 
completed. 

To use By Feature, set the option to By Feature. Next, press the Paintbrush icon, which invokes the 
current Design and Computation Manager. Select the desired item, and then press the OK button, 
which closes the Design and Computation Manager, and populates the Draw Profile Display Settings 
group box. 

FILTER TOLERANCES 
Both Horizontal and Variance filter tolerances are considered together for each pair of profile 
segments. The middle point is deleted if both segment lengths are less than the Horizontal filter 
tolerance while the projected distance between the mid-point and the chord between the two end points 
is less than the Variance tolerance. 

 

OFFSETS 
Vertical or horizontal offsets may be specified in terms of master units (feet or meters). The horizontal 
offset is the distance offset from the chain. Once the horizontal location for the profile is determined, 
the data source is utilized to determine the profile. Any vertical offset is applied after the profile is 
generated from the source data. 

STORE PROFILE TO COGO 

 
When the profile is drawn, it may also be stored in 
COGO by pressing this button, which opens the 
dialog box depicted below left. 
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Profile Report 

 

 

The profile may be stored, or just the input file may 
be created. If an input file is created, the Operator 
Code and File Name are required. If the dialog box 
is invoked while in a 3D file, you may toggle on the 
option to create a 3D profile string. The 3D profile 
string consists of the circles denoting every location 
where the design centerline intersects topographic 
elements. If the circles are not deleted at this time, 
they can be deleted at any time with a single 
application of the MicroStation Delete Element 
command. 

COGO TAB 
The COGO tab is utilized for drawing any profile that has been previously stored into the GPK file. 

 

To draw a profile, first select the Profile Name to be drawn. Vertical Offset defaults to a value of 0, but 
can be set to any value. This instructs the software to draw the profile at a distance above or below the 
elevations in the GPK file. Station Limits may also be specified to have the software draw only a 
portion of the profile. If the Display Settings are set to By Feature and a feature is selected, the Options 
area of the dialog box is un-ghosted. This is where various labeling options for the profile can be 
specified. If a value is given for the Strip Grade Increment, elevations will be placed at that increment 
along the bottom of the profile. 

PROFILE REPORT 
To review a textual report listing stations and elevations of a ground profile, open the GEOPAK 
Coordinate Geometry dialog box. A couple of different methods can be used to create this listing for 
any profile.   
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Lab Exercise:   Existing Ground Profiles 

 
By selecting Element > Profile > Utility then 
highlighting a specific profile name and clicking 
Print. The results of this command will be 
displayed in the Command Output window of the 
Coordinate Geometry dialog box. To obtain a 
hardcopy of this information, create an output file 
using the File > File Utility > Output command 
and supply a filename of 1-5 characters. Then use 
the File > File Utility > Print Output File 
command to print this to the default system 
printer.  

The second method utilizes the COGO 
Navigator tool to create the Print Profile 
command. The advantage to this method is 
that multiple profiles can be identified at once 
and printed to the Command Output window. 
Start the COGO Navigator by clicking Tools > 
Navigator or selecting the icon from the 
COGO dialog box.  Change the Element to 
Profile then highlight the desired profile(s). 
Once selected, click the Print/Describe 
Element icon on the Navigator to process the 
profile(s).   

 

LAB EXERCISE:   EXISTING GROUND PROFILES 
 Extract an Existing Ground Profile Along the Ditch Alignment 

1. Select the Draw Profile Tool. (MS Menu: Applications>GEOPAK ROAD>Plans 
Preparation>Draw Profiles). 

 
2. Select chain DITCH. 

3. Click  Dialog Profile Cell Control icon  . 
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Lab Exercise:   Existing Ground Profiles 

 
4. Set the Active Chain to DITCH 

5. Click Place Profile Cell on the right side of the dialog and populate it as follows: 

 
6. Locate the profile cell by giving a data point in a clear area of the design file. 

7. From the Surfaces tab, select the Browse TIN File button in the Details area, then select the 
SURVEY.TIN file for the TIN File to cut the profile. 

8. Set the Method to Triangles.  

9. Set the option button to By Feature in the Display Settings area of the dialog. 

10. Click the Browser Feature icon then navigate to the item shown below. 

 
11. Click OK. 

12. Click Add Surface Settings to add the profile to the list box as well as draw the profile into 
the MicroStation file. 
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Lab Exercise:   Existing Ground Profiles 

 

 
 

 Store the Existing Ditch Profile into the COGO Database 

1. Click Store Surface in the Draw Profile dialog.  

2. Populate the dialog as shown below. 

 
3. Click Apply to store the EX_DITCH profile into the gpk database. 

4. Close the Store Profile and Draw Profile dialogs when done. 
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Proposed Profiles : Vertical Alignment Generator 

 
PROPOSED PROFILES : VERTICAL ALIGNMENT GENERATOR 

The Vertical Alignment Generator is a GEOPAK tool that can graphically create and modify proposed 
design profiles or modify an existing ground profile. These operations may be accomplished through a 
dialog box and/or by dynamic manipulation of graphic elements. 

The Vertical Alignment Generator can be accessed by selecting Applications > GEOPAK ROAD > 
Geometry > Layout Profiles (VPI Based). It can also be invoked from Project Manager by clicking the 
Vertical Alignment button or by selecting the VPI Based Vertical Alignment Design Tools icon from 
the GEOPAK ROAD tool frame. 

When selecting the Vertical Alignment 
generator, the first dialog that appears is 
labeled Settings, as depicted here. The 
entries in this box set the parameters and 
define the location within the design file where 
the profile components are to be displayed. All 
fields must be completed before the design 
process can begin. Once OK is clicked, the 
Vertical Profile Generator dialog box appears. 

Note This tool also utilizes the cell that was 
drawn in the previous exercise by 
using the Identify Cell button. 

 

USING THE VERTICAL ALIGNMENT GENERATOR 
This tool enables a user to load a previously stored profile or create a new profile. You will notice the 
dynamic changes in the dialog throughout the vertical alignment design. 
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Various design parameters must be defined prior to designing a new profile; which are discussed in the 
options supported under the two menu options; File and Tools. 

FILE 

 
 

Preferences – Elevation, length, grade increment and vertical curve preferences. 
Profile Cell Settings – contains the profile cell definition. 
K Value Table – defines the stopping sight distance K-values for crest and sag 
conditions at various design speeds. 
Load Profile - retrieves a previously stored profile from the coordinate geometry 
database (.gpk). 
Save Profile - stores a new profile or updates (redefines) a previously stored 
profile under the same name. 
Save Profile As - is used to store the profile or to save a modified profile under a 
different name. 
Clear Profile - clears the profile display from MicroStation graphics and removes 
all VPI’s from the dialog box. 
Draw Profile - write the graphic elements of the profile to the MicroStation file. 
Exit - ends the process. 

TOOLS 

  

 

Issue Data Point - Permits you to type in stations and elevations, issue a data 
point that can be part of a MicroStation place line, place a cell or perform other 
generic operations. This is useful in displaying visual references within the profile 
that need to be considered in design of the vertical profile. 
Critical Points - Vertical curves may also be defined by one or two critical points 
– i.e. the curve will pass through these points  If mathematically solvable, the 
vertical curve will be drawn and the design speed display adjusted to fit the 
current parameters. 
Best Fit – Allows you to best fit a line, parabola (vertical curve), or profile 
through a series of existing VPI’s. 
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Creating A New Profile 

 
CREATING A NEW PROFILE 

Warning The enter/tab key must be used to ensure values are accepted. 

A new profile can be created with the following steps: 

1. Place the first VPI using one of the four supported options. 

• Type station and elevation of the VPI into the appropriate fields in the Profile Generator 
dialog. 

• Enter station of VPI as precision input (type in value), and allow the elevation to be 
defined through dynamic cursor placement on screen. 

• Elevation is defined via precision input, and the station is defined through dynamic cursor 
placement on screen. 

• Both values for the VPI can be established dynamically on screen by clicking on the 
Dynamic button and placing a DP in the view at the desired station and elevation. 

2. Define ahead (or back tangent). 

Station, elevation, grade and length parameters may be defined via precision input, dynamic 
manipulation or a combination of both. 

3. Define remaining VPI’s and Grades. 

A repetition of Step 2 with an option to insert VPI’s between two existing VPI’s. 

4. Define Vertical Curves. 

Simply define the design speed from the Speed option button and GEOPAK will reference the 
K-value table and draw the vertical curve. If a curve overlap occurs, an overlap message will 
be displayed in the dialog box along with the overlap length. Length of Curve or K-value may 
also be keyed in. 

5. Adjust Curve Lengths. 

The vertical curve can be modified by directly keying in either the K-value, curve length or 
defining the design speed in the dialog box. You will see the values computed automatically 
adjust to reflect the results of any modifications. 

6. Save the Profile. 

Select File > Save As to name and save the newly created profile. The names of profiles are 
any 1-9 alphanumeric characters. 

PRECISION PLACEMENT OPTIONS 
 

 

Options available for creating or modifying vertical curves, VPI’s and grade lines:  

• OFF - Values change. 

• INC (Increment) - Ensures that the designated profile parameter 
will be adjusted as defined in the Preferences dialog. 

• LCK (Locked) - Forces selected operations to maintain the 
designated profile parameters. 

 

9-32 © 2007 VDOT VDOT GEOPAK Drainage 



Lab Exercise : Vertical Alignment Generator 

 
LAB EXERCISE : VERTICAL ALIGNMENT GENERATOR 

 Creating a Proposed Ditch Profile 

1. Select the Vertical Alignment Generator dialog. (MS Menu: Applications > GEOPAK Road > 
Geometry > Layout Profiles (VPI Based) ). 

2. Click the Identify Cell button and select the previously plotted profile cell. This will 
automatically populate the Settings dialog as shown below. 

 
3. Click OK. This will invoke the Profile Generator dialog. 

4. Provide the initial VPI Station = 0+00 and the initial VPI Elevation = 2033.50 as shown in the 
diagram below. Be sure to press Enter after each entry is made. 

 
5. Click the Insert button and complete the VPI Station and Elevation of the subsequent VPIs as 

detailed in the table below. 

VPI Station Elevation 

2 2+20 2018.00 

3 3+90 2012.05 

4 4+95.13 2009.11 

 

6. Click the Previous button to return to VPI 2 as shown in the diagram below. Enter a 200 ft 
vertical curve. 
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7. Click the Next button to move to VPI 3. Enter a 100 ft vertical curve. 

 
8. Select File > Save Profile to save the profile DITCH. 

9. Close the Profile Generator dialog. 

 

 Drawing the Ditch Profile 

1. Select the Draw Profile tool. (MS Menu: Applications>GEOPAK ROAD>Plans 
Preparation>Draw Profiles).  

2. Click the COGO tab then set the Label Scale to 50 in the upper right hand corner. 

3. Select the Profile Name DITCH in the Details section. 

4. Set the option button to By Feature in the Display Settings area of the dialog. 

5. Click the Browser Feature icon then navigate to the item shown below. 

 
6. Click OK.      

7. Click Add COGO Profile Settings to draw the profile.  
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8. Review the proposed ditch profile. This will draw the proposed profile with the proper 

symbology in addition to labeling the stations. 

9. Close the Draw Profile dialog. 

10. Exit MicroStation. 
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OBJECTIVES 
Provide you with a general understanding of GEOPAK Cross Section Reports and their capability to 
generate geometric information for the HecRas program. 

INTRODUCTION 
The creation of a stream or river cross sections requires the usage of different tools within the 
GEOPAK software. 

The GEOPAK Cross Section Report tool enables us to extract information from the stream cross 
sections in a format accepted by the HecRas software. 

The designer should be able to place a basic alignment along the stream and generate existing ground 
cross sections. These cross sections will be used in the GEOPAK Cross Section Report to format the 
data accordingly to HecRas GIS format. 

LAB EXERCISE: IMPORTING STREAM GEOMETRIC DATA TO HEC-RAS 
> Creating a River Baseline 

1. Execute c:\data\geo\vdot\drain1\LAB10_V8ad.EXE 

2. Open the MicroStation file, C:\Data\Geo\VDOT\drain1\Survey_river.dgn  

3. Access Store Graphics (MS Menu: Applications > GEOPAK Road > Geometry > Store 
Graphics) 

4. Enter the information as shown in the dialog below. 

 

5. Press ID Element and select each of the lines that represent the alignment of the river stream 
until the Store button activates. 



Lab Exercise: Importing Stream Geometric Data to HEC-Ras 

 
Note Remember to consider that for HEC-RAS the highest station value of a section is the 

upstream point of the channel. In our example, the river flows from south to north. 

6. Click on the Store button. 

7. Click OK at the Store Graphics notification dialog. The alignment will be saved into the 
geometric database and a copy of the generated commands will be written into the ASCII file 
j101ojd.inp. 

8. Close the Store Graphics dialog and delete the MicroStation lines that represented the stream 
alignment. 

 

> Drawing the River Alignment 

1. Access the Design and Computation Manager (Applications > GEOPAK Road > Design & 
Computation Manager). A secondary dialog box will appear to be used in conjunction with 
the Design and Computation Manager dialog box. 

2. Select the item shown in the dialog box shown below. 

 

3. Click on the Draw Plan and Profile button from the secondary dialog box. 

 

4. Select Chains operation as the Element Type.  Each of the chains will be displayed in the list 
box as shown.  Notice that the options that are to be drawn with the chain are already 
activated. Set the Label Scale to 25. 
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5. To draw the chain, click on the name of the chain: River in the list box. Only click once!! 
Each time you ID a chain it will be plotted into the design file. 

6. Change the Element Type to Stationing and modify the dialog settings as shown. 

 

7. To draw the stationing for the chain, click on the name of the chain: River in the list box.  

8. Exit the Plan and Profile Draw dialog box and close the D&C Manager. 
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> Existing Ground Cross Sections: Drawing Pattern Lines 

1. Access Draw Patterns (Applications > GEOPAK Road > Cross Sections > Draw Patterns 
by Station Range). 

 

 

 

2. Click Draw Pattern Lines to initiate the plotting of the patterns into the design file. 

3. Adjust the length of the pattern lines, using MicroStation commands, at both ends of the 
bridge just enough to cover the channel section. 

Note The designer has the option to add, delete or modify patterns lines manually using the Place 
Line command in MicroStation. GEOPAK identifies any line as a pattern line for cross section 
plotting by searching for user specified CADD symbology. 

4. Close the Draw Pattern Lines dialog box. 

 

> Existing Ground Cross Sections: Generating the Stream Cross Sections 

1. Open MicroStation file c:\data\geo\VDOT\drain1\xsriver.dgn 

2. Access Draw Cross Sections from Surfaces (Applications > GEOPAK Road > Cross 
Sections). 

3. Select the job number: 101 and chain name: RIVER in the Draw Cross Sections dialog. 

4. Generate the existing ground cross-sections by populating the dialog boxes as shown below.   
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Note The Display Settings for the existing ground line are set to level 1, color 1, style 2, weight 5 

5. Click DRAW to generate the cross sections. 

    

6. Exit the Draw Cross Sections dialog box. 

> Review the Cross Sections 

1. Select the Cross Section Navigator tool. (Applications > GEOPAK Road > Cross Sections > 
Navigator) 
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2. Use the Cross Section Navigator to browse and check your existing cross sections. 

3. Close the XS Navigator dialog box 

> Exporting to Hec-Ras 

1. Access the HEC-RAS report (Applications > GEOPAK Road > Cross Sections > Reports) 

 

2. Populate the dialog box as shown below. 

      

3. Click Apply to generate the Hec-Ras cross section geometry file. 

4. Exit MicroStation. 

 

10-6 © 2007 VDOT VDOT GEOPAK Drainage 



Lab Exercise: Importing Stream Geometric Data to HEC-Ras 

 
> Importing Cross Section Data into Hec-Ras 

1. Activate Hec-Ras from c:\ data\geo\vdot\drain1\hecras\ras.exe. 

 
2. Access the included Hec-Ras project: xsriver.prj located in the c:\data\geo\vdot\drain1 

 

3. Access the Geometric data module of Hec-Ras by selecting Edit > Geometric Data from the 
Hec-Ras pull down menu. 

 
4. Import the cross section data generated by GEOPAK. (File > Import Geometry Data > GIS 

Format ) 
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5. Select the file we created from the GEOPAK cross sections: 

 

6. Review the alignment and layout of the imported cross section data. 
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7. Review the generated cross sections by clicking on the Cross Section button in the Geometric 
Data dialog box. Click on the Expand XS Editor button to see a graphical representation of 
the cross section data. 

      

8. Save your project data and exit Hec-Ras. 
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OBJECTIVES 
• Provide the user with a general understanding of GEOPAK Site Modeler functionality.  Gain 

a general understanding of Site Models, Site Objects and Site Element interaction, 
associations, and terminology. 

• Design of a Pond and Channel 

• Review Pond Routing Calculations. 

• Review a procedure for Flood Plain Determination 

INTRODUCTION 
The GEOPAK Site Modeler enables fast, dynamic development of site models and easy management 
of the many changes that occur on site projects.  It captures design intent as users work and provides 
immediate visual feedback.  The software performs engineering modeling within a Digital Terrain 
Model (DTM)—without merging or extracting graphics into the DTM.  Many traditionally 
cumbersome processes are reduced to one step: for example, you can dynamically move a building pad 
in a single drag and drop step—without measurement, clipping, merging, and placement steps. 

The Site Modeler offers unprecedented flexibility in interactively working with site designs without 
the limitations of traditional iterative steps.  No cumbersome triangle or point editing is necessary.  The 
software maintains existing ground and provides full control over defining elevations and side slopes 
and balancing cut-and-fill.  Analytical tools are included to afford powerful evaluation of site designs. 

GEOPAK Site integrates digital terrain modeling with interactive 3D site design.  The software allows 
you to incorporate design features in the model while maintaining existing ground:  Move building 
pads, change pond elevations, extend retaining walls, trim curbs, or resize berms.  The Site Modeler 
automatically regenerates the DTM, yet retains full integrity of the models and the original DTM.  
There is no need for merging or extracting graphics into the terrain model. Easy on-the-fly functions 
let you change elevations and side slopes and balance cut-and-fill. You can add features such as 
contours to the model as needed to define your design.  Tools are supported for evaluating the site 
design and producing drawings and site models. 

SITE MODELER PROJECT COMPONENTS 
A GEOPAK Site Project is comprised of three components: Elements, Objects, and Models. 

GEOPAK SITE ELEMENTS 
Elements are any MicroStation graphical element assigned an elevation and DTM Feature (breakline, 
boundary, contour, etc.) with GEOPAK Site tools.  They can be placed into a 2D or 3D design file 
utilizing any generic MicroStation command, except Make or Drop Complex Chain.  Once the 
elements are drawn, elevations are assigned with GEOPAK Site tools.  At any time, they can be 



GEOPAK Site Elements 

 
moved, copied, or otherwise manipulated.  Once a group of elements is drawn to the designer's 
satisfaction, they can be defined as an object. 

Elements can be modified at any time during the site design process.  To move the location of an 
object in the X-Y plane, utilize any MicroStation command, except Create Complex Chain. 

Let's review several types of modifications, their impact on element elevation(s) and their results on 
the site project. If using the Site Element Association feature, the elements elevations will be recreated 
per their original definition. If not using the associations then the following will apply to the elevations 
of the site elements. 

Note All modifications support selection sets and fence operations. 

Extend / Shorten Line Use generic MicroStation commands to shorten or lengthen.  The Site 
Modeler holds the elevations of the original element. 

Insert Vertex Elevation of new vertices is interpolated between adjacent vertices. 

Move Element Maintains all vertices at the original elevations. 

Scale Maintains the elevations at all vertices. 

Rotate Maintains the elevations at all vertices. 

Mirror Maintains the elevations.  If there are duplicate vertices due to the 
mirroring, the second elevation is utilized. 

Delete Line Removed from the DTM object. 

 

GEOPAK SITE OBJECTS 

Site Objects are collections of Site Elements that are grouped together into Objects for the purposes of 
side slope definition, model merging, volume quantity options, and logical geometric components. Site 
Elements can be added to Objects as they are created or at any point in the design process. Site 
elements can also be removed and included in more than one Site Object.  Examples include: 

• Parking lots 
• Buildings 
• Ponds 

Each object can contain an unlimited number of elements.  In addition, it has other site attributes and 
capabilities that should be considered during object creation: 

• Side slopes - defines the interrelationship between the object and the model.  Cut and fill side 
slopes are automatically generated around the extent or boundary of each Object in the model.  
The boundary is automatically determined from the extent of the elements contained in the object.  
Side Slopes can be as basic as a single cut or fill slope from the edge of a building to existing 
ground, or intersecting slopes between two objects, i.e., a building and a parking lot. 

• Quantity depth - In order to do excavation quantities, an object may have an associated depth.  For 
example, a building may have a quantity depth of two master units, which represents the amount 
of granular material required beneath the building.  These quantities can be easily changed, and 
quickly computed. 

• A specific set of visualization settings can be applied to each object to control the display 
symbology of each. 
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• A Site Model is created by merging each of the triangulated Objects specified in the Model.  The 

designer determines which slopes control the merging process by means of a FIFO list.  The first 
object, also referred to as the Base Object is the starting surface.  Each object is then merged "on 
the fly" in the order listed.  To change the controlling slopes for intersecting, simply change the 
order of the list. 

• Site Objects can be raised and lowered in their entirety to easily evaluate design alternatives. 
• The Objects layout and the geometry of the member elements should be evaluated. The boundary 

of Objects is determined from the extent of the elements and the objects triangulated 
representation will include all elements.  Therefore, specific attention to the grouping of elements 
based on vicinity and shape of the desired objects in the model should be made. It is recommended 
to create more objects than fewer as it provides more control and more flexibility in the design and 
evaluation of the final model. 

Objects can be modified at any time during the site design process.  The following are methods of 
modification: 

• Add / remove elements from the object 
• Modify Object Slopes 
• Raise or lower the object 

GEOPAK SITE MODELS 

A model is comprised of an unlimited number of objects, one base object (i.e., existing ground), and a 
“First In – First Out” (FIFO) list which dictates the merging order.  Note the designer does not have to 
merge, as it's done automatically "on the fly."  As a new object is added to the model, its resultant 
slopes, contours, etc., can be displayed on the screen. 

Models can be modified at any time during the site design process. This can be accomplished in three 
methods: 

• Add or remove objects from the mode 
• Change the base object, i.e., update existing ground terrain data 
• Changing the FIFO list 

The workflow involved in using the Site Modeler is designed to expedite the creation of digital terrain 
models while providing enough flexibility to easily accommodate design changes. The following 
outlines getting started with the Site Modeler. 

• Establish base design planimetrics in 2D or 3D MicroStation design file. This includes design 
features that define the DTM (e.g., centerlines, curbs, berms, ponds, property line etc.). 

• Obtain design information such as original ground or survey information that serves as the basis of 
the initial design. 

• Review the geometric layout of design features and determine a preliminary concept for the type 
and configuration of Site Objects to be used in the design. 

• Start Site Modeler New Project Wizard. 
• Create an empty Model. 
• Import the base design information into the Model. 
• Select a location to begin the DTM design. 
• Create a new Site Object that fits the starting location. 
• Begin defining the elevations of the Site Elements and adding them to the Active Object. 
• Continue to create Site Objects, Site Elements as needed. 
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• Evaluate and analyze the Site Model and adjust Site Elements, Site Objects and Model. 

SITE MODELER MAIN MENU 
GEOPAK Site is invoked from within a MicroStation design file.  If the Project Wizard dialog is 
bypassed (by activation of the Don't Show this dialog at Startup), the GEOPAK Site Modeler main 
menu bar (along with the Active site Object Control) is automatically displayed.  An alternate method 
of invoking the menu bar is completion (without pressing the Cancel button) of the Project Wizard.   

Each menu selection accesses GEOPAK Site project information, feature placement and tools 
necessary to complete a GEOPAK Site project.  Tool frames and tool boxes are also supported for all 
functions and are accessed via the Tool boxes pull down.  The current Site working directory and 
Project File are displayed in the header of the menu bar. 

PROJECT MENU OPTIONS 

The Project Menu selections are utilized for creating new GEOPAK Site projects, opening existing 
projects, saving projects, establishing the project Preferences, Importing and Exporting data in and out 
of the project file, and exiting the Modeler. 

When working on a project, frequent use of the File > Save pull down is important.  Any changes 
made in the project are not recorded in the GEOPAK Site File (GSF) file unless a File > Save or File > 
Save As operation is executed.  Hence, any power interruption or other malfunction will result in loss 
of data that can be avoided through the judicious use of the File > Save tool. 

Each GEOPAK Site project contains a set of Preferences which control the project file components 
and visual symbology which are accessed through this menu selection. 

GEOPAK Site Modeler supports two operations to import data into a site project: 

• Data 
• 3D to Object 

In addition, it supports three operations to export data from a site project: 

• Visualization to DGN (Contours, Triangles, etc) 
• Model / Object (Creates DAT & TIN Files) 
• To COGO (Creates Points in the COGO Database) 
• Export to COGO Profile (Creates a Profile in COGO) 

To exit GEOPAK Site, the designer may utilize the File > Exit tool on the Project pull down. When 
exiting, GEOPAK Site Modeler prompts for saving the current project. 

PROJECT PREFERENCES 

GEOPAK Site Modeler supports a wide array of user defined Preferences which enables the designer 
to set project specific options, or a larger organization to set parameters to maintain standards.  Each 
GEOPAK Site project contains a set of Preferences and they remain with the project. 
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The general 
groupings of 
Options are 
displayed in a 
list box in the 
left side of the 
dialog, while 
the right side 
displays 
parameters for 
the highlighted 
Option.  As different options are selected in the list box, the right side of the dialog changes 
dynamically to reflect the parameters for highlighted Option. 

These Options and very brief descriptions are detailed below. 

Tolerances Tolerance and stroking options used in the creation of Site Elements. 

Visualization Variety of element symbology and display options 

Updating Toggle for automatic updating 

Objects Standard List of Object Types and default values for Object parameters 

Save Automatic saving and backup options 

On the right side of the dialog, the OK and Cancel buttons commence closing the dialog and storing 
the preferences, if required. 

TOLERANCES 

 
 

Linear Stroking The Linear Stroking option densifies portions of linear elements and is 
utilized to interpolate new spots from the linear elements. 

Curve Stroking The Curve Stroking feature densifies the curved portions of the break 
lines.  Curved break lines in GEOPAK are handled by segmenting the 
curve into small chord segments.  The length of the chord segments can 
be determined by setting the Curve Stroking. 

Maximum Triangle 
Length 

External triangles whose external edge is longer in length than the 
Maximum Triangle Length user specified distance are dissolved. 
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Elevation Decimal The Elevation Decimal controls the number of decimal places displayed 
on the elevation labels for points within the objects and models. 

Note Stroking is the process of automatically inserting points along Site Elements by interpolating 
new points from the linear and curved sections of the data. 

VISUALIZATION 

A variety of 
user-defined 
parameters are 
supported, to 
provide the 
designer with 
maximum 
flexibility in 
Visualization.  
These 
parameters are 
briefly detailed below. 

View Active Object When activated, the current object listed in the Active Site Object Control 
dialog is displayed. This object will maintain the display settings during 
view updates and changes. All visualization settings are derived from the 
definition of the specific object that is active. 

View Active Model When activated, the current model listed in the Active Site Object Control 
dialog is displayed.  This model will maintain the display settings during 
view updates and changes.  All visualization settings are derived from the 
definition of the specific model that is active.  If the mode is inactive, no 
models are displayed as depicted in the example below, where only the 
MicroStation elements are displayed. 

Smooth Contours When active, an algorithm is employed to smooth contours. 

Construction Elements The element symbology for Site Elements created in the modeler that is 
not contained in a Site Object.  It may be desirable to establish Site 
Elements and their elevations purely as a reference or to construct other 
elements. These Site Elements are not needed in the Site Objects 
themselves and are considered Construction Elements.  Site Elements 
contained in Site Objects are displayed according to the object 
visualization of the object to which they belong.  The Construction 
Elements are displayed using these settings in the preferences. 

MODEL VISUALIZATION 

When the Model Visualization button is pressed, the dialog below is invoked. 
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The Visualization tab contains specifications for all features that are available for display in Site 
Models including triangles, boundaries, and vertices.  These settings will be applied to all models 
created subsequent to setting these.  All symbology controls, the sample line and text graphics in this 
case, can be set by double clicking the sample and using the Set Feature dialog shown below. 

 

Additional options can be invoked by clicking the right mouse button over these sample controls. 

 

OBJECTS 

When the Objects option is selected, the dialog changes as reflected below.  This option is utilized for 
creation, deletion, and manipulation of the library of objects.  The information includes both the Object 
Type and Naming Prefix. 
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This list box displays all Object Types within the active project.  Default types which are initially 
displayed include:  Parking, Building, Pond, Roadway, Lot, etc.  These Object Types assist in 
organizing and categorizing design features, controlling standard symbology, and establishing defaults 
for Objects created. 

The portion of the dialog titled Object Details allows you to set Visualization of the highlighted Object 
Type.  Each Object Type may have its own settings, providing maximum flexibility for you to display 
only specified parameters for the particular Object Type.  Note its similarity to the Default Model 
Visualization dialog. 

When an Object Type is highlighted and the Object Details is set to Default Slopes, the dialog depicted 
below is displayed. 

 

As new Objects of a particular type are created they will obtain the default settings.  Note that an 
Object slopes can be modified at any time, these defaults are applied when the object is created and 
remain in effect until the slopes are modified while editing the Object.  Slopes are applied around the 
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boundary of the entire object and are generated as the intersection from the Object boundary to the 
Model.  Three Default Side Slope options are supported: 

• No Slopes 
• Cut - Fill Slope 
• Cut-Fill Table 

Corner Options can be specified to generate either Rounded or Straight slopes around corners of 
Objects and can be projected Radial or Planar.  Supported options for Cut and Fill specifications are: 

• Slope run:rise 
• Slope rise:run 
• Slope % 
• Slope Unit / Unit (ft. / ft. or meter/meter) 

Simply specify the desired slope. 

UPDATING 

The Updating dialog is depicted below. 

 

When the Auto Update Model is active, the model is updated whenever a change is made to an 
element, object, or the FIFO of the Active model.  As Models get larger, it may not be necessary to 
update the Model on every single edit.  Deactivating this speeds up the modifications that are being 
performed, but must either be activated or the Model itself processed to view any changes incurred. 

Element Association refers to the relationship elements maintain with the original method by which 
they were defined.  Elements defined by other elements / object / models can always maintain the same 
dependency on the items referenced in their creation. 

When activated (On), it enables the associations.  All subsequent element modifications that occur to 
the dependent elements or referenced identity utilize the original association when computing the 
impact of the modifications.  Clearing the toggle (OFF) disables the associations. 

SAVE 

The Save dialog is depicted below. 
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When the Automatic Backup option is activated, a backup file is always created (in the project 
directory with a *.bak extension) when the project is opened. 

The Automatic Save Option saves the GEOPAK Site project file (.GSF) to the disk at the user 
specified interval.  Automatic Save intervals include 1, 2, 5, 10, & 30 minutes. 

MODEL MENU 

The Model menu selections provide the 
mechanism to add, edit and delete the various 
elements which comprise a Model, including 
Display parameters, merging order (FIFO), and 
Display options.  Each of these tools invokes a dialog wherein the specific model information can be 
added or edited, or entire models deleted. 

EDIT MODEL 

The Model editing options provide the mechanism to change the list of Objects contained in the model 
and modify the display setting of the model and its objects. When invoked, the dialog depicted below 
is displayed. 

FIFO FUNCTIONALITY 

The FIFO, or "First in First out," contains the list of all the Site Objects contained in the model and the 
order in which the Objects are to be merged. This Object list is processed from the top to bottom, 
starting with the Base Object any time a change is made to a Site Object or Site Element contained in 
the Model. The Site Preferences contain an option to disable this automatic updating should this 
immediate feedback be unnecessary or grow time consuming as the model grows. Since Objects can 
easily be added and removed from the FIFO list, certain time savings can be achieved by removing 
Objects not needed for the current design process and can be added back at the end or at such time as 
their impact is needed. 

The process used in the creation of the final triangulated Site Model is as follows: 

• The Base Object starts as the initial state of the Model. 
• The first Object in the FIFO list is retrieved. 
• The boundary of the Site Object is determined from the extent of all the Site Elements contained 

in it. 
• The Side slopes associated with that Object are applied around the boundary down or up to the 

Model depending on the cut fill situation. 
• This Object is then merged into the Model. 
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• This new state of the Model with the first Object and its side slopes merged into the base Object 

becomes the initial sate of the model for the next Object in the FIFO list and the process is 
repeated for all the objects in the list. 

DISPLAY MODEL TAB 

The Display Model Tab is utilized to control the visualization settings of the entire model.  The dialog 
is depicted below and contains specifications for features displayed within the Modeler including 
triangles, boundaries, and vertices.  When the toggle to the left of the feature is active, the element is 
displayed.  When inactive, it is not drawn.  To the right of each feature is the level and element 
symbology. 

 

DISPLAY OBJECTS TAB 

When the Display Objects Tab is selected, the dialog depicted below is displayed. 

 

Object Type List box containing all current Object Types in the current model.  If the 
eye icon is displayed to the left of the Object Type, then all objects of the 
specified type are displayed with their visualization settings. 

Clip Objects from When activated, this clips every object out of the model prior to display.  
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Model It is good for showing proposed vs. existing. 

Display Base Object This toggle indicates whether the Base Object should be displayed with 
its visualization settings. 

Apply Commences the display procedure, which reacts to any display changes 
made. 

OBJECTS MENU 

The Object menu selections provide tools 
to Add, Edit, Copy, Move, Raise, Lower, 
or Delete an Object. 

EDIT OBJECT 

The object editing options 
provide the mechanism to 
modify an Object's properties, 
side slopes, and display 
settings. 

 

 

 

OBJECT PROPERTIES 

Under the Properties Tab (shown above) the Object Name for the object to be edited is displayed in the 
dialog.  A description can be entered if desired.  Quantity Depth is the vertical depth beneath an Object 
where the earthwork volume is adjusted to compensate in the total volume.  Note that this depth is 
applied to the limits of the Object's elements and is optional when Volumes are computed. 

OBJECT ELEMENTS TAB 

Three tools are supported within 
the Elements group box.  
Highlight and/or window center 
Site elements within the Active 
Site Object.  Add previously 
created Site Elements to the 
Active Site Object and Remove 
Site Elements from the Active 
Site Object. 
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OBJECT SLOPES TAB 

The Slopes options dictate the type of side slopes generated from the outer extent or boundary edge of 
the Object.  These slopes are applied when the Object is placed into a Model and computed from the 
Object to whatever the state of the Model when it is merged.  When the Display with Object toggle is 
activated, GEOPAK includes the display of slopes in the Object symbology. 

 

There are four slopes options available:  No Slopes, Cut - Fill Slope, Cut-Fill Table, and Dynamic 
Slopes.  Corner Options can be specified to generate either Rounded or Straight slopes around corners 
of Objects. 

DISPLAY OPTIONS TAB 

The Edit Object Display Tab is utilized to control the visualization settings of the Active Object 
displayed in the dialog.  The dialog is depicted below and contains specifications for features displayed 
within the Modeler including triangles, boundaries, and vertices.  When the toggle to the left of the 
feature is active, the element is displayed.  When inactive, it is not drawn.  To the right of each feature 
is the level and element symbology. 

 

SLOPE INDICATORS TAB 

The Slope Indicators Tab is used to set the display preferences of Object Slopes Indicators. 
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COPY OBJECT 

The copy tool is useful when the object is comprised of numerous elements which need to be copied. 

To copy an object, simply key in the Elev Diff (0 if 
there is none), then press the Start Move / Copy 
button and identify the object to be copied.  A 
second data point defines the revised location. 

 

 

Note When the Make Copy toggle is not activated, the dialog dynamically changes to a Move 
Object dialog. 

MOVE OBJECT 

To move an object, simply key in the Elev Diff (0 if 
there is none), then press the Start Move / Copy button 
and identify the object to be moved.  A second data 
point defines the revised location. 

 

RAISE/LOWER OBJECT 

Raise/Lower Object tool can be used to change the 
elevation of an entire object by raising or lowering it.  
Note the value is in terms of master units, i.e., feet or 
meters. 

 

DELETE OBJECT 

The Delete Object tool deletes the entire object from 
the project file and (if desired) all the Site elements 
that are part of the Object. 

 

ELEMENTS MENU 

The fundamental components in the GEOPAK Site Modeler, Site Elements are simply MicroStation 
graphics (2D or 3D) that have been assigned elevations using one of these Site Element tools. 

GEOPAK Site Modeler supports a wide variety of tools that when combined with generic 
MicroStation commands create and modify elements. These operations include: 

• Creating / editing elements 
• Changing element feature types 
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• Change Element Associations 
• Raising/Lowering of elements 
• Copy parallel existing elements 
• Modifying elements 
• Deleting element Z 
• 3D elements 
• Composite Sections 
• Edit Profile 
• Obtaining and modifying element information 

The 3D Element is active only within MicroStation 3D design files. 

ELEMENT FEATURE TYPES 

All Site Elements require a Feature Type to describe the way in which to process and interpret the 
features within the terrain model. 

A Boundary is used to constrain the external boundary of the object or model.  For example, an L-
shaped building can be defined as a boundary, so that no triangles are created within the internal 
corner.  If no boundary elements exist within an object, the limits of the object would result from the 
convex area of all the elements contained in the object. 

      

Feature types can be modified at any point in the design to create the desired results.  It is often 
desirable to leave features as break lines until the object design is near completion and then the desired 
elements can be specified as boundaries. 

Break Lines designate linear features such as edges of buildings, parking lots, and other pavement.  
The generated triangles never cross a break line, rather the edges of the triangles are coincident with a 
break line. 

A Contour is an element of constant elevation.  Triangles can intersect and / or cross over contours. 

A Void delineates an area of no data or obscured area and is defined in a series of points forming a 
closed element. 

A Hole is extremely useful when the base object surface (i.e., existing ground) is desired within an 
object.  For example, an area of existing within a building footprint is to be landscaped and remain at 
the original ground elevation, while surrounded by a building pad. 
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SELECTION SETS 

Many of the Element tools utilize selection sets, therefore, a generic discussion is warranted into the 
operation and use of selection sets.  Two options are supported: the MicroStation Power Selector or 
GEOPAK selection tools within each dialog. 

 

USE POWER SELECTOR 

When active, the MicroStation Power 
Selector (as depicted below) is 
utilized.  To invoke, press the Select 
Elements button in the Element 
Selection group box. 

GEOPAK SELECTION TOOLS 

Selection commands can be utilized 
without the Power Selector.  The 
leftmost button is Select Elements.  
Simply press the button, then select the 
desired elements.  To select multiple 
elements, depress the <Control> button 
on the keyboard while selecting.  To view the highlighted elements, rather than the "handles," a change 
in the preferences is needed.  To change, select the MicroStation Workspace > Preferences.  Then 
select Input and activate the option Highlight Selected Elements. 

After utilizing numerous MicroStation commands, the highlighted elements may not be highlighted.  
To display previously selected elements, press the Reselect Elements button (center of the three) and 
the highlighted elements are displayed again in the specified color.  To remove all selected elements 
from the selection set, press the Reset Selection Set button (rightmost of the three).  The color of the 
selected elements is set with the color picker on the far right side of the group box.  Note that Element 
Selection must be invoked through these selection icons.  While the Site Modeler uses a selection set, 
it must be started through the use of these commands not the MicroStation Selection set commands. 

NEW/EDIT SITE ELEMENTS 

One of the primary tools within Elements is the New / Edit Elements tool.  When invoked, the dialog 
depicted below is displayed. 
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The dialog contains five main options:  Element, Point, Section, Side Slope and Display.  When a tab 
is selected, the dialog dynamically changes to reflect the selection.  The fields below are displayed 
regardless of which tab is selected. 

Add to Active Object When toggled, created and/or edited elements are automatically added to 
the active object. Refer to the Active Object Control toolbar for the 
current active object. 

Current Object Located between the Add to Active Object and the Apply button, the 
active Object can be selected. 

Apply Commences the processing.  This includes redrawing of the elements, 
inclusion into the active object, and if the active object is part of a model, 
reprocessing of the model. 

 

ELEMENT TAB OPTIONS 

The element options provide for the primary mechanism for the creation and redefinition of Site 
Elements.  When the Element option is selected, the dialog depicted below is displayed. 

 
 

Six tools to assign or modify elevations are provided.  As each option is selected, the title bar as well 
as the left side of the dialog dynamically changes to reflect the selection.  These options include: 
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Slope/Offset 
from Site 
Elements 

The Slope/Offset from Site Element option is used for assigning 
elevation to Site Elements by placing the elements at an optional slope 
and offset height from existing Site Elements. In calculating the elevation 
from the existing Site Element, a projection is performed from the new 
Site Elements to the reference based on the minimum distance from the 
element to the existing reference element. 

 

Radial From 
Existing Points 

The Radial From Existing Point option is useful for establishing the 
elevation of elements relative to points within another model or object. 
The tool uses a reference data point elevation and an optional slope and 
offset height to compute the elevation for the new element vertices. 

 

Along Element 
From Existing 
Point 

The Along Element from Existing Point tool assigns the elevations along 
an element at a constant slope and/or offset height from a data point.  The 
data point will be projected to the element and the distance along the 
element from this point to the vertices will be used in conjunction with 
the slope and offset height to compute the elevation of the new element 
vertices. 

 

Drape on 
Model / Object 

The Drape on Model/Object tool is used to establish the elevation of Site 
Elements relative to the elevations contained in a model or object. It is 
useful to set the elevation of elements relative to existing ground or other 
object. 

 

Constant 
Elevation 

Placing elements at a constant elevation may be utilized when the desired 
elevation of an element is known. It can be used to set the elevation of a 
building or even place a contour into an object.  If the computed contours 
within an Object do not exactly match the desired results, simply draw 
the contour wanted and then place in the Object as a Contour Feature at a 
constant elevation. 

 

Alignment The alignment tool is used to create Site Elements from a GEOPAK 
horizontal and vertical alignment.  The alignments must have previously 
been created using one of the GEOPAK Coordinate Geometry features or 
the Horizontal and Vertical Alignment Generators.  Once a Site Element 
is created from an alignment, the curbs, edges of pavement, etc., can be 
created using one of the other Site Element Creation tools.  Typically this 
would be the Slope/Offset from Site Element. 

 

POINT TAB OPTIONS 

When the Point Tab is selected within the New/Edit Site Element dialog, the dialog changes as 
displayed below. 
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Point elements can be created and added to Objects to refine the surfaces or edit the vertices of existing 
Site Elements.  When placing points, the Site Modeler can detect when an existing Site Element is 
snapped to and rather than placing a new point in the Object, the snapped vertex will be changed to the 
new elevation defined in the Point options. This provides for "pull and tug" editing of Site Elements on 
a vertex by vertex basis.  If no existing Site Element is detected, a MS point graphic element will be 
added to the design file and the Object. 

If a point is snapped to a Site Element, but not to a natural vertex of the graphic element, the Site 
Modeler will actually insert the point along the Site element. This point is now considered dependent 
on the site Element and as the element is modified or moved, so will the point. 

Five options are supported within the Point tab. 

 

As each option is selected, the title bar as well as the left side of the dialog dynamically changes to 
reflect the selection.  These options include: 

 
Constant 
Elevation 

Used to add a point or edit a vertex of an existing Site element at a 
constant elevation. 

 
Drape Point on 
Model / Object 

The Drape on Model / Object option is useful for placing or editing 
points and placing them at an elevation relative to the elevation in a 
Model or Object. 

 
Slope from Site 
Element 

The Slope from Site Element option is used for placing points at a 
given slope from a Site Element. 

 
Min. / Max. 
Elevation at Slope 
From Elements 

The Min. / Max Elevation at Slope from Elements option is used for 
placing points at the minimum or maximum elevation computed 
from a set of Site Elements.  It can be used to insure a low point or 
high point amongst elements. 

 
Slope from Point 
to New Point 

The Slope from Point to New Point option is used to create a point at 
a given slope to an existing point in an object or model. 
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SECTION TAB OPTION 

Sections are special Site Elements that are created and attached to existing Site Elements that define a 
constant vertical and horizontal offset from the existing element(s).  It can be used to attach curb and 
gutter sections to the edge of pavement, retaining walls or benching sections. 

Section Elements is 
another feature where the 
MS graphics are actually 
created by the Site Modeler 
in the active MS 
symbology. Section 
elements cannot be directly 
edited, they are locked and 
connected to the elements 
on which they are placed.  
As the Site Elements 
containing the section are 
modified, moved, deleted, 
or elevations reassigned, the Section Elements are automatically updated accordingly. 

Provisions for assigning sections to multiple Site Elements at once, even disconnected Site Elements, 
are available.  This capability is provided by gathering all the Site Elements selected for section 
placement and assigning the Direction or which side to place the section element.  The Site Modeler 
may not be able to logically determine a direction given very complex sets of Site Elements.  Suitable 
messages are provided in this case and a smaller selection set of Site Elements should be used. 

CREATING SECTIONS 

The following is the procedure for creating Section Elements. 

• Select the Reference Elements to place the section along. It is recommended that the Power 
Selector be used in Single element select mode. If the elements are chosen in an order which 
would easily accommodate chaining the elements together the resulting sections will be 
simplified. 

• Determine if a cell or table of horizontal and vertical offset is desired and fill tables. 
• Set the Direction – this will indicate the side of all the elements for which to place the Section 

Elements. 
• The Site Modeler attempts to chain all the elements together and then determine the side based on 

a single data point.  If the element selection does not easily facilitate this process, it may be 
necessary to hit any key and reselect a smaller set of elements. 

• Once the site modeler has chained the elements together, a dynamic display will indicate which 
direction would correspond to positive offsets. 

• Set the Feature type and press Apply. 
• The Section Elements are created and added to all the Objects that contain the Site Elements for 

which they were placed. 

MANIPULATING SECTIONS 

The Manipulate Section has three tools, as detailed in the table below. 

11-20 © 2007 VDOT VDOT GEOPAK Drainage  



Site Modeler Main Menu 

 

 

Reverse Section This button flips all sections currently selected to the other side of 
the Site Elements that they are attached. 

 

Remove Section This button removes the sections from the selected Site Elements. 
Since Section Elements are locked, this is the only way to remove 
them from graphics. 

 
Query Section This button queries a Site Element and populates the offset table 

with the values from the Site Element. 

 

DISPLAY TAB OPTIONS 

When the Display Tab is selected, the dialog depicted below is displayed. 

 

Element symbology is supported in this dialog for the following elements: 

• All Elements 
• Active Model Elements 
• Active Object Elements 
• Construction Elements 

Activate the desired elements option.  Options are also supported for: 

• Selected Elements Only 
• Temporary Elements Only 

Both of these toggles may be active simultaneously.  The Reset Display button redisplays the Elements 
within the selected group in the desired symbology. 

CHANGE SITE ELEMENT FEATURE &  ASSOCIATIONS 

These two element tools can be used to change the feature type of a previously defined site element or 
group of site elements as well a turn on or off the site element associations. 

The dialogs below will appear when their respective tool is selected. 
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RAISE/LOWER SITE ELEMENTS 

This tool is utilized to change the elevation(s) of an existing element. 

 

MODIFY SITE ELEMENTS 

A variety of tools are supported to modify existing site elements. 

The tools (from left to right) are: 

• Site Element Extend Line 
• Site Element Extend Arc 
• Site Element Extend to Intersect 
• Site Elements Extend Both to Intersect 
• Site Elements Fillet 
• Site Elements Chamfer 

All tools function identically to their generic MicroStation counterparts, except the Extend to Intersect 
and Extend Both To Intersect.  These two commands have elevation options to be considered.  The 
Modify Element Tools are only available within a 2D MicroStation Design File. 

DELETE SITE ELEMENTS 

This tool is used to delete a Site element that is 
associated with a MicroStation Element. 
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3D ELEMENT 

Elements placed at the correct X, Y, and Z 
coordinates within a MicroStation 3D design 
file can be utilized within this dialog.  When 
invoked, the dialog depicted below is 
displayed. 

 

 

SITE ELEMENT INFORMATION 

The Information Tool can be used to 
display coordinate information, 
Feature type, stroking information and 
Member Objects and Site Element 
Association information.  Most 
importantly however, the Information 
Tools can be used to quickly change 
element information when needed.  
The dialog below shows one option of 
the Information Tool.  Each vertices of 
the Site element can be modified to 
achieve the desired result. 

COMPOSITE SECTION TOOL 

The Composite Section Tool is used to create multiple Site Elements which will be grouped into a Site 
Object.  This tool can be useful for creating Roadways, Channels, Levees, etc. 
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ACTIVE SITE OBJECT CONTROL TOOLBAR 

Upon opening an existing GEOPAK Site Project or creation of a new project, the Active Site Object 
Toolbar is displayed as shown below. 

 

The toolbar is resizable, can be docked and remains open throughout the entire Site Modeler session. 

Display View When the toggle to the left of Display View is activated, the Active 
Model and/or Active Object are displayed, based on their respective 
visualization settings. 

Model The active model is displayed.  Selection of any other model from the list 
changes the active model.  When the model is selected, all Objects which 
belong to the model are listed in the Object listing to the right.  When 
<All Objects> is selected, all objects in the project are listed.  When 
<Orphan Objects> is selected, all objects which currently do not belong to 
a model are listed. 

Object The Object list changes dynamically based on the Model selection. 

ID? 

 

Pressing the ID button and then identifying any Site Modeler object 
highlights the selected element and invokes the Select Object dialog 
depicted below. 

Center Window On 
Object 

 

After setting the Object list to the desired Object, then pressing the 
Window Center on Object button, the Site Modeler window centers (and 
fits the object) to the Display View. 

 

MAIN TOOLBAR 

The Tools menu selections provide access to all Tool Boxes.  The Main 
Tools tool frame is depicted below and accesses the other tool boxes. 

Each icon in the tool frame (except single tools) is a tool box that one can 
"tear off" to become a "tool box."  The individual tool boxes (except those 
which have single tools) can be docked and resized.  There are seven tool 
boxes, with the following titles (order down first column, then down 
second column): 

• Project tools 
• Object tools 
• Composite Section 
• Exit 
• Elements tools 
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• Model tools 
• Analysis tools 

If the function of an icon is not apparent to the user, position the cursor on the icon.  A detailed 
description is displayed in the status bar and a tool tip (flyover) appears. 

The Network computations serve as the final calculation process in the design or analysis of a storm 
drain system.  Drainage Areas and Inlets may be computed individually and are not dependent on any 
type of Network topology.  Pipes and Ditches, however, are dependent on the connectivity and 
Network characteristic and therefore, require a Network be defined and successfully built, in order to 
complete the hydraulic computations on these features. 

Several options are supported to add, edit, and delete Networks and are invoked via the Network pull 
down on the main menu bar as depicted below. Alternately, the Network tools are invoked by selecting 
Tools > Tool Boxes > Network, then identifying the desired tool from the tool box. 

 

Seven tools are supported in the Network tool box (from left to right). 

Tools Description 

Add Initially utilized to define the Network and associated data.  When 
invoked, the Network Configuration dialog is blank. 

Edit Utilized to edit any previously defined Network.  When selected, the 
Select Network dialog is invoked, wherein the desired Network is 
highlighted. Note the Network Edit dialog is identical to the Network Add 
dialog, however all associated data is displayed. 

Delete Utilized to delete the specified Network and associated data. 

Rename Utilized to rename any previously defined Network. 

Design This mode enables when an Active Network is defined. It's a shortcut to 
the Design procedure without having to invoke the Network dialog. 

Analyze This mode enables when an active network is defined.  It's a shortcut to 
the Analyze procedure without having to invoke the Network dialog. 

Set Active Network GEOPAK Drainage uses an Active Network as a shortcut and 
organization tool. Many of the reporting, query, and navigation tools 
support the use of the Active Network to limit the information viewed to 
the system currently under design (the Active Network). When selected, 
the Active Network dialog is invoked, wherein a previously defined 
Network may be specified as active. The current Active Network is 
displayed on the main menu bar for quick reference. 

 

VDOT GEOPAK Drainage © 2007 VDOT 11-25 



Lab Exercise: Pond Design 

 
LAB EXERCISE: POND DESIGN 

> Creating a Site Modeler Project 

1. Execute c:\data\geo\VDOT\drain1\LAB11_V8ad.EXE 

2. Open the MicroStation file, c:\ data\geo\VDOT\drain1\h17682.dgn. 

3. Access the Project Wizard. (Applications > GEOPAK Site > Site Modeler > Site Modeling)  

4. Select the Create New Project button and then press the Next> button to continue.  

 

5. The Project Wizard dialog will appear filled out as shown. Click the Next> button to 
continue. 

 

> Defining the Project Preferences 

1. Create a new Model: h17682-pond. 

 

2. Click Set Project Preferences, and populate the dialog as shown below. 

 

3. Select the Visualization item and toggle on the View Active Object and View Active Model. 

11-26 © 2007 VDOT VDOT GEOPAK Drainage  



Lab Exercise: Pond Design 

 

 

4. Click the Model Visualization button in the lower right corner of the Site Preferences 
dialog.  The Edit Object Visualization dialog will appear. 

 

5. Click Apply to return to the Site Preferences dialog. 

6. Select the Updating option as shown below. 

 

7. Select the Save option and set the Automatic Save to 30 minutes. 

 

8. Click OK. 
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> Completing Project Setup 

1. Click Next>. 

 

2. Toggle On the Open Object Import Wizard and click OK. 

 

3. Select Tin File in the Import Data Wizard, and Browse for the survey.tin file located in 
c:\data\geo\VDOT\drain1 

 

4. Click Next> and select the Existing Ground object type. 

 

5. Click Next> and setup the dialog as shown and click OK. 
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> Creating the Pond 

1. Access the Pond Design tool. (MS Menu: Modeler > Tools > Pond Design) 

 

2. Click Next>. 

 

3. Click New and create a new object Pond1. Click OK when done. 
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4. Setup the dialog as shown below. 

 

5. Click Next>. 

6. Setup the pond bottom at a constant elevation. 

 

7. Select the MicroStation element representing the pond bottom. 

 

8. Click Next>. Then, setup the Pond Side Slopes, Berm and Side Slopes as shown in the dialog 
below. 
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9. Click Finish to build the pond. 

Note The pond bottom could be modified using MicroStation commands like: move, modify and 
scale. This will recompute new elevations and adjust the slopes based on the original pond 
configuration. 

> Computing the Pond Volume 

1. Access the GEOPAK Volume Calculations tool. (MS Menu > Modeler > Analysis > 
Volumes). 

 

2. Click the Range button. 

 

3. Set the Volume Elevation Range as shown below. 
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4. Click the Process button on the Volumes Calculation dialog. 

 

5. The following report is generated. 

 
6. Close the Volume Calculations dialog when done. 
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LAB EXERCISE : POND VISUALIZATION FOR PLANS 

Adjusting the Existing Ground Level Symbology 

1. Select the Edit Object Display tool. (MS Menu: Modeler > Object > Edit) 

2. Select the Object Name : Exist Ground 1 

3. Click on the Display tab. 

 
4. Toggle ON the Major Contour option and setup the symbology as shown below. 

 
5. Toggle ON the Label option and setup the text parameters as shown below. 

 
6. Setup the Elev. Interval and Label Interval spacing as shown below. 
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7. Click Apply when done. The Exist Ground 1 symbology in the dgn file will update. 

8. Close the Edit Object dialog when done. 

 

Setting Up the Model Display 

1. Select the Edit Model  tool. (MS Menu: Modeler > Model > Edit) 

2. Click on the Display Model tab. 

 
3. Toggle ON the Major Contour option and setup the symbology as shown below. 
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4. Toggle ON the Label option and setup the text parameters as shown below. 

 
5. Setup the Elev. Interval and Label Interval spacing as shown below.  

 
 

6. Select the Display Objects tab and setup the dialog as shown below. 

 
7. Click Apply when done. The Model display will update. 

8. Close the dialog when done. 
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Writing the Model Display to DGN 

1. Select the Object: Exist Ground 1 in the Active Site Object Control dialog as shown below. 

 
 

2. Select the Export Visualization to DGN tool. (MS Menu: Modeler > Project > Export > 
Visualization to DGN). 

3. Setup the dialog as shown below. 

 
4. Click Apply. 

5. Click OK to the Alert message. The pond contours will be written into the dgn file. 

 
6. In the same Export Visualization to DGN dialog, select Object and select Exist Ground 1 

 
7. Click Apply. 

8. Click OK to the Alert message. The existing ground contours will be written into the dgn file. 
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9. Toggle OFF the Display View option in the Active Site Object Control. We can verify that the 

final contours were written into the dgn file. 

 
10. Save the Site project. (MS Menu: Modeler>Project>Save). 

 

LAB EXERCISE: CHANNEL DESIGN 
Creating the Channel Object 

1. Toggle ON the Display View option in the Active Site Object Control.  

 
2. Access the Channel Design tool. (MS Menu: Modeler > Tools > Channel Design) 

 
3. Click Next> 
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4. Click New and create a new object: Channel 1 

 
5. Click OK when done. 

 
6. Click Next> and setup the dialog as shown below. We will use the alignment and profile 

created in a previous chapter. 

 
7. Click Next> and setup the dialog as shown below. 
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8. Click Finish to build the channel. 

 

Reviewing the Channel Section 

1. Access the profile tool. (Modeler > Analysis > Profiles). 

2. Setup the dialog as shown below. 

 
3. Select the Profile tab. 

4. Click on the Place Element button and draw a MicroStation line across the channel section. 
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5. Reviewing the section, we can see that the ditch profile could be lowered to better follow the 

ground. 

 

Adjusting the Ditch Profile 

1. Open the Coordinate Geometry tool. (Applications > Geopak Road > Geometry > Coordinate 
Geometry). 

2. Setup the dialog as shown below and click OK when done. 

 
3. From the Coordinate Geometry tool, open the Offset Profile tool. (Coordinate Geometry > 

Element > Profile > Offset). 
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4. Setup the Offset Profile dialog as shown below. Click the Add icon when done. 

 
5. We will lower the Ditch profile 2 feet and create a new profile : Ditch2 

 
6. Click the Create Profile button. The new profile Ditch2 will be created and stored. 
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Updating the Channel Design with the New Profile 

1. Select the Element Information tool. (Modeler > Elements > Information). 

2. Click the Select Element icon and select the centerline of the ditch in the dgn file. 

 
3. Select the Associations tab and switch the Options to Reference Associations 

 
4. Change the Profile to Ditch2 and click Update when done. 

 
5. Click Yes on the Alert box in order to accept the changes. 
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Reviewing the New Channel Section 

1. Access the profile tool. (Modeler > Analysis > Profiles). 

2. Setup the dialog as shown below. 

 
3. Select the Profile tab. 

4. Click on the Select Element button and select the MicroStation line across the channel 
section. 

 
5. Click the Place Profile button to place the cross section of the channel in the design file. 

6. Save the Site project. (MS Menu:Modeler>Project>Save). 

7. Exit Modeler. (MS Menu: Modeler > Project > Exit). 
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LAB EXERCISE : POND ROUTING 

> Review GEOPAK Drainage Project Preferences 

1. Activate GEOPAK Drainage. (MS Menu > Applications > GEOPAK Drainage > Drainage) 

2. Open the drainage project: c:\data\geo\vdot\drain1\h17682.gdf. (Drainage > Project > Open) 

3. Select the Preferences tool (Drainage > Project > Preferences) 

4. Click Project Components. 

5. Activate the GEOPAK Site Project as shown below. 

 
6. Click OK to save the changes in the drainage project. 

 

> Create a Drainage Area for Routing 

1. Create a new drainage area for the routing calculation. (Drainage > Components > Area > 
Add) 
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2. Setup the drainage area dialog as shown below. 

 

3. Click the Compute TC button. Setup the dialog as shown below. 

 
4. Click the Compute button and then, Apply to return to the Drainage Area Definition dialog. 

5. Highlight Compute in the Drainage Area Definition dialog and press the Compute 
Discharge button. 
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Lab Exercise : Pond Routing 

 

 
6. Click Apply to store the drainage area into the h17682.gdf  project. 

7. Close the Drainage Area Definition dialog. 

 

> Create a Runoff Hydrograph 

1. Create a new routing ID: Route1. (Drainage > Components > Routing > Add). 

 

2. Select the Runoff icon (1st icon located in the top middle of the dialog) and highlight the 
Definition item in the Options list. Select Area1 as the Area ID. 

 

3. Keyin the storm Duration TC Factor = 1. 

4. Click the Select button and select the any cell, since it is just used as a graphical marker, a 
procedure will be executed in the dgn file. 
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Lab Exercise : Pond Routing 

 

 

5. Click OK to continue. 

6. Click the DP button and data point in MicroStation view window 1 in the area where the pond 
is located. This will place a cell that graphically represents the routing configuration in 
MicroStation. 

7. Select the Use Compute Discharge radio button in the Discharge option. 

 

8. Select the Computations list item in the Options list. 

9. Click the Compute button.  

 
10. Click Apply to accept the calculations. 
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Lab Exercise : Pond Routing 

 
> Create the Reservoir Routing 

1. Create a new routing ID: Route2. (Drainage > Components > Routing > Add). 

 

2. Select the Reservoir icon and highlight the Definition list item from the Options list. 

 

3. Select Route1 for the Inflow Runoff ID and set the Starting Water Surface Elevation at 
2005.00. 

 

4. Click the DP button and data point in MicroStation view window 1 in the area where the 
control structure is located. This will place a cell that graphically represents the second 
routing configuration in MicroStation. 

5. Select the Stage Storage list item from the Options list, and setup the dialog box as shown 
below. 
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Lab Exercise : Pond Routing 

 

 

6. Select the Stage Discharge list item from the Option list. Set the type, size, coef., and 
elevation options as shown. 

 

7. Select the Computations list item from the Options list.  

8. Type routing.txt as a filename in the Output group box. 

9. Click the Compute button to perform the routing calculations. 

 
10. Click Apply to store the routing configuration. 
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Lab Exercise : Flood Plain Determination 

 
11. Click View to review the calculations.  

12. Close the dialog when done. 

13. Exit MicroStation. 

 

LAB EXERCISE : FLOOD PLAIN DETERMINATION 
> Determining the Water Surface Elevation 

1. Execute c:\data\geo\vdot\drain1\LAB11_V8ad_Flood.EXE 

2. Open the MicroStation file, c:\data\geo\VDOT\drain1\Survey_river.dgn. 

3. Activate Hec-Ras from c:\ data\geo\vdot\drain1\hecras\ras.exe. 

 
4. Access the included Hec-Ras project: xsriver.prj located in the c:\data\geo\vdot\drain1 

 
5. The project contains the geometric and hydraulic information of the channel shown in the dgn 

file. 
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Lab Exercise : Flood Plain Determination 

 
6. The geometry and station information has been updated according to the channel 

configuration. (HEC_Ras: Edit > Geometric Data) 

  
 

7. Review the Steady Flow Data information (Hec-RAS: Edit>Steady Flow Data) 

 
8. Perform the Steady Flow Analysis in order to get the new water surface elevation. (Hec-RAS: 

Simulate>Steady Flow Analysis) 
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Lab Exercise : Flood Plain Determination 

 
9. Review the water elevation in the channel thru the cross section display. (Hec-RAS: 

View>Cross Section). 

 
 

> Creating a HEC-RAS Profile Table 

1. Create a profile table that will allow us to export the information needed. (Hec-RAS: 
View>Profile Table). 

 
2. Define a new table (Profile Output Table: Option > Define Table). 
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Lab Exercise : Flood Plain Determination 

 
3. Click on the Clear All Table Headings button. 

 
4. Add the following variables in each column: Center Station, Sta W.S. Lft, Sta W.S. Rgt 

and W.S. Elev. 

 
5. Click OK when done. 
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Lab Exercise : Flood Plain Determination 

 
6. Include the profile name in the newly created table. (Profile Output Table: Options > Include 

Profile Name in Table) 

 
7. Select all the elements in the profile by clicking the upper left corner of the table. 

 
8. Copy the elements to the clipboard. (File>Copy to Clipboard) 

 
9. Open a new Microsoft Excel file and name it: Flood_plain_table.xls 

10. Paste the contents of the clipboard into the spreadsheet. (Excel: Edit > Paste) 
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Lab Exercise : Flood Plain Determination 

 

 
11. Save the spreadsheet (Excel: File > Save) 

12. Exit Microsoft Excel. 

 

Creating a DTM Surface from the Profile Table 

1. In the MicroStation file: Survey_river.dgn, load the VDOT_FloodPlainDTM macro located in 
c:\data\geo\VDOT\drain1 . (MS Menu: Utilites > Macro > Project Manager) 

 
2. Highlight the VBA application and click on the Macros button. 
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Lab Exercise : Flood Plain Determination 

 

 
3. Execute the loaded macro by clicking on the Run button. 

 
4. Setup the Flood Plain DTM dialog as shown below and generate a Flood Plain DTM. This 

will create a GEOPAK TIN file at the floodplain level. 

 
5. Close the dialog when done. 
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Lab Exercise : Flood Plain Determination 

 
Plotting the Flood Plain Encroachment Limits in the Channel 

1. Select the DTM Tools from GEOPAK Road. (MS Menu: Applications > GEOPAK Road > 
DTM Tools) 

 

2. Select the DTM Menu icon. 

 
3. Select the Elevation Differences dialog from the DTM Menu. (DTM > Analysis > Elevation 

Differences). 

4. We will need to find where the floodplain dtm (flood_plain.tin) intersects at the same 
elevation into the existing ground dtm (creek.tin). Setup the dialog as shown below. 

 
5. Click Process. 

6. A series of lines will be plotted delineating the flood elevation as it is encroaches into the 
existing dtm. 

7. Exit MicroStation. 
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This page left intentionally blank. 

 

 

11-58 © 2007 VDOT VDOT GEOPAK Drainage  



Technical Reference 

 
VDOT GEOPAK Drainage  © 2007 VDOT 12-1 

12 
 

OBJECTIVES 
• The objective of this chapter is to review the computation methods utilized by GEOPAK 

Drainage. 
 

THE RATIONAL METHOD 
The Rational method is the most widely used formula to calculate storm water runoff. VDOT 
recommends the use of that for pipe sizing, inlet capacity and spread computations. 

This method uses certain assumptions that make their use only suitable for areas of less than 200 acres.  

These assumptions are: 

• The entire drainage area contributes to the discharge 

• Rainfall intensity, measured in inches per hour, is distributed evenly in the whole drainage 
area. 

• Rainfall intensity is at a constant rate along the entire duration of the storm. The storm 
duration is at least equal to the time of concentration.  

• Frequency of the computed flow is of the same frequency as that of the rainfall intensity. A 5 
year rainfall intensity is set to produce a 5 year peak flow or discharge. 

• Coefficient of runoff is the same for all storms and probabilities of recurrence.  

The rational formula is given as: 

CIAQ =  

Q  =  computed peak discharge in cubic feet per second (cfs) 

C  =  runoff coefficient (non dimensional value) 

I    =  intensity of storm in inches/hr. 

A   = drainage area in acres 

The formula is not dimensionally correct as it is a result of empirical studies. 

Let’s analyze in detail each component of the formula. 



THE RATIONAL METHOD 
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RUNOFF COEFFICIENT (C)  

The runoff coefficient is a function of the ground cover and other hydrological abstractions.  

 

This is a dimensionless number that represents the fraction of rainfall that remains on the surface of the 
ground.  

The runoff coefficient relates the estimated peak discharge to a theoretical maximum of 100 percent of 
runoff.  

VDOT provides a table of runoff coefficients that depends on the slope of the terrain being analyzed 
and the use of it.  

In more practical terms we can summarize that for storm drain projects, we can divide our drainage 
area into pervious and impervious areas. 

We can conclude that a pervious area is the one with a c value equal or less than 0.5. A typical 
pervious area could be woodlands, grassy terrain or residential areas. Then we can also say that an 
impervious area is the one with a c value greater than 0.5. Pavement areas or heavy commercial and 
industrial lots are a good representation of this type of drainage area.  

Therefore, we can say that for storm drain projects the following assumption is valid: 

C = 0.95 for pavement areas 

C = 0.50 for grassy areas 

In a drainage area, multiple types of surfaces could be present with different runoff coefficients. Then, 
a weighted runoff coefficient should be determined. The weighting is based on the area of each land 
and is found by the following formula: 

C = 
∑
∑

A
CA

 

INTENSITY (I) 

Intensity is usually represented at the rate of rainfall in inches over an hour period. Intensity 
computations in GEOPAK Drainage are based on one of several options for defining the Intensity-
Duration-Frequency (IDF) relationship. 

The selection of the intensity over a drainage area depends of the frequency of the storm to be analyzed 
and their duration, than in general we equal to the time of concentration of the area.  

The intensity over a drainage area is calculated or extracted from widely develop I-D-F (intensity-
duration-frequency) curves. VDOT also provides mathematical functions for each of the curves so they 
can be implemented in computer programs. GEOPAK Drainage uses a four parameter intensity curve 
with the time of concentration in logarithmic format to represent the intensity rainfall in Virginia. 

32 )ln()ln()ln( tcdtcctcbaI +++=  

I  =   rainfall intensity for frequency (inch/hr) 
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n  =   time of concentration (min) 

a,b,c,d =   empirical factors which are input for each frequency. 

 

VDOT has also published I-D-F curves covering the State of Virginia for different frequencies under 
different rainfall zones. 

In order to find the intensity for drainage area, we have to do the following. 

1.- Localize our project inside one of the zones VDOT has divided the State. 

2.- Select the proper I-D-F curve according to the selected zone. 

3.- Enter the chart using the time of concentration as the storm duration and intersect the proper 
frequency curve. 

4.- At the point of intersection, read the rainfall intensity in inches per hour. 

TIME OF CONCENTRATION (TC) 

Time of concentration is defined as the time required for a drop of rainfall to travel from the most 
remote point of a watershed to the point of analysis. GEOPAK Drainage time of concentration 
calculations are derived from FHWA HEC-22. 

VDOT recommends a minimum time of concentration equal to 5 minutes despite a lower calculated 
time. 

To calculate time of concentration, we have to recognize the different types of flow that occur inside 
the drainage basin and along the flow path. These are sheet flow, shallow concentrated flow and open 
channel or pipe flow. For each type of flow a myriad of formulas could be used; each one of them 
using their own assumptions. FHWA in their “Urban Drainage Design Manual” cites the following 
formulae for each types of flow. 

Sheet Flow Travel Time: it is the starting type of flow in a drainage basin in which runoff has a 
uniform depth along a sloping surface. We can say that the limit is the first 400 ft. The formula is a 
version of the kinematic wave equation. 

6.0

4.0 ⎟
⎠

⎞
⎜
⎝

⎛
=

S
nL

I
KT u

sheet  

T  =   sheet flow travel time (minutes) 



THE RATIONAL METHOD 
 

12-4 © 2007 VDOT VDOT GEOPAK Drainage  

n  =   Manning’s roughness coefficient of the watershed. 

L  =   flow length (ft) 

I   =    rainfall intensity (inches/hr) 

S =    surface slope (ft/ft) 

Ku =   empirical coefficient equal to 0.933 

Manning's Roughness Coefficient (n) for Overland Sheet Flow 

Surface Description n 

Smooth Asphalt 0.011 

Smooth Concrete 0.012 

Ordinary concrete lining 0.013 

Good wood 0.014 

Brick with cement mortar 0.014 

Vitrified clay 0.015 

Cast iron 0.015 

Corrugated metal pipe 0.024 

Cement rubble surface 0.024 

Fallow (no residue) 0.05 

Cultivated soils: 

Residue cover < 20%  

Residue cover > 20%  

Range (natural)  

 

0.06 

0.17 

0.13 

Short grass prairie  

Dense grasses  

Bermuda grass  

0.15 

0.24 

0.41 

Woods (when selecting n, consider cover to a 
height of about 30 mm. This is the only part of the 
plant cover that will obstruct sheet flow.  

 
 
 



THE RATIONAL METHOD 
 

VDOT GEOPAK Drainage  © 2007 VDOT 12-5 

Light underbrush  

Dense underbrush  

0.40 

0.80 

 

This is an iterative process since the intensity depends on the time of concentration. Therefore, the 
assumed time of concentration must be the same as the calculated one in order to stop the iterative 
process. 

Shallow Concentrated Flow Travel Time: Up to a distance of 400 ft, sheet flow tends to 
concentrated in rills and then gullies of increasing proportions. First, we need to calculate the velocity 
in order to estimate the travel time. 

5.0kSKV u=  

V   = velocity (ft/s) 

Ku = coefficient of 3.28 

k    = intercept coefficient.  

S    = slope in percentage 

Intercept Coefficients for Velocity vs. Slope Relationship 

Land cover / Flow regime k 

Forest with heavy ground litter; hay meadow (overland 
flow) 

0.076 

Trash fallow or minimum tillage cultivation; contour or strip 
cropped; woodland (overland flow). 

0.152 

Short grass pasture (overland flow) 0.213 

Cultivated straight row (overland flow). 0.274 

Nearly bare and untilled (overland flow) alluvial fans in 
western mountain regions 

0.305 

Grassed waterway (shallow concentrated flow). 0.457 

Unpaved (shallow concentrated flow.) 0.491 

Paved area (shallow concentrated flow); small upland 
gullies 

0.619 

 

Open Channel and Pipe Flow Travel Time: It is the flow collected in channel and pipes. The 
Manning’s equation can be used to estimate the average flow velocities in pipes and open channels. 
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5.03/249.1 SR
n

V =
 

V  =   velocity (ft/s) 

n  =   Manning’s runoff coefficient 

R =    hydraulic radius (flow area divided by the wetted perimeter) 

S =    slope (ft/ft) 

Then the travel time could be calculated as: 

V
LTchannel 60

=  

 

Values of Manning Coefficient (n) for Channels and Pipes: 

Conduit Material Manning n 

Closed Conduits:  

Asbestos – cement pipe 0.011-0.015 

Brick 0.013-0.017 

Cast Iron pipe 

Cement-lined & seal coat  

 

0.011-0.015 

Concrete (monolithic) 0.012-0.014 

Corrugated-metal pipe (1/2 in x 2 ½ in corrugations) 

Plain  

Paved Invert  

Spun Asphalt Lined  

 

0.022-0.026 

0.018-0.022 

0.011-0.015 

Plastic pipe (smooth) 0.011-0.015 

Vitrified Clay: 

Pipes  

Liner Plates  

 

0.011-0.015 

0.013- 
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Open Channels  

Lined Channels: 

A. Asphalt 

B. Brick 

C. Concrete 

D. Rubble or riprap 

E. Vegetal 

 

0.013-0.017 

0.012-0.018 

0.011-0.020 

0.020-0.035 

0.030-0.40 

Excavated or dredged 

Earth, straight, and uniform  

Earth, winding, fairly uniform  

Rock  

Not maintained  

 

0.02-0.030 

0.025-0.040 

0.030-0.045 

0.050-0.14 

Natural channels (minor streams, top width at flood 
stage < 100 ft. 

Fairly regular section  

Irregular section with pools  

 

0.03-0.07 

0.04-0.10 

 

Then, the total time of concentration for a watershed will be: 

channelshallowsheetionconcentrat TTTT ++=  

 

STORM FREQUENCY 

Frequency can be defined as the return period of a specific storm or their exceedance probability.  

Exceedance probability is the probability that an event having a specific volume and duration will be 
exceeded in a specified time period. Return period is the average length of time between events having 
the same volume and duration.  

Be careful, saying that a storm has a 50 year frequency does not mean that it happens every 50 years. 
The probability of a storm happening is inversely proportional of the return period. This means that a 
50 year storm has a 2% probability of recurrence. 

VDOT recommends the following design frequencies depending of the type of project: 
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Type of Project Design Frequency 

General Design 3 year 

General design with ditch replacement 
and adding of side pipes. 

10 year 

General design work on interstates 10 year 

Interstate facilities which only outlet is 
a storm drain system and for the outlet 
of systems requiring pumping stations. 

50 year 
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INLET SPREAD COMPUTATIONS 
The spread or ponded width of runoff at an inlet location is a geometric function of the cross sectional 
geometry, longitudinal pavement/gutter slope and discharge. A direct solution is not possible for 
complex cross sections with multiple breaks in the transverse slope so an iterative procedure derived 
from HEC-22 is employed.  

 

CURB INLETS ON-GRADE 
The computation of on-grade curb opening inlets involves a determination spread or ponded width 
characteristics, computation of length required for total interception, and consideration of inlet 
efficiency. 

 

The hydraulics of Curb Inlets On Grade is derived from HEC-22. The applicable equations are as 
follows: 

The length of curb inlet required for total interception using Equation: 

 

where: 

Lr = length of curb inlet required (ft) 

Q = flowrate in gutter(cfs) 

S = longitudinal slope (ft/ft) 

n = Manning's roughness coefficient 

Se = equivalent cross slope (ft/ft) for non depressed inlets  

The equivalent cross slope (Se) for a depressed curb-opening inlet using Equation: 



CURB INLETS IN SAG CALCULATIONS 
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where: 

Se = equivalent cross slope (ft/ft) 

SX = cross slope of the road (ft/ft) 

a = gutter depression depth (ft) 

W = gutter depression width (ft) 

EO = ratio of depression flow to total flow 

The Ratio of depression flow to total flow is determined using the following equation:  

 

 where: 

EO = ratio of depression flow to total flow 

Inlet interception capacity is then defined by: 

 

where: 

Qi = intercepted discharge (cfs) 

Qt = total inlet discharge (cfs) 

Efficiency = inlet efficiency defined below 

 

where: 

Lr = length of curb inlet required for 100% interception (ft) 

L = length of curb inlet provided (ft) 

CURB INLETS IN SAG CALCULATIONS 
The capacity of a curb inlet in a sag depends on the water depth at the curb opening, and the height of 
the curb opening. 
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The inlet operates as a weir to depths equal to the curb opening height and transition to orifice flow on 
higher depths. In the transition the capacity is based on the lesser of the computed weir and orifice 
capacity. 

The head on the inlet is computed by adding the ponded depth (y) and the inlet depression (a) using the 
following Equation: 

h =  y + a 

where: 

h = head at inlet opening (ft) 

y = ponded depth in gutter (ft) 

a = inlet depression depth (ft) 

The capacity of the inlet when operating under weir conditions is calculated with the equation: 

 

where: 

Q = total flow reaching inlet (cfs) 

CW = weir coefficient = 2.3 

h = head at inlet opening (ft) 

L = length of curb inlet opening (ft) 

W = lateral width of inlet depression (ft) 

The equation for interception capacity of a curb opening operating as an orifice follows: 

 

where: 

Q = total flow reaching inlet (ft3/s) 

Co = orifice coefficient = 0.67 

h = depth of opening (ft) 

L = length of curb opening inlet (ft) 

g = acceleration due to gravity = 32.2 ft/s2 

do = effective head at the centroid of the orifice (ft) 
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GRATE INLETS ON-GRADE CALCULATIONS 
The capacity of a grate inlet on-grade depends on its geometry and the cross slope, longitudinal slope, 
total gutter flow, depth of flow, and pavement roughness. The design of a grate inlet on-grade involves 
an analysis of given grate dimensions to estimate the interception rate. The difference between the 
estimated interception rate and the total approach discharge equals the bypass rate. The following 
procedure is applicable to grate inlets on-grade: 

The Ratio of discharge over the grate (Frontal Flow) to flow to total flow is determined using the 
following equation:  

 

where: 

EO = ratio of flow over the grate to total flow 

The ratio of frontal flow intercepted to total frontal flow: 

 

where: 

Rf = ratio of frontal flow intercepted to total frontal flow 

V = approach velocity of flow in gutter (ft/s) 

Vo = minimum velocity that will cause splash over grate (ft/s) 

The splash over velocity is of the form of  

 

where: 

 Vo =  is splash over velocity 

 A = constant for different grate type 

 N = a power coefficient for different grate type 

 L = grate length 

 factor = 1 for English and .3048 for metric 
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Grate Type Coefficient A Coefficient N 

P-1-7/8 5.74872 0.5038679 

P-1-1/8 4.54822 0.5058875 

Curved Vane 3.92812 0.5954068 

45 Tilt Bar 3.35159 0.5926234 

30 Tilt Bar 2.67291 0.7567052 

P-1-7/8-4 3.01181 0.6454720 

Reticuline 2.48235 0.7659749 

The ratio of side flow intercepted to total side flow: 

 

where: 

 RS = ratio of side flow intercepted to total flow 

 z = inverse of transverse slope 

 V = approach velocity of flow in gutter (ft/s) 

 L = length of grate (ft) 

The efficiency of grate, Ef, using equation: 

 

The interception capacity of the grate, Qi, using equation: 

 

The bypass flow rate: 

 

 



GRATE INLETS IN SAG CALCULATIONS 
 

12-14 © 2007 VDOT VDOT GEOPAK Drainage  

GRATE INLETS IN SAG CALCULATIONS 
A grate inlet in sag configuration operates in weir flow at low ponding depths. The transition to orifice 
flow begins as the ponded depth increases. The procedure for calculating the inlet capacity is as 
follows: 

The capacity of a grate inlet operating as a weir is determined with the following equation: 

 

where: 

Qw = weir capacity of grate (cfs) 

Cw = weir coefficient = 3.087 

P = perimeter of the grate (ft)  

h = allowable head on grate (ft) 

PR = perimeter reduction factor to account for clogging  

Under orifice conditions, the grate area controls the capacity. The capacity of a grate inlet operating 
under orifice flow is computed equation: 

 

where: 

Qo = orifice capacity of grate (cfs) 

Co = orifice flow coefficient = 0.67 

A = clear opening area (ft2) of the grate (the total area available for flow) 

g = acceleration due to gravity (32.2 ft/s2) 

h = allowable head on grate (ft) 

AR = area reduction factor to account for clogging  

The capacity of a grated inlet in a sag is based on the minimum flow calculated from weir and orifice 
conditions. The figure below demonstrates the relationship between weir and orifice flow. If Qo is 
greater than Qw (to the left of the intersection in the figure), then the capacity would be that calculated 
with the weir equation. If, however, Qo is less than Qw (to the right of the intersection), then the 
capacity as determined with the orifice equation would be used. 
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LINK HYDRAULIC COMPUTATIONS 
Numerous algorithms are employed to perform the pipe and ditch hydraulic computations. The 
fundamental equations and terminology are presented here for reference purposes.  

The most widely used formula for determining the hydraulic characteristics of storm drain networks is 
the Manning Formula, expressed by the following equation: 

 

where: 

V = mean rate of flow (ft/s) 

R = the hydraulic radius (ft) 

S = the slope of hydraulic gradeline (ft/ft) 

n = Manning's roughness coefficient 

The hydraulic radius (R) is defined as follows: 

 

where: 

WP = wetted perimeter (ft) 

A = cross sectional area of flow (A2) 

To satisfy continuity, 

 

where: 

Q = discharge (m3/s) 

Combining these equations gives the following equation: 

 

Conveyance describes the geometric carrying capacity of a hydraulic conduit and is described by the 
following equation: 
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Friction Slope is the slope (S) in Manning's formula required to convey a specified discharge under 
uniform flow conditions given a depth, roughness, and shape. Under uniform flow, depth and flow area 
are constant and the friction slope, the actual slope, and the energy slope are all equal. 

 

LINK DESIGN CONSTRAINTS 
The Constraints establish further design criteria for Links. GEOPAK Drainage utilizes the physical 
constraints of minimum and maximum size and slope to determine a suitable pipe size.  

 

 

GEOPAK Drainage will perform the following steps to determine the “allotted pipe envelope” 

• Starting upstream, GEOPAK computes each link slope by connecting the nodes at the 
elevation set by the node elevation minus the  minimum depth. 

• If this slope is less than the minimum slope, GEOPAK Drainage sets the slope equal to the 
minimum slope. This will provide the upper limit of the envelope. Then, it continues 
downstream. 

• To setup the bottom part of the “envelope” , it starts from the outlet elevation, move upstream 
and setup the minimum invert of the pipes by using node elevation minus the maximum depth 
values on each node. 

• If the invert falls within the minimum and maximum slopes the link is placed at the calculated 
elevation.  If not, the link is once again placed at the minimum specified slope from that node 
to the upstream end of the system. 

• If during the construction of the envelope, any elevations that the user has held will be 
accommodated if physically possible and the envelope constrained to that elevation.  
However, if a held elevation of a pipe violates the minimum or maximum depth line, the 
elevation will not be held. With the minimum and maximum depth profiles computed, 
GEOPAK Drainage can then design a suitable pipe within this envelope that satisfies all the 
constraints possible. 
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The other constraints, minimum and maximum velocity are for querying purposes and evaluating the 
adequacy of the design. 

Minimum Rise Constraint - Minimum rise (diameter, height) for pipe or ditch in master 
units (i.e. feet or meters). The Department’s minimum round pipe size is 
1.5' (18”). 

Maximum Rise Constraint - Maximum rise (diameter, height) for pipe or ditch in master 
units (i.e. feet or meters). Unless the designer knows a constraint, it is 
recommended that this be set for a large pipe such as a 6' (72”). 

Minimum Slope Constraint - Minimum physical slope for pipe or ditch expressed in 
percentage. The minimum pipe slope varies with the pipe size (0.15% for 
18”, 0.102% for 24” etc.)  See the discussion in the Storm Drain Handbook.  
During the initial design, the pipe sizes are not known, so this constraint 
may need to be changed as the design progresses.   In moderately sloped 
terrain, using 0.15% may be acceptable for all pipes, because the terrain 
will force the pipes to be steeper than that.  In flat terrain, using 0.15% for 
all pipes may cause the downstream pipes to be too deep. 

Maximum Slope Constraint - Maximum physical slope for pipe or ditch expressed in 
percentage. The Department does not have a maximum slope constraint, so 
it is recommended that this be set high for all pipes. 

Minimum Velocity Query - Minimum velocity for pipe or ditch expressed in feet per second or 
meters per second. This value must be something greater than zero for the 
program to do the hydraulic calculations. 

Maximum Velocity Query - Maximum velocity for pipe or ditch expressed in feet per second or 
meters per second. 

 



HYDRAULIC GRADE LINE COMPUTATIONS 
 

VDOT GEOPAK Drainage  © 2007 VDOT 12-19 

HYDRAULIC GRADE LINE COMPUTATIONS 
The methodology employed  by GEOPAK Drainage to compute the water surface profiles through a 
storm drain network is typical of any open channel water surface procedure. A backwater analysis is 
performed through the system beginning at the most downstream point (outlet) and progressing 
upstream to the most remote nodes. GEOPAK Drainage will compute the hydraulic grade line using 
gradually varied flow analysis in free surface flow conditions and pressure flow computations under 
full flow conditions.  

The resulting hydraulic gradeline represents the set of elevations to which the water would rise if open 
to atmospheric pressure (e.g., piezometer tubes) along a pipe run and can be used to evaluate the 
adequacy of the design and identify areas where flooding occurs. 

HYDRAULIC GRADELINE 
The hydraulic gradeline (HGL) procedure begins at the most downstream node (outlet) and proceeds 
upstream through each link in the same fashion. A starting HGL at this downstream point elevation 
must be defined. The procedure for developing the HGL through a link of the network from 
downstream node to upstream node is as follows: 

 

1. Beginning with the HGL at the downstream node (HGL1), the Energy Gradeline (EGL1) is computed 
from: 

 

where: 

v = velocity at flow depth HGL (ft/s) 

g = gravity (32.2) 

HGL = elevation of hydraulic gradeline 

Assuming a very small change in the energy and depth (y) compute the HGL2 from HGL2 = HGL1+ y 

2. Determine the distance along the pipe (x) to create the y loss due to friction = x = Sfy where Sf = 
0.5(S1+S2) 



SPECIAL CONSIDERATIONS 
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3. This procedure of computing HGL2 and the distance along the pipe proceeds until the end of the 
pipe has been reached yielding the HGL at the upstream end of the pipe. 

4. The resulting upstream HGL is subsequently used on the next upstream pipe as its starting 
downstream HGL. GEOPAK Drainage can alternatively use the computed energy gradeline upstream 
as the starting downstream EGL on the next pipe upstream. This alternative method differs in that the 
EGL's upstream and downstream at a node are equal rather than the conventional assumption that the 
HGL's are equal. 

5. If junction losses are desired they computed prior to progressing upstream and added to the 
hydraulic gradeline. 

SPECIAL CONSIDERATIONS 
• If the starting HGL is less than critical depth then critical depth will be assumed. 

• If the HGL converges to equal the uniform depth the computations proceed to the upstream 
end at uniform depth 

• Once the HGL reaches the soffit of the pipe full flow conditions begin. 

• Hydraulically steep pipes where uniform depth is less than the critical depth are checked with 
a backwater profile to verify if the resulting upstream HGL drowns out critical depth at the 
upstream end. If it does than the backwater profile is accepted. If the backwater curve does 
not exceed the critical depth, then a forewater profile is generated for this supercritical 
condition. A forewater profile uses the same procedure as above but progresses from the 
upstream end towards the downstream end. It begins at critical depth at the upstream end and 
converges towards uniform depth as the calculations proceed downstream. 

• Hydraulic jumps may occur when mixing supercritical and subcritical water surface profiles. 
GEOPAK Drainage does not compute the exact location of a jump but will check if 
downstream subcritical depths have sufficient energy to force a supercritical profile to its 
conjugate depth thereby satisfying the conditions required for a jump to occur. Message will 
be appear indicating the existence of a jump. 
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JUNCTION LOSS METHODOLOGIES 
 

Five junction loss methodologies are discussed: 

• Free surface transition losses 

• Pressure flow transition losses 

• Bend losses 

• Terminal inlet / junction losses 

• Complex junction losses 

FREE SURFACE TRANSITION LOSSES 
The energy losses may be expressed in terms of the kinetic energy at the between the incoming and 
outgoing pipes: 

 

where Kt is the transition Loss Coefficient.  

 

for V2 > V1 

 

for V1 > V2 

where: 

V1 = upstream velocity 

V2 = downstream velocity 

Kt  = Loss Coefficient for expansion of contraction 

PRESSURE FLOW TRANSITION LOSSES 
The energy losses may be expressed in terms of the kinetic energy at the between the incoming and 
outgoing pipes: 
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where Kt is the transition Loss Coefficient.  

 

for V2 > V1 

 

for V1 > V2 

where: 

V1 = upstream velocity 

V2 = downstream velocity 

Kt  = Loss Coefficient for expansion of contraction 

 

BEND LOSSES 
Method 1 (From Modern Sewer Design) 

Bend losses may be estimated from the equation: 

 

Where the Kb can be estimated from the following table. 

K - Bend Loss Coefficient Degree of Turn at Bend 

0.10 20 

0.32 40 

0.64 60 

1.06 80 

1.32 90 
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Method 2 (From AASHTO) 

Bend losses may be estimated from the equation: 

 

Where the Kb can be estimated from the following table. 

K - Bend Loss Coefficient Degree of Turn at Bend 

0.19 15 

0.35 30 

0.47 45 

0.56 60 

0.64 75 

0.70 90 

 

CURVE LOSSES 
Losses for curved pipe segments may be estimated from the equation: 

 

where: 

 = central angle of bend in degrees 

 

TERMINAL INLET /JUNCTION LOSS 

 

where: 

V = Velocity at terminal end of junction 

Kt  = Loss Coefficient for terminal junction 



COMPLEX JUNCTIONS 
 

12-24 © 2007 VDOT VDOT GEOPAK Drainage  

COMPLEX JUNCTIONS 
Manhole losses in many cases comprise a significant percentage of the overall losses within a sewer 
system. Losses at junctions are dependent upon flow characteristics, junction geometry and relative 
sewer diameters.  

Method 1 

Losses at junctions where one or more incoming laterals occur may be estimated by combining the 
laws of pressure plus momentum where Hj is equal to the junction losses. 

 

Using the laws of pressure plus momentum, the loss Hj can be estimated as follows: 

 

Method 2 

Losses at junctions where one or more incoming laterals occur utilize the principle of conservation of 
energy, involving position energy and momentum energy. The energy content of the inflows is equal to 
the energy content of the outflow plus any losses due to the collision and turbulence. 
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The loss Hj can be estimated as follows: 

 

where: 

Q = discharges 

V = horizontal velocities 

K = bend loss factor 
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GEOPAK DRAINAGE WARNING MESSAGES 
 

PREFERENCES 
• Error Opening GPK file: The directory path for the location of the project’s geometric database (gpk file) is 

not properly defined in the Drainage project preferences. 

• Error Opening Drainage Library: The directory path for the location of the project’s drainage library (dlb 
file) is not properly defined in the Drainage project preferences. 

• Close All Open Library Item Dialogs Before Exiting Librarian: All edit dialogs must be saved or cancelled 
before exiting the drainage library dialog. 

• Unable to load path data: The directory paths for any of the project components are invalid or do not exist as 
defined in the Project preferences dialog. 

• Unable to find shape file in preferences: The roadway superelevation shapes dgn file is not at the location 
specified in the Project preferences dialog. 

AREAS 
• No element meets the boundary level/symbology criteria: The dgn element symbology specified as a search 

criteria for the area definition does not match any of the elements in the dgn file. 

• Area Creation Failed or Aborted - Area Must be Enclosed: A drainage area must be closed shape element in 
Microstation. 

• No Boundary Elements Selected: A boundary or borderline Microstation elements to define a drainage area 
were not selected. 

• Sum of Subareas = ## Exceeds Total Drainage Area = ## Do You wish to Reset Total ?: The sum of the 
subareas entered in the Area>Subareas option exceeds the total area defined in the Area>Definition dialog box. 
GEOPAK will adjust the total area as the total sum of the subareas. 

NODE:  
• Error Retrieving Cell: The Microstation cell library containing the drainage node cells is not attached to the 

dgn file, it is not found or it is not specified in MS_Celllist variable. 

• NO element identified: User has not selected/identified the Microstation element where the drainage node is 
going to take as a reference for placement while using the Tangent to Element or Tangent on Element option in 
the Node>location dialog. 

• Unable to determine PGL Elevation: The station where the node is placed does not exist along the profile 
specified as a reference. 

• Unable to compute TIN Elevation: The node is placed outside the boundary of the TIN file specified or the 
TIN file does not exist. 

• Error Finding D&C Manager: The D&C Manager ddb file is not found at the location specified in the Project 
Preferences. 
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• Error Computing Inlets Calculations for Network: GEOPAK Drainage was not able to compute any 
hydraulics for the specified inlet. No flow is getting to the inlet. This could be caused by a wrong spread criteria 
definition in which the first slope of the spread criteria cross section is diverting the flow out of the inlet 
(negative slope) or the user has not defined a drainage area or discharge into the node. 

• Error Opening ACBOOK: The D&C Manager ddb file is not found at the location specified in the Project 
Preferences. 

• Error Accessing TIN or Model: The TIN file or Site Model gsf file do not exist  at the directory path specified 
in the Project Preferences. 

• Error in Inlet By Pass Designations - Loop Detected: User is bypassing flow into the same node.  

• Error using shapes: GEOPAK was unable to extract information from the roadway superelevation shapes 
defined in the Project preferences. This could be caused by wrong definitions inside the shapes (chain and 
profile), the shape dgn file does not exist in the path specified in the Project preferences or there are not shapes 
defined at the node location. 

LINK:  
• Link placement ERROR: Link was not placed and stored in the drainage database (gdf file). This could be 

caused by a wrong definition (from and to node are the same) or a Microstation element to define the link is not 
selected. 

• Cannot Hold the Slope and From and To Node Elevations: User can not specify hold values for the inverts 
and slope of the link/pipes at the same time. User should specify the inverts and let the slope to be calculated by 
the software. 

• Cannot Hold From Node Soffit and Invert Elevations: User can not specify values for the soffit and invert 
elevations in the same FROM node. User should specify either one of them and let the software calculate the 
remaining elevation with the link rise or pipe diameter. 

• Cannot Hold To Node Soffit and Invert Elevations: User can not specify values for the soffit and invert 
elevations in the same TO node. User should specify either one of them and let the software calculate the 
remaining elevation with the link rise or pipe diameter. 

• Cannot Hold More than Two Conditions: User can not specify hold values for the inverts and slope of the 
link/pipes at the same time. 

• Rise Exceeds Maximum allowed by Profile Envelope: The selected or designed link for the segment is 
encroaching in the profile envelope defined by the elevations and minimum depths of the connected nodes. 

• Downstream HGL sufficient for Hydraulic Jump: GEOPAK Drainage does not calculate the exact location 
of a hydraulic jump but it can warn the user of its possible occurrence. 

• Minimum Slope used for Positive Drainage: Link slopes were adjusted to the minimum specified slope in 
order to assure gravity/positive flow. Adverse slope pipes are not allowed. 

• Min Depth Exceeded at Upstream or Downstream of Link: Link rise is encroaching the limits defined by 
the node elevation minus the minimum depth. 
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NETWORK: 
• Error Building Network : An invalid network has been defined. Multiple outlet nodes or “loop” connections 

are not allowed. 

• Network Calculations Containing Profile are not up to date, Please Perform Network Calculations: 
Shown results may not be up to date since possible edit operations have occurred in the network. 

• An Active Network must be selected: The Drainage>Network>Active Network has not been selected in the 
project. Some reporting options required this definition at the user request. 

• Network Computations are not up to date show results anyway ?: Shown results may not be up to date since 
possible edit operations have occurred in the network. 

• Network Calculations involving link are not up to date, Please perform Network Computations: Shown 
results may not be up to date since possible edit operations have occurred in the network. 

• Errors Preclude Computations: GEOPAK Drainage was unable to calculate the network system. This could 
be caused by some zero values in the node or link definitions (no flow into the nodes, minimum 
velocities equal to zero) or no drainage areas defined for inlets. 

• HGL Blowout at upstream end: The hydraulic grade line is encroaching the limits defined by the node 
elevation minus the minimum freeboard value (defined in the Project Preferences). 

• Commingling Runoff Methods not supported: GEOPAK Drainage can compute a network either using the 
Rational or SCS method for the drainage areas definitions. 

• Error Building Network - More than One Outlet found: An invalid network has been defined. Multiple 
outlet nodes are not supported. 

• Error Building Network - Loop or Multiple Downstream Links: An invalid network has been defined. Loop 
or closed circuits connections are not supported. 

• Error Building Network - More than five Incoming Links for Node: GEOPAK Drainage does not allow 
more that five link/pipes connections in a node.  

PROFILES 
• Unsuccessfully projecting to chain __ from link __: The chain extends/limits does not include the 

link location. 

• Error Accessing TIN or Model: The TIN does not exist  at the directory path specified in the Project 
Preferences. 

• Drainage Profile __ contains Node __: The Drainage Profile dialog must be closed to edit this node: 
The Drainage Profile dialog must be closed before editing a node that is part of the active profile. 

• Drainage Profile __ contains Link __:The Drainage Profile dialog must be closed to edit this link: 
The Drainage Profile dialog must be closed before editing a link that is part of the active profile. 
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NAVIGATOR 
• No Queries Available for Selected Type: There are no query options for the drainage element type 

selected. 

• No Elements Meeting Query were found: An specific query has returned no results. 

ROUTING 
• Unable to load computation file: The ASCII file specified to store the computations was not 

previously created while in Append mode. 
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GEOPAK REPORT BUILDER VARIABLES 

AREA 
Area-ID: Drainage area name/identification stored in the drainage database (gdf file) 

Area – Description: Drainage area user provided description. 

Area - Time of Concentration: User provided or calculated time of concentration. 

Area - Tc Used: Time of concentration used in the calculation for the drainage area discharge. 

Area – Discharge: Computed discharge for the drainage area. 

Area – Intensity: Intensity rainfall used as computed from the time of concentration and rainfall 
library. 

Area - Composite C Value: Calculated composite C coefficient for the Rational method. 

Area - Composite Area: Calculated composite area value for the Rational method. 

Area - Total Subarea C Value: Calculated composite C value for only the delineated subareas. 

Area - Total Subarea: Sum of  the delineated subareas only. 

Area - Remainder C Value: C coefficient of the area not included into the delineated subareas. 

Area - Remainder Area: Calculated value equal to Total Drainage Area minus the Total Subareas. 

Area - Subarea 1…20 Area: Area value of the 1..20 delineated subarea. 

Area - Subarea 1…20 C Value: C coefficient of the 1..20 delineated subarea. 

Area - Subarea 1…20 Description: Description of the 1..20 delineated subarea. 

NODE 
Node-ID: Drainage node name/identification stored in the drainage database (gdf file) 

Node – Description: Drainage node user provided description. 

Node – Type: Node type as defined in the drainage library. E.g. curb, grate, junction, other, curb-grate, 
headwall. 

Node - Library Item Name: Node name as it is stored in the drainage library. 

Node - Library Item Description: Node description as it is stored in the drainage library. 

  Node - Reference Chain: GEOPAK chain used to locate the node by station. 

Node - Reference PGL: GEOPAK profile used to compute the elevation and longitudinal slope for the 
node. 



NODE 
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Node - Reference TIN: GEOPAK DTM file used to compute the elevation of the node. 

Node - Station : Station value computed at the node location using the Node - Reference Chain. 

Node - Offset : Offset or distance value computed from the Node - Reference Chain to the node 
location. A negative value will indicate the left side of the chain. 

Node - Location X Node/ Node - Location Y Node : Coordinate location of the drainage node. 

Node – Rotation Node: Angle value in which the node is rotated. 

Node - Cumulative Tc : Accumulated time of concentration at the node location. 

Node - Supplied Discharge: Applied flow  into the node. A discharge is entered directly without a 
drainage area definition. 

Node - Cumulative Supplied Q : Accumulated directly-entered discharge in the node. 

Node – Freeboard : Distance computed as node elevation minus hydraulic grade line elevation. 

Node - Cumulative Discharge : Accumulated discharge/flow in the node. 

Node - Cumulative Area : Accumulated drainage area in the node. 

Node - Cumulative C Value : Accumulated C coefficient in the node. 

Node - Cumulative Intensity: Accumulated intensity in the node. 

Node - Hyd Center X / Node - Hyd Center Y : Coordinate location of the node hydraulic center. 

Node - Elev Point X / Node - Elev Point Y : Coordinate location of the node elevation point . 

Node - Origin X / Node - Origin Y : Coordinate location of the node cell origin. 

Node - Minimum Depth / Node - Maximum Depth: Distance measured from the node elevation point. 
These distances paired with the next connected node creates en envelope in which the links can be 
placed. 

Node – Depth : Distance computed from the node elevation point minus the node bottom elevation. 

Node - Minimum Invert Elevation : Minimum invert elevation computed from the links arriving or 
leaving the node. 

Node - Maximum Rise In : Maximum link size arriving into the node. 

Node - Maximum Rise Out: Maximum link size leaving the node. 

Node - Minimum Invert In / Node - Minimum Invert Out : Minimum invert elevation of the links 
arriving or leaving the node. 

Node - Bottom Name : Name as stored in the drainage library of the bottom structure attached to the 
node. 

Node - Bottom Description : Description as stored in the drainage library of the bottom structure 
attached to the node. 
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Node - Pay Item : D&C Manager item ID attached to the node. 

Node - Bottom X / Node - Bottom Y : Coordinate location of the bottom structure attached to the node. 

Node - Bottom Station: Station value computed at the bottom of the structure attached to the node 
using the Node - Reference Chain. 

Node - Bottom Offset: Offset or distance value computed from the Node - Reference Chain to the 
bottom of the structure attached to the node . A negative value will indicate the left side of the chain. 

Node - Bottom Elevation: Elevation of the bottom of the structure attached to the node. 

Node - Sump Depth: Extra depth specified by the user added after computing the node bottom 
elevation. 

Node - Is Link Base Flow: Returns a value of -1 if a Baseflow (offsite drainage discharge) option is 
added to the node. 

Node - Link Base Flow Type: Returns a value of 1 if the Baseflow (offsite drainage discharge) is 
entered as a numeric value. Returns 0 if the baseflow discharge is entered as a predefined drainage 
area. 

Node - Link Base Flow Area: Returns the name or ID  of the drainage area entered as baseflow. 
Returns N/A if not. 

Node - Link Base Flow Discharge: Returns the numeric value entered as baseflow discharge. Returns 
N/A if not. 

INLET 
Inlet - ID: Drainage inlet name/identification stored in the drainage database (gdf file). 

Inlet – Description: Drainage inlet user provided description. 

Inlet - By Pass Node ID : Node name in which by pass flow is directed from the present inlet. 

Inlet – Type: Inlet type as defined in the drainage library. E.g. curb, grate, curb-grate. 

Inlet - Profile Type : Inlet placement profile condition. Either On Grade or Sag. 

Inlet – Discharge : Inlet computed discharge from the drainage area or supplied discharge. 

Inlet – Capacity : Capacity of the inlet based on their physical properties and placement conditions. 

Inlet - Max By Pass: Maximum by pass flow/discharge assigned to the inlet as a query value. It is not 
used for design purposes. 

Inlet - By Pass Flow: Computed flow that the present inlet will bypass due to lack of capacity. 

Inlet - By Pass Flow Into: Inlet name in which by pass flow is directed from the present inlet. 

Inlet - Curb Length: Curb length as defined in the drainage library. 

Inlet - Curb Depression: Curb Depression as defined in the drainage library. 
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Inlet - Curb Height: Curb Height as defined in the drainage library. 

Inlet - Curb Depression Width: Curb Depression Width as defined in the drainage library. 

Inlet - Slot Length: Slot Length as defined in the drainage library. 

Inlet - Slot Width: Slot Width as defined in the drainage library. 

Inlet - Grate Type: Grate Type as defined in the drainage library. 

Inlet - Grate Length: Grate Length as defined in the drainage library. 

Inlet - Grate Width : Grate Width as defined in the drainage library. 

Inlet - Grate Area: Grate Area as defined in the drainage library. 

Inlet Grate Perimeter: Grate Perimeter as defined in the drainage library. 

Inlet - Grate Clog Area: Grate Clog Area as defined in the drainage library. 

Inlet - Grate Clog Per Inlet: Grate Clog Per Inlet as defined in the drainage library. 

Inlet - Max Ponded Depth: Maximum allowed spread depth. This is used a query value and not for 
design purposes. 

Inlet - Max Ponded Width: Maximum allowed spread width. This is used a query value and not for 
design purposes. 

Inlet - Longitudinal Slope: Slope along the direction of stationing defined by the user or a GEOPAK 
profile. 

Inlet - Computed Ponded Width: Computed spread width. 

Inlet - Computed Ponded Depth: Computed spread depth. 

Inlet - Right Spread Intercept: : Computed spread width at the right side of the inlet. 

Inlet - Left Spread Intercept: Computed spread width at the left side of the inlet. 

Inlet - Length Required: Computed inlet required in order to handle all the discharge. 

Inlet - Spread N: Manning’s coefficient for the spread section. 

Inlet - Composite Spread Slope: Composite slope across the inlet. 

Inlet - Inlet to Gutter Offset: Distance applied when the inlet is set at a certain offset of the section 
considered for computing spread width and depth.  

Inlet - Spread Slope 1…5: Slope of the different segments of the Spread Criteria cross section. Section 
1 is the closest to the inlet. 

Inlet - Spread Width 1…5: Width of the different segments of the Spread Criteria cross section. 
Section 1 is the closest to the inlet. 
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LINKS 
Link – ID: Drainage link name/identification stored in the drainage database (gdf file). 

Link – Description: Drainage link user provided description. 

Link – Type: Link type. Either pipe or ditch. 

Link - Upstream Node: Upstream node ID of the connecting link. 

Link - Downstream Node: Downstream node ID of the connecting link. 

Link – Shape: Link shape as defined in the drainage library. E.g. Arch, box, circular, ellipse or pipe 
arch. 

Link – Material: Link material as defined in the drainage library. E.g. aluminum, concrete, plastic, or 
steel. 

Link - Corr – Type: Link corrugation or type as defined in the drainage library. E.g. Standards, low 
profile, high profile, horizontal, or vertical. 

Link - Library Item: Link name as it is stored in the drainage library. 

Link - Number of Barrels: Number of parallel pipes going from one node to another. 

Link - Actual Length: Link length measured from the graphical ends of the element. 

Link - Hydraulic Length: Link length measured from hydraulic center to hydraulic center of each node. 

Link - Manning's N Value: Manning’s coefficient of the link. 

Link – Slope: Link slope in percentage. 

Link – Rise: Link rise in feet or meters. 

Link – Span: Link span in feet or meters. 

Link – Discharge: Link discharge/flow. 

Link - Uniform Depth: Flow uniform depth at the link. 

Link - Uniform Velocity: Uniform velocity computed at the link. 

Link - Critical Depth: Critical depth computed at the link. 

Link - Critical Velocity: Critical Velocity computed at the link. 

Link - Friction Slope: Friction slope computed at the link. 

Link - Critical Slope: Computed slope caused by critical flow at the link. 

Link - Actual Depth Downstream: Downstream runoff depth at the link. 

Link - Actual Depth Upstream: Upstream runoff depth at the link. 

Link – Capacity: Link capacity under the present physical conditions. 
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Link - HGL Downstream/ Link - HGL Upstream: Hydraulic grade elevation at the link ends. 

Link - EGL Downstream/ Link - EGL Upstream: Energy grade line elevation at the link ends. 

Link - Upstream Junction Loss: Junction loss value at the upper portion of the link. 

Link - Soffit Upstream /Link - Soffit Downstream: Soffit or crown elevation at the link ends. 

Link - Invert Upstream/Link - Invert Downstream: Invert elevation at the link ends. 

Link - Minimum Rise: Minimum link rise used for design purposes. 

Link - Maximum Rise: Maximum link rise used for design purposes. 

Link - Minimum Slope/ Link - Maximum Slope: Minimum/maximum slope at which links would be 
placed. 

Link - Minimum Velocity/Link - Maximum Velocity: Minimum/maximum velocity at which links 
would be placed. 

Link - Design Size: Return a Yes/No value if GEOPAK Drainage will design the size of the links. 

Link - Design Barrels: Return a Yes/No value if GEOPAK Drainage will consider parallel links from 
node to node. 

Link - Actual Velocity Downstream/Link - Actual Velocity Upstream : Velocities computed at the link 
ends. 

Link - Pay Item: ID of the Design and Computation Manager item associated with the link as defined 
in the drainage library. 

Link - Library Description: Link description as it is stored in the drainage library. 

Link - Iterative Velocity: Computed velocity at the link after 10 iterations. 

Link - Full Velocity: Computed velocity assuming that the links are flowing full. 

Link - Upstream Freeboard: Computed elevation from the upstream node minus the assigned freeboard 
to the node. 
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